
 
 
 
 

 

 

 

 

 

PERSPECTIVE USER’S GUIDE 
Version 5.5 

August 2018 

 
 
  
  



Perspective by Resolver™  

Version 5.5 

Distributed August 2018. 

Notices and Intellectual Property Information 
Notice 

The materials contained in this publication are owned or provided by Resolver Inc. and are the property of Resolver or its licensors, and are protected 

by copyright, trademark, and other intellectual property laws. No trademark or copyright notice in this publication may be removed or altered in any 

way. 

Copyright 

Copyright ©2019 Resolver Inc. All rights reserved. All materials contained in this publication are protected by Canadian, the United States, and 

international copyright laws and no part of this publication may be reproduced, modified, displayed, stored in a retrieval system, or transmitted in any 

form or by any means, electronic, mechanical, photocopying, recording or otherwise, without the prior written consent of Resolver, 111 Peter Street, 

Suite 804, Toronto, Ontario  M5V 2H1, Canada or, in the case of materials in this publication owned by third parties, without such third party’s 

consent. Notwithstanding the foregoing, to the extent any material in this publication is reproduced or modified in any way (including derivative works 

and transformative works), by you or on your behalf, then such reproduced or modified materials shall be automatically assigned to without any 

further act and you agree on behalf of yourself and your successors, assigns, heirs, beneficiaries, and executors, to promptly do all things and sign all 

documents to confirm the transfer of such reproduced or modified materials to Resolver. 

Trademarks 

Protect What Matters, RiskVision and/or other products or marks referenced herein are either registered trademarks or trademarks of Resolver Inc. in 

Canada, the United States and/ / or other countries. The names of actual companies, trademarks, trade names, service marks, images and/or products 

mentioned herein may be the trademarks of their respective owners. Any rights not expressly granted herein are reserved. 

Changes 

Companies, names, and data used in the examples herein are fictitious unless otherwise noted. 

Although every precaution has been taken in preparation of this document, Resolver Inc. assumes no responsibility for errors or omissions. Neither is 

any liability assumed for damages resulting from the use of the information contained herein.  

Permission to modify and distribute this document strictly for the purpose of internal user training is hereby granted, provided that it is made evident 

the document has been modified, and that all copies contain all proprietary notices set forth in or on the original version. Resolver Inc. assumes no 

responsibility for errors or omissions resulting from the modification of this document. Resolver Inc. expressly waives all liability assumed for damages 

resulting from the modification of the information contained herein. Notwithstanding the permission granted herein, no part of this document may 

otherwise be reproduced, transmitted, disseminated or distributed, in any form or by any means, electronic or mechanical, for any other purpose, without 

the express written permission of Resolver Inc. 
  



 

 

Table of Contents 

Perspective Editions ................................................................................................................................... 1 

Welcome to Perspective by Resolver ..................................................................................................... 2 

Accessing Perspective .................................................................................................................................... 2 

Logoff ................................................................................................................................................................... 7 

User Interface .................................................................................................................................................... 7 

Main System Components ............................................................................................................................ 9 

User Privileges and Access Rights .......................................................................................................... 11 

Account Settings ........................................................................................................................................... 11 

Changing Your Password .................................................................................................................. 11 

Dashboard Settings ............................................................................................................................. 12 

Shortcut Keys ......................................................................................................................................... 13 

Quick Find Tool .............................................................................................................................................. 18 

Custom Search Feature ............................................................................................................................... 20 

Maps .................................................................................................................................................................. 21 

Features ................................................................................................................................................... 22 

Incidents ................................................................................................................................................... 23 

Activities .................................................................................................................................................. 23 

Dispatches ............................................................................................................................................... 24 

Tooltips ..................................................................................................................................................... 24 

Exiting Perspective ....................................................................................................................................... 26 

Dashboard .................................................................................................................................................. 27 

User Interface ................................................................................................................................................. 27 

Charts ................................................................................................................................................................ 28 

Assignments ................................................................................................................................................... 31 

Data Forms ................................................................................................................................................. 35 

User Interface ................................................................................................................................................. 35 

Navigating Data Forms Overview ........................................................................................................... 37 

Select a Data Form ............................................................................................................................... 38 

Merging records’ duplicated data (the Merge button). ............................................................. 51 



 

 

Select a Record from the List ............................................................................................................ 59 

Enter and/or Edit Record Data .......................................................................................................... 60 

Incidents ........................................................................................................................................................... 64 

Create a New Incident Record .......................................................................................................... 64 

Identify All Involved Persons ............................................................................................................. 68 

Identify All Involved Organizations ................................................................................................. 76 

Document All Involved Vehicles ....................................................................................................... 79 

Identify All Involved Items .................................................................................................................. 82 

Summarize an Incident or a Case .................................................................................................... 84 

Attach a File to a Record .................................................................................................................... 85 

Link the Incident to an Activity ......................................................................................................... 87 

Link an Incident to Another Incident ............................................................................................... 89 

Link an Incident to a Case .................................................................................................................. 91 

Record Losses Involved in an Incident and View Their Summary ........................................ 92 

Record Incident Investigation Data ................................................................................................. 96 

Control a Record’s Processing Options ....................................................................................... 108 

Track Changes Made to a Record.................................................................................................. 116 

Cases ............................................................................................................................................................... 118 

Create a new Case record ................................................................................................................ 119 

Assign an Investigator to a Case’s Investigation ...................................................................... 120 

View All Case’s Involvements ......................................................................................................... 122 

Summarize a Case or an Incident Linked to a Case ................................................................. 124 

Attach a File to a Case Record ....................................................................................................... 124 

Link an Incident to a Case ................................................................................................................ 124 

Link a Case to Another Case ........................................................................................................... 126 

View a Summary of Losses Involved in a Case ......................................................................... 127 

View and Record Case Investigation Data ................................................................................. 129 

Control a Case Record’s Processing Options ............................................................................ 131 

View a Quick Summary of a Case’s Key Data ........................................................................... 131 

Track Changes Made to a Case Record ....................................................................................... 134 

Activities......................................................................................................................................................... 134 

Create a New Activity Record ........................................................................................................ 134 



 

 

Record an Officer’s Response to an Activity .............................................................................. 137 

Record an Organization’s Response to an Activity ................................................................. 138 

Note an Action Request for an Activity ....................................................................................... 141 

Identify All Persons Involved in an Activity ................................................................................ 144 

Identify All Organizations Involved in an Activity ..................................................................... 144 

Document All Vehicles Involved in an Activity .......................................................................... 145 

Identify All Items Involved in an Activity ..................................................................................... 145 

Attach a File to an Activity Record ................................................................................................ 145 

Link an Activity to Another Activity .............................................................................................. 145 

Link an Activity to an Incident ......................................................................................................... 146 

Control an Activity Record’s Processing Options ..................................................................... 148 

Track Changes Made to an Activity Record ............................................................................... 151 

Escalate an Activity Record to an Incident ................................................................................. 152 

Items ................................................................................................................................................................ 152 

Create a New Item Record ............................................................................................................... 152 

Import Record’s Settings from the Gateway ............................................................................. 154 

View Record’s Incident Involvements .......................................................................................... 156 

Attach a File to an Item Record ...................................................................................................... 157 

Control Record’s Processing Options .......................................................................................... 158 

Track Changes Made to an Item Record ..................................................................................... 160 

Persons ........................................................................................................................................................... 160 

Create a New Person Record .......................................................................................................... 160 

Record Contact Information ............................................................................................................ 166 

Link a Record to a Person ................................................................................................................ 168 

Link a Record to an Organization .................................................................................................. 169 

Link a Record to a Vehicle ................................................................................................................ 170 

View Person’s Incident Involvements .......................................................................................... 172 

Attach a File to a Person Record ................................................................................................... 172 

Control a Person Record’s Processing Options ........................................................................ 172 

Track Changes Made to a Person Record ................................................................................... 173 

Organizations ............................................................................................................................................... 173 

Create a New Organization Record .............................................................................................. 174 



 

 

Record an Organization's Contact Information ......................................................................... 175 

Link an Organization to a Person................................................................................................... 175 

Link an Organization to Another Organization ......................................................................... 175 

Link an Organization to a Vehicle .................................................................................................. 176 

View Organization’s Incident Involvements ............................................................................... 176 

Attach a File to an Organization Record ..................................................................................... 176 

Control an Organization Record’s Processing Options .......................................................... 176 

Track Changes Made to an Organization Record ..................................................................... 176 

Vehicles .......................................................................................................................................................... 176 

Create a New Vehicle Record ......................................................................................................... 176 

Link a Vehicle to a Person ................................................................................................................ 178 

Link a Vehicle to an Organization .................................................................................................. 178 

Link a Vehicle to Another Vehicle .................................................................................................. 178 

View Vehicle’s Incident Involvements .......................................................................................... 179 

Attach a File to a Vehicle Record ................................................................................................... 179 

Control a Vehicle Record’s Processing Options ........................................................................ 179 

Track Changes Made to a Vehicle Record .................................................................................. 180 

Merge Records ............................................................................................................................................. 180 

Construct a Visual Link Chart for a Record ......................................................................................... 184 

Analyze and Report ............................................................................................................................... 186 

Analysis Expert ....................................................................................................................................... 187 

User Interface ............................................................................................................................................... 187 

Navigating Data Forms Overview ......................................................................................................... 189 

About Operators .......................................................................................................................................... 190 

Create a Query Category .................................................................................................................. 192 

Query Design Process ............................................................................................................................... 193 

Create a Query ..................................................................................................................................... 193 

Specify Query Criteria........................................................................................................................ 195 

Save a Query ........................................................................................................................................ 201 

Edit a Query .......................................................................................................................................... 201 

Clone a Query ....................................................................................................................................... 202 

Share a Query ...................................................................................................................................... 203 



 

 

Delete a Query ..................................................................................................................................... 205 

Execute a Query .................................................................................................................................. 205 

Track Query Runs ............................................................................................................................... 206 

Working with Query Results ................................................................................................................... 207 

View Query Results ............................................................................................................................ 208 

Search for Specific Data in Query Results .................................................................................. 208 

Group Query Results by a Field ...................................................................................................... 209 

Perform Calculations on Query Results ....................................................................................... 210 

Export Query Results ......................................................................................................................... 212 

Print Query Results ............................................................................................................................ 212 

Access Records in Query Results and Print Reports .............................................................. 213 

Construct a Visual Link Chart From Query Results .................................................................. 214 

Chart Query Results ........................................................................................................................... 215 

Analyze Results ........................................................................................................................................... 218 

Table ....................................................................................................................................................... 219 

Data Chart ............................................................................................................................................. 222 

Pie Chart ................................................................................................................................................ 224 

Reports..................................................................................................................................................... 226 

User Interface ............................................................................................................................................... 226 

Types of Reports ......................................................................................................................................... 227 

Administrator Only ............................................................................................................................. 227 

Detail Reports ...................................................................................................................................... 227 

List ........................................................................................................................................................... 228 

Lookups .................................................................................................................................................. 229 

Summary Reports ............................................................................................................................... 230 

Creating a Report ........................................................................................................................................ 230 

Custom Reports ..................................................................................................................................... 236 

User Interface ............................................................................................................................................... 236 

Custom Report Design Process ............................................................................................................. 236 

Create a Custom Report ................................................................................................................... 237 

Save a Custom Report ...................................................................................................................... 238 

Edit a Custom Report ........................................................................................................................ 238 



 

 

Clone a Custom Report ..................................................................................................................... 239 

Share a Custom Report ..................................................................................................................... 240 

Delete a Custom Report ................................................................................................................... 240 

Execute a Custom Report................................................................................................................. 241 

Report Designer .......................................................................................................................................... 241 

Getting Started .................................................................................................................................... 242 

General Procedures ............................................................................................................................ 256 

Create a Professional Table ............................................................................................................. 262 

Create a Crosstab ............................................................................................................................... 311 

Gateway ................................................................................................................................................... 321 

User Interface ............................................................................................................................................... 322 

Incidents ......................................................................................................................................................... 324 

Items, Persons, Organizations and Vehicles ...................................................................................... 329 

DispatchLog and Dispatch ................................................................................................................... 331 

Visual Analysis ....................................................................................................................................... 332 

Use Visual Analysis to Build a Link Chart ........................................................................................... 332 

Access Visual Analysis .............................................................................................................................. 333 

Create a Link Chart ..................................................................................................................................... 333 

Use IBM i2 ChartReader to Manipulate Your Link Chart ................................................................ 338 

Transfer Your Link Chart into IBM i2 ChartReader .......................................................................... 339 

Additional IBM i2 ChartReader Resources ......................................................................................... 340 

Appendix A: Dashboard Chart Types ................................................................................................ 342 

Appendix B: Text Editor Navigation .................................................................................................. 349 

Appendix C: Data Field Types ............................................................................................................. 353 

Appendix D: Chart Wizard .................................................................................................................. 361 

Glossary ................................................................................................................................................... 370 

Index ......................................................................................................................................................... 390 

Contact Information .............................................................................................................................. 399 

Technical Support ....................................................................................................................................... 399 

Resolver Inc. .................................................................................................................................................. 399 



Perspective User’s Guide  Perspective Editions 

 © Resolver Inc.   Page 1 of 399 

Perspective Editions 

The chart below summarizes the Perspective features available by edition. For more information on the 

edition you’re currently running, check your licensing. 
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Welcome to Perspective by Resolver 

Welcome to Perspective by Resolver™, the industry leader in Incident Reporting and Investigation 

Management software. Perspective by Resolver is an end-to-end Incident Management solution that 

covers everything from response and documentation, through to investigation, and analysis. You can 

intelligently action and query your data for trending, risk mitigation, and planning. Then, with the ability 

to assess what’s happening and its potential impact, you can make informed decisions that optimize 

performance, and illustrate the effectiveness of your security operation. 

 
This guide was designed for day-to-day users of Perspective. For information about using the 

Administration component, see the Perspective Administrator’s Guide on the Resolver Support site. 

Accessing Perspective 

1. Ensure Compatibility View is turned off in Internet Explorer: 

 

a. Click the gear icon in the top right of the browser. 

 

b. Click Compatibility View Settings. 

 

c. Ensure the Display intranet sites in Compatibility View checkbox is unchecked. 

 

d. Click Close. 

 

https://support.resolver.com/hc/en-ca/sections/201705483-Documentation
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2. Navigate to your Perspective Services URL:  

 

• For On Premise customers: https://<servername>/PerspectiveServices. <servername> refers to 

the Perspective Web server installed during the installation of Perspective. 

 

• For Hosted customers: https://<businessID>.myincidents.com/perspective/ 

 

3. Click the Perspective icon.  
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4. If launching Perspective for the first time: 

 

a. Click Run in the Security Warning window.  

 

b. Configure your login settings: 

 
• For On Premise customers: 

 
i. Click the Specify Server tab, if it’s not already open. 
 

ii. If needed, enter the Perspective Services URL (e.g. 
https://<servername>/PerspectiveServices) in the Service Folder field.  

   
iii. If your business ID is different from default, enter it in the Business ID field. 
 

Note: The  icon indicates that valid information has not yet been entered into 

mandatory fields. When the required information has been validated, the  will 

appear next to the fields. 
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iv. Select the database from the Database Name dropdown menu. 
 

v. Click  Back to return to the previous screen.  
 

• For Hosted customers: 
 

i. Click the MyIncidents.com tab. 
 

ii. Confirm the database selected in the Database Name dropdown is correct. 
 

 
 

iii. Click  Back to return to the previous screen.  
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Note: If the Database Name field is missing or login fails, click the Specify Server tab 

to confirm the Service URL, Business ID, and Database fields have populated 

correctly. 

 

5. Enter your login credentials: 

 

Note: If your system uses Windows® authentication, the login will be performed automatically. To 

switch back to the standard Perspective login, press the F5 key on your keyboard. 

 

a. If you’re logging in using single sign-on (SSO) authentication:  

 

i. Click Login.  

 
 

ii. Enter your username, password, and any other information required by your SSO 

provider to complete the login process. The SSO settings, including the amount 

of time your session remains active, are determined by the SSO provider 

selected by your Perspective administrator. 

 

Note: If both SSO and Perspective authentication are enabled on your system 

and you want to log in using your Perspective credentials, click Login with 

Perspective, then enter your user name and password. This option will only 

appear on the login screen if both Perspective and SSO authentication were 

enabled at the time of installation or update. 
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b. If you’re not logging in using single sign-on (SSO) authentication: 

 

i. Enter your user name and password in the User Name and Password fields.  

 
 

ii. Select the Remember Me checkbox if you want Perspective to remember your 

user name. 

 

iii. Click Login. 

Logoff 

If you’ve logged in using single sign-on (SSO) authentication, clicking the X at the top right of the screen 

will not log you out of Perspective, Dispatch, or Dashboard. To end your SSO session, click Logoff in the 

ribbon. 

User Interface 

Perspective’s user interface is interactive, which means that it is constructed to match the current 

working process (e.g., creating a record, analyzing data, filing a report). While the standard icons of the 

Ribbon and the components of the Navigation pane remain constant, the rest of the screen content 

changes depending on the currently active Perspective component selected from the Navigation pane.  
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Perspective’s user interface consists of the following broad parts: 

 

1. The Ribbon: Locates the most frequently used general administration, navigation, help, and search 

tools.  

 

In the Data Forms component, the Visual Analysis icon is added. Visual Analysis assists by visually 

representing relationships between the records stored in Perspective’s database.  

In the Analysis Expert component, the Ribbon is populated with an additional set of icons that 

perform saving, adding, cloning, deletion, sharing, and execution of queries.  

Hide the Ribbon by clicking the  icon on the top right corner (next to the Privacy link). Click the 

icon again to show the Ribbon. 

 

To read Perspective’s Privacy Statement, click the Privacy link. To read Perspective’s Legal Notice, 

click the Legal link. 

 

2. Navigation pane: Consists of the two major parts: the bottom part allows you to select different 

Perspective components (Dashboard, DispatchLog, Analysis Expert, Reports, etc.), while the top 

part displays the component-specific navigation options. Using the top part of the Navigation pane, 

you will be able to control the workflow within the individual Perspective components (e.g., open 

the DispatchLog console, modify the view of your Perspective records, customize reports, and 

specify query settings). To hide the Navigation pane, click the Toggle Navigation Window icon  

on the Ribbon. Click the icon again to make the pane reappear. 

 

3. Main screen: Consists of one or more sections and displays the core record data stored in 

Perspective (depending on the currently active component). For instance, the main screen in the 

Data Forms, and the Gateway components, consists of a Listing pane with a list of records and a 

Viewing pane, where data of the record selected in the Listing pane is displayed.  

 

4. Status bar: Contains your system and login information, including your username, role, and your 

current Perspective’s system and connection status (e.g., Connected/Disconnected). After 

performing an action on a record, check the status bar at the bottom of the screen for a confirmation 

message. The status bar will indicate when Perspective is in the process of completing an action 



Perspective User’s Guide  Welcome to Perspective 

 © Resolver Inc.   Page 9 of 399 

(e.g., Loading, Saving, Deleting) and also specify if an action is complete and successful (e.g., 

Record is successfully saved), or unsuccessful (e.g., Please provide required fields before saving). 

 

  

Main System Components 

You can access all of Perspective’s features and functionality from the Navigation pane. Just click on the 

buttons to switch between components, and then further explore each component by clicking on the 

options displayed. 

 

Note: The components any particular user sees are dependent on that user's privileges and access rights. 

Refer to User Privileges and Access Rights for more information. 

 

Main System Components 

Dashboard 

Dashboard is Perspective’s opening screen. Use it to track ongoing projects in 

the Assignments section, and quickly review selected records’ trends and 

statistics in the Charts area. 
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DispatchLog 

Opens a separate DispatchLog console window that assists in centralized 

dispatching of officers and organizations. See the Perspective DispatchLog 

User's Guide on the Resolver Support site for more information. 

Data Forms 
Enter, update, and review your Activity, Incident, Case, Item, Person, 

Organization, and Vehicle records in Data Forms.  

Analyze and 

Report 

Use Analysis Expert to query records for specific data, and then turn your results 

into a printed grid, spreadsheet, chart, or report. Choose from a number of pre-

set reports to generate statistics and analyze trends in your data. Or use Custom 

Reports to create your own reports. 

Gateway 

Gateway serves as an inbox for all electronically submitted reports. Selected 

users assess each report before accepting it into Perspective or deleting it from 

the system. 

Administration 

Designated Administrators use this component to manage system settings, 

workgroups, roles, users, officers, auditing, languages, some components of the 

system interface, and visual alerts. The functions of the Administration 

component are described in the Perspective Administrator’s Guide. 

Customize visibility of the components by dragging the top border of the component section in the 

Navigation pane, or by clicking the configure arrow buttons. This will hide the bottom components one 

by one. Click on the pin icon  to return the hidden component back to the pane. 

 
 

  

https://support.resolver.com/hc/en-ca/sections/201705483-Documentation
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User Privileges and Access Rights 

Every Perspective user’s visibility and access rights are customized by a user, or users, designated as the 

Administrator(s). 

 

Some basic users may only be authorized to read and add new records, without any editing, locking, 

unlocking, or deleting privileges. The records they are permitted to read may also be restricted by various 

security controls, and some forms may not be visible (e.g., Investigations forms or the Controls tab). 

Furthermore, these basic users may be restricted from advanced components, such as Analysis Expert or 

Reports. On the other hand, highly advanced users may have full access to all system components, 

forms, fields, and functions.  

 

If you are unable to view a particular component or form, or if you are not permitted to perform a certain 

function, it may be a result of your assigned user privileges. For more information on how data is 

segregated within Perspective and how user visibility and access rights are assigned, refer to the 

Security Layer Overview chapter in the Perspective Administrator’s Guide, or, if you possess appropriate 

access rights, in the online Admin Help. 

Account Settings 

Changing Your Password 

1. To initiate the change of your current account password, click the File icon  on the Ribbon. 

 

2. Select Change Password. 

 

3. In the dialog window, enter your Old Password and your New Password. 

 

4. Re-enter your new password in the field below to confirm the password configuration. 

 

5. Click OK to save the change and verify your new password. 

https://support.resolver.com/hc/en-ca/sections/201705483-User-Guides
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Dashboard Settings 

By default, your Dashboard is set to automatically refresh once every minute. You may set your 

Dashboard to automatically refresh less frequently or to require manual reloading. 

 

1. Click the Settings icon  on the Ribbon. The Settings window will open with the General tab open 

by default.  

 

2. To modify how often your Dashboard refreshes, ensure the Automatically Refresh Dashboard 

Assignments box is checked, and in the field below, specify how frequently you would like the 

Dashboard to refresh (from once every minute to once every sixty minutes).  

To set your Dashboard to require manual reloading, uncheck the Automatically Refresh Dashboard 

Assignments box.  

 

3. Click Save. At any time, you may click Reset to return your Dashboard to its default refresh settings.  

 

4. Restart Perspective (log out, then log back in) to enforce any changes that you have made. 
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Shortcut Keys 

Shortcut keys enable you to map commonly used Perspective functions to shortcut key combinations for 

quick access. 

 

1. Click the Settings icon  on the Ribbon. The Settings window will open. 

 

2. Select the Shortcut Keys tab. 

 

3. For every key you want to change, do the following:  

 

a. Click the function's button.  

 

b. Tap the new key combination you want to use. If the shortcut is being used elsewhere, you'll be 

prompted to confirm your selection. 

 

4. Click Save.  At any time, you may click Reset to return your shortcut key settings to their original 

system defaults.  
 

The default settings for shortcut keys are as follows: 

 

Shortcut Keys 
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Function Name Default Key Combination 

Global  

Navigation Mode Ctrl + N 

Ribbon Menus * Alt/F10 

Navigation Keys  

Go to Data Forms D 

Go to DispatchLog L 

Go to Dashboard H 

Go to Analysis Expert E 

Go to Gateway G 

Go to Administration M 

Go to Activities A 

Go to Incidents I 

Go to Cases C 

Go to Items S 

Go to Persons P 

Go to Organizations O 

Go to Vehicles V 

List All Records W 

Open Quick View Q 

Show Saved Views K 



Perspective User’s Guide  Welcome to Perspective 

 © Resolver Inc.   Page 15 of 399 

Focus on List Pane F 

Hide List Pane Y 

Change Password 1 

Exit Perspective 2 

Admin Help 8 

User Help 9 

Toggle Navigation Pane 3 

Logoff 4 

Settings 5 

Quick Find 6 

Open Visual Analysis 7 

About Perspective 0 

Hide Ribbon Menu Minus 

View Legal Notice F3 

View Privacy Policy F2 

Go to Client Site F5 

Maps F6 

Record Details  

Save Ctrl + S 

Edit Ctrl + E 

Merge Ctrl + U 
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Add From Source Ctrl + G 

Delete Ctrl + Minus 

Add Ctrl + Plus 

Cancel Ctrl + K 

Create Incident Ctrl + I 

Lock/Unlock Ctrl + L 

Print Ctrl + P 

Send Ctrl + M 

View Record Audit Info Ctrl + D 

Focus on Details Tabs Ctrl + F 

Back to List Pane Ctrl + B 

List Pane  

Select Top Record Ctrl + T 

Print List Ctrl + P 

Sort List Ctrl + O 

Next Page Ctrl + Right Arrow 

Last Page Ctrl + Down Arrow 

Previous Page Ctrl + Left Arrow 

First Page Ctrl + Up Arrow 

Jump to Page Ctrl + 1 

Focus on Selected Record Ctrl + L 
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Add * Ctrl + Plus 

Edit * Ctrl + E 

Focus on Details Tabs * Ctrl + F 

Delete * Ctrl + Minus 

Controls  

Link Record: Open List Ctrl + W 

Link Record: Quick View Ctrl + Q 

Large Text Field: Spell Check Ctrl + Q 

URL Field: Open URL Ctrl + Q 

Interview: Toggle Fields Ctrl + F 

Analyze and Report  

Reports Ctrl + R 

Queries Ctrl + Q 

Custom Reports Ctrl + E 
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* Not configurable or must be set in another section. 

 

 

Quick Find Tool 

The Quick Find tool is an advanced search that can locate records containing your specified text. The tool 

will check text fields across your Perspective database (such as summaries, narratives, and text 

attachments) for the words or phrases you enter. The Quick Find attachment indexing supports the 

following file formats: .doc, .docx, .docm, .xls, .xlsx, .pdf, .txt, .text, .rtf, .sms, .log, .msg, .wpd, and .wps. 

 

Note: The Quick Find tool requires an indexed database to function properly. Contact your Perspective 

Administrator for further information. 

 

1. Click the Quick Find button  on the Ribbon. 

 

2. In the Enter Search String field, type the text you want to find. You can customize your search as 

follows: 

 

• To search for an exact matching phrase, enclose it in quotation marks. 
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• To search for records containing two or more words or phrases, join the words or phrases with 

the AND operator. For example, if you want to search for records containing the words black 

and coat, use the following search string: black AND coat.  

 

• To search for records containing either one word or phrase or another word or phrase, join the 

words or phrases with the OR operator. For example, if you want to search for records 

containing either the word laptop or the word computer, use the following search string: laptop 

OR computer. 

 

• Use wildcards to search for words and phrases that start, end, or simply contain particular 

characters. Perspective’s Quick Find supports the * (asterisk) wildcard as a substitute for zero or 

more characters. For example, if you want to search for records containing words (numbers, 

names, cities, etc.) that start with san, use the following search string: ‘san*’. If you want to 

search for records with words that contain the pattern ger, use the following search string: 

‘*ger*’. 

 

Note: Previews for matching records found with the help of the wildcards will not be displayed. 

 

• Searches can be customized further using the Fuzziness and Phonetic settings.  

 

• Select a Fuzziness setting (default value is zero; maximum value is 10) to determine how broadly 

your search terms will be applied. A higher Fuzziness value will return results which are less 

exact than your search text. This can help to discover records even if they have typos in them. 

For example, a fuzzy search for ‘vehicle’ would include the results ‘vehcile’ or ‘vehickle’. Enabling 

the Fuzziness setting may increase the time it takes to perform a search. 

 

• Select the Phonetic checkbox to include search results that sound the same as the search term. 

This can be helpful when searching for names that sound the same but have different spellings 

(e.g., Aaron/Erin, Smith/Smyth). Enabling the Phonetic setting may increase the time it takes to 

perform a search. 

 

3. Click Search.  
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• A list of records containing the specified word or phrase will appear in the grid below. The 

number of times the word or phrase appears in each record will be noted in the Hits column. As 

well, the specific form that the word or phrase was found in will be listed (e.g., Incident 

Narrative, Investigation Summary, Person Attachment). 

 

4. To quickly scan the results, select a record in the list.  

 

• A preview of the record segment containing the word or phrase will appear in the pane below. 

 

5. Double-click a record in the list to open it.  

 

• Perspective will advance to the selected record in Data Forms, with focus on the form 

containing the word or phrase. (The Quick Find window may still be opened in the foreground; 

in this case, minimize the Quick Find window to view Perspective.) 

 

6. Click the Close [x] button in the top-right corner to close the Quick Find window. 

 

 

Custom Search Feature 
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The Custom Search feature allows you to launch the Infoglide Identity Resolution Engine™ (IRE) from 

Perspective, to search within several data sources at once.  

 

Note: Custom Search must first be configured in the Perspective Service Manager before it may be 

accessed in Perspective. For further details, please see the Perspective Installation Guide. 

 

1. Click the Custom Search icon  on the Ribbon.  

 

• The Infoglide Identity Resolution Engine will open in a new window.  

 

2. Following the basic search principles described in the Quick Find Tool section of this chapter, 

perform the custom search required. 

 

3. When finished, close the window to return to Perspective. 

Maps 

Perspective Maps allows you to quickly see where a Dispatch is occurring, or where an Activity or 

Incident has occurred. Perspective’s mapping tool allows you to quickly access any record you want.  

 

All Dispatches, Activities, and Incidents will appear on the map. You can easily define the records you 

want displayed with the filter option.  

 

From the mapping tool, you can see relevant tooltips that contain information like the Class, Category, 

Occurred Time, Priority, and Status (the information you are able to see depends on if you are looking at 

an Incident, Activity, or Dispatch). From here, you can select the record you want to open and look at it in 

more detail. 

 

Note: The Mapping option requires an internet connection. 
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Features 

Map view: The Aerial map is the default map. To switch to Road map, click the button Aerial/Road button 

 on the top right corner of the Maps window.  

 

Zoom: You can zoom in or out on the map by using the  or  buttons, or by using the scroll button on 

your mouse.  

 

Incidents and Activities auto refresh: The map automatically refreshes Incidents and Activities every 15 

minutes, but if you want to refresh it sooner, click the refresh button . Pressing the F5 button will also 

refresh the Incidents and Activities. 

 

Dispatches auto refresh: To automatically refresh Dispatches on the map, you need to have the  

Auto Refresh checkbox  selected (located in the Dispatches section on the Maps page). If this 

checkbox is selected, the Dispatches will refresh in less than one minute. 
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Note: Dispatch auto refresh only works if the date range is set to the last seven days. If your date range is 

set to the last 14 days and you check the Dispatch auto refresh checkbox, your timeline will be reset to 

the last 7 days, or auto refresh will deselect automatically if you expand your date range to over 7 days 

with auto refresh enabled. 

 

Date Range: Use the left and right arrows on the date range to move backwards in time, or drag and 

drop the date range bar to the occurred dates of Incidents, Activities, and/or Dispatches you want to see 

on the map. 

 

Scale: Your map’s scale will be automatically set to go off of your computer’s system settings. 

 

Filters: To filter what you want to see displayed on the map, turn the switch to on  or off  . For 

example, if you only want Incidents to be displayed, turn the Activities and Dispatches filter switch to the 

off position. By filtering out Incidents, Activities, or Dispatches, it will make it easier for you to find exactly 

what you are looking for.  

Incidents 

Note: If you do not have privileges for Incidents, Activities, particular Workgroups, etc., those records will 

not display in Mapping. 

 

You can search by all Class Rollups, or drill down to only search for specific Classifications (i.e., Criminal 

Incidents). 

 

Activities 

You can search by all Call Categories and Priorities, or drill down to only search for specific Call 

Categories or Priorities.  
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Dispatches 

You can search by all States and Priorities, or drill down to only search for specific States or Priorities.  

 

 

Tooltips 

Tooltips are how you dig deeper into an Incident, Activity, or Dispatch, to determine if it is the one you 

are looking for. To look at tooltips, simply hover over the pin  on the map. A pin is a circle with a 

number in the middle, where the number represents how many Incidents or Activities have occurred in 

that location, or how many Dispatches are occurring in that location. 

When you hover over the pin, the tooltip will appear. First, you will be shown a count of the number of 

Activities, Incidents, and Dispatches that are in that pin.  
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From here, click once on the word Activities, Incidents, or Dispatches, depending on what you want to 

look at. For example, if you click on the word Incidents, all the Incidents in that pin will open in greater 

detail. To scroll through them, use the scrollbar that appears in the window.  

 

 
 

Once you have found the record you are looking for, click on it, and it will open in Perspective. The map 

will remain opened in another window. 

 

 
 



Perspective User’s Guide  Welcome to Perspective 

 © Resolver Inc.   Page 26 of 399 

Note: A pin will only go up to 99+. However, you can hover over the pin and the tooltip will open, 

allowing you to scroll through all Incidents, Activities, and Dispatches that have occurred or are occurring 

in that location. Double click on pin clusters to zoom in.  

Exiting Perspective 

There are two options to exit Perspective:  

 

• Logoff option: Log off the current user while leaving the Perspective system running. To log off, 

click the Logoff key icon  on the Ribbon, or use the keyboard shortcut Ctrl+Shift+L. 

 

• Exit option: Completely exit Perspective, which requires a full system reload upon the next login. To 

exit Perspective, close the Perspective window, use the keyboard shortcut Alt+F4 (or click on the 

File icon ), and select Exit.  

 

Note: While the Logoff option requires an additional confirmation of your choice to exit Perspective via a 

confirmation window, the Exit option will simply terminate the work of Perspective as soon as you 

choose to exit. 

 

Before exiting Perspective (regardless of which exit option you choose), you have to press the Save 

button  to save any changes you have made to records while working in Perspective.
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Dashboard 

The Dashboard is Perspective’s default screen. Like the dashboard of an automobile with its various 

gauges and indicator lights, Perspective’s Dashboard keeps users informed about what is happening in 

their organization and alerts them of important changes. It helps to track ongoing projects and tasks, and 

includes a statistics snapshot section for the incidents the user has access to. The two elements of the 

Dashboard are Charts and Assignments.  

User Interface 

1. Charts: Get a quick overview of incident trends and statistics with the help of up to four selected 

bar or pie charts. 

 

2. Assignments: Track activities or projects assigned to you, as well as those you have assigned to 

others, from start to finish. 

 

 
 

• Resize the individual elements by dragging the borders surrounding them.  
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• To display/hide one of the Dashboard elements, click Show/Hide Charts, or Show/Hide 

Assignments on the Navigation pane.  

 

• To refresh the view of the Dashboard, click the Refresh button on the Navigation pane. 

Charts  

The four pre-set charts on the Dashboard give you a quick overview of trends found in the Perspective 

database records you have access to. To select the combination of up to four charts for display on the 

Dashboard, follow the steps described below. 

 

1. Click the Chart Options button on the Navigation pane. 

 

2. In the Chart Settings window, click on the ON/OFF  switch to display or hide one of the 

chart sections. 

 

3. Within the relevant chart field (e.g., Chart 1), choose the chart you would like to appear in the 

selected chart section (e.g., Incident by Class).  

 

• For a complete list of available pre-configured charts and their descriptions, see Appendix A: 

Dashboard Chart Types. 

 

4. Depending on the chart specified, a number of further settings will be displayed, which may (or may 

not) include the following: 

 

• From Last: Select the time period for which you would like to see the statistics on the chart 

(e.g., 365 days).  

 

• Top: Specify the number of categories you would like to display on your chart (e.g., top 10 

classes). 
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• Call Category: Restrict your data to a specific Call Category, making it as narrow as necessary. 

Click the plus icon  next to the Call Category field, and select the requirednumber of levels of 

category by which you would like to restrict the data in the chart. 

 

• Class ID: Restrict your data to a specific Class, making it as narrow as necessary. Click the plus 

icon  next to the Class ID field, and select the required number of class levels (i.e., 

Class/Category/Subcategory/Type) by which you would like to restrict the data in the chart. 

 

• Site: Restrict your data to a specific Site, making it as detailed as necessary. Click the plus icon 

 next to the Site field, and select the required number of site levels (i.e., 

Site/Building/Location/Section) by which you would like to restrict the data in the chart.  

 

• Category ID: Restrict the Case data in your chart to either Internal or External cases. 

 

• Year: Select the specific year you want to display your data for (e.g., 2011) 

 

• Chart Type: Choose either the pie or bar chart type.  
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5. Click OK to see the results displayed on the Dashboard. 

 

6. At any time, you may change the chart options for each individual chart displayed on the Dashboard 

by clicking the corresponding Settings icon .  

 

• This will open the options window for the chart that you chose to modify. 

 

7. Examine one particular chart in detail by clicking the Maximize icon  in the upper right corner of the 

relevant chart section. To dock it back together with the rest of the charts, click the equivalent 

Minimize icon . 

 



Perspective User’s Guide  Dashboard 

 © Resolver Inc.   Page 31 of 399 

8. If the chart you selected is either a uni-coloured bar chart or a pie chart, you may be able to explore 

the information contained in the chart further. By clicking on a bar or a pie sector that corresponds to 

a specific category, class, organization, or site, you may expand the data that is hierarchically 

subordinate to the data currently displayed on the screen. For example, if you are viewing the 

Incident By Class chart, you may click on the green pie sector that corresponds to the Criminal class 

of incidents to open a pie chart for all incidents contained under the Criminal class (e.g., Assault, 

Theft, Fraud). To explore the data even further, you may click on the yellow pie sector that 

corresponds to the Assault category of incidents. 

The number of subordinate charts corresponds to the number of tiers under the corresponding rollup 

(in our example, the Class Rollup). To navigate within the hierarchy, click on one of the dark gray 

circle icons displayed below the chart. Each circle represents one tier of the rollup, in ascending order. 

 

 

9. To copy a chart image, right-click the chart and select Copy to Clipboard. 

Assignments 

When you receive or delegate an assignment to another user, the assignment is displayed on your 

Dashboard. You may also receive an email notification about the assignment, and if you are logged on to 



Perspective User’s Guide  Dashboard 

 © Resolver Inc.   Page 32 of 399 

Perspective at the time, a pop-up will appear in the bottom right corner of your screen alerting you to the 

email. Incomplete assignments that are past their due date are listed in red font. 

 

Along with your assignment’s associated Activity, Incident, or Case Number, the Dashboard’s 

Assignments section displays the following information: 

 

• Completed: A checkbox indicating whether or not the assignment has been completed.  

 

• Assigned Date: The date the assignment was delegated to the user. 

 

• Assigned By: The user who created the assignment. 

 

• Assigned To: The user who is responsible for completing the assignment. 

 

• Due Date: The date the assignment must be completed. 

 

• Assignment Type: The nature of the assignment, such as Correction Notice, Follow-up Activity, 

Information Request, Investigative Action, or Verification. 

 

• Message: The details of the assignment. 

 

 
 

You may perform a number of assignment-related tasks directly from your Dashboard: 
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• To add an assignment to your email application’s calendar, select the assignment and click Export 

. A window will open allowing you to schedule the assignment using external applications. 

 

• To open an assignment’s corresponding Activity, Incident, or Case record, double-click the 

assignment record, or highlight the assignment and click Go To . Perspective will leave 

Dashboard and advance to the applicable record in Data Forms.  

 

• Once the assignment has been completed, highlight the assignment on the Dashboard, then right-

click and select Mark Completed. A pop-up window will appear asking if you would like to send the 

Assigned By person an email notifying them of the assignment’s completion. Click Yes or No. 

 

• By default, only incomplete assignments will appear in the Assignments section of the Dashboard. 

To display all assignments, complete and incomplete, click View All. Click View All again to hide 

completed assignments. 

 

Like the other grids, Perspective provides several sorting options for Assignments: 

 

• To reorder the grid columns in the Assignments section, drag the column headings to the desired 

location. Drop them into place once the indicator arrows have appeared pointing to the correct spot. 

To reset the order of columns to their default position, click Reset      Layout . 

 

• To sort assignments by a particular column (e.g., Incident Number, Assignment Type, Due Date), 

click the column heading once. Click the heading again to sort the data in reverse order. Click Clear 

Filter to return to the unsorted view. 

 

• To group assignments by Assigned Date, Assigned By, Assigned To persons, Due Date, 

Assignment Type, or to group complete and incomplete assignments separately, click the thick 

vertical bar located at the top of the Assignments grid and drag the relevant column heading to the 

Group By Area. In our example, assignments have been grouped by their status as either complete 

(True) or incomplete (False). If necessary, you may build up on internal grouping, dragging 

additional headings to the blue field and arranging them in the required hierarchy. For instance, you 

may group the complete and the incomplete assignments by Assigned By persons, and so on. Click 

Clear Filter to return to the default view. 
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Data Forms 

Data Forms is the data entry component of Perspective. These data are used for analysis and comparison 

to create reports and charts. Information in the Data Forms is organized into sections, so it is easy to find, 

review, and update records. The data forms include Activities, Incidents, Cases, Items, Persons, 

Organizations, and Vehicles. To access the Data Forms component, select it from the bottom part of the 

Navigation pane. 

User Interface 

The Data Forms interface is divided into three sections: Navigation pane, Listing pane, and Viewing pane. 

 

 
 

1. Navigation pane: Allows you to move between the various data forms (e.g., Activities, Incidents, 

Items). To display a particular record subset in the middle Listing pane, choose a data form from the 

Navigation pane and select your record view (i.e., specify a Quick View, view All Records, or select a 

view from the Saved Views menu). 
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2. Listing pane: Provides a list of records that are available for viewing. Once you select a record in the 

Listing pane, the corresponding record information will be displayed in the Viewing pane on the 

right. 

Listing Pane 

Change the orientation of the current component’s (e.g., 

Incidents) Listing pane by dragging it to a different part of the 

screen. Display the pane in a separate dialog by double-

clicking it or dragging it outside of the screen. To dock it back 

in, double-click the pane. 

 

To hide the Listing pane, click the Auto Hide pin icon. Once 

the pane is hidden, access it by clicking the pane’s newly-

created shortcut button on the left side of the screen, and 

unpin it by clicking the pin icon again. 
 

If Perspective displays a list of entities (e.g., incidents, 

persons) that consists of multiple pages, use the left/right 

navigation arrows at the bottom of the list, or type a page 

number in the Page field, to move through the pages. The 

total number of pages will be provided for your reference. To 

quickly move to the first or the last page, click the first arrow 

 or the last arrow icons  respectively. 

 

To print the record list as it appears in the Listing pane, click 

the Print button located at the top of the Listing pane. 
 

 

3. Viewing pane: Displays information of a record selected in the Listing pane and provides options 

for saving, editing, adding, deleting, (un)locking, printing, sending, and merging individual records. 

 

Note: Merge is only available for the Item, Person, Organization, and Vehicle records. 
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Every record consists of a set of customized forms and subforms designed specifically for the data 

form type. For example, a Person record contains a separate Contact(s) tab, which is absent in such 

data forms as Vehicles or Items. 

 

 

Viewing Pane 

To view a particular segment of a selected record (e.g., 

Narratives), click the appropriate tab at the top of the record. 

The diamond symbol appearing on a tab indicates that the tab 

contains data. Tabs without the diamond symbol contain no 

saved data. 

 

View more tabs. If these arrows appear next to a row of tabs 

in a form, there are more tabs available than are currently 

visible on-screen. 
 

Expand or collapse a section to view or hide its contents. 
 

To resize a grid column, place the cursor between column 

headings. When an arrow appears, drag the column border to 

the desired width. To resize a column to fit its content, double-

click the border of the column. 
 

To reorder the grid columns, drag the column heading to a 

new position. Drop it into place once the thick arrows have 

appeared, pointing to the correct spot.  

To sort the grid data by a particular column, click the column 

heading once. Click it again to sort the data in reverse order. 
 

Navigating Data Forms Overview 



Perspective User’s Guide  Data Forms 

 © Resolver Inc.   Page 38 of 399 

Every data entry/editing action in Data Forms requires you to first choose one data form type in which 

you intend to work in: Activities, Incidents, Cases, Items, Persons, Organizations, or Vehicles.  

 

Navigating the Data Forms component is a logically flowing process: 

 

1. Select the appropriate data form type by clicking the corresponding banner located in the bottom 

part of the Navigation pane. 

 

2. Using the Quick View, Saved Views, and All Records buttons located at the top of the Navigation 

pane, manage the view of the records displayed in the Listing pane. Here you may choose from 

either displaying all records, or a subset of records, with an option to filter and save the view for 

future reference. 

 

3. Select an existing record from the Listing pane, or create a new record for the chosen data form 

type (e.g., a new Incident record). 

 

4. Enter and/or modify the data contained in your active record. 

 

5. Print your record in the form of a report. 

 

The following chapters will address the options available for each of these steps in greater detail. 

Select a Data Form 

Activities Form 

Use this form to create records of dispatched activities, or to manage activities imported from 

DispatchLog or Dispatch (See the Resolver Support site for more information on DispatchLog and 

Dispatch). Before creating a new record, do a record search to ensure that the information has not 

already been entered.  

Activities Form 

General 

https://support.resolver.com/hc/en-ca/sections/201705483-Documentation


Perspective User’s Guide  Data Forms 

 © Resolver Inc.   Page 39 of 399 

• Specify the category, priority, and location of the dispatched activity. 

• Track the times of the dispatching progress. 

• Identify the persons directly involved in the processing of the activity. 

• Fill in the user-defined fields required by your organization. 

• Post notes on the activity tracking progress. 

Responses 

Officer Responses 

• View, create a new, or edit the details of an existing officer response to the selected activity. 

Organization Responses 

• View, create a new, or edit the details of an existing organization response to the selected 

activity. 

Requests 

• Note an action request sent to an organization in response to the selected activity. 

Involvements 

Persons 

• Identify all persons involved in the activity. 

• Record injuries sustained during the activity. 

• Flag the involved person. 

Organizations 

• Identify all organizations involved in the activity. 

Vehicles 

• Document all vehicles involved in the incident. 

Items 

• Identify all items involved in the incident. 

Attachments 
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• Attach a file to the Activity record. 

Links 

Activity Links 

• Link the activity to another activity. 

Incident Links 

• Link the activity to an incident. 

Controls 

Details 

• Set security controls and status of the Activity record. 

• Define which workgroups can access the Activity record. 

Standard Operating Procedures 

• Review the Standard Operating Procedures available for the activity’s call category, site, and/or 

status. 

• Check off complete procedures, view relevant attachments, and access related links. 

• View mass notifications and/or email notifications sent in relation to the activity. 

Assignments 

• Give an activity-related assignment to another user. 

Audit History 

• View the history of all changes made to the Activity record. Visibility of Audit History depends 

on user permissions. 
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Incidents Form 

Use this form to record the details of an incident and track the progress of its investigation. Every 

Incident record is given a unique number so it is easy to find, identify, and organize. Before creating a 

new record, do a record search to ensure that the information has not already been entered.  

Incidents Form 

General 

• Create a new Incident record. 

• Indicate which authorities have been notified of the incident. 

• Flag the incident. 

Involvements 

Persons 

• Identify all persons involved in the incident. 

• Record injuries sustained during the incident. 

• Record an involved person’s clothing details. 

• Flag an involved person. 

• Add losses, recoveries, or potential no impact losses associated with an involved person, and 

review their summary. 

Organizations 

• Identify all organizations involved in the incident. 

• Note an action request sent to an organization. 

• Log organization response details. 

• Add losses, recoveries, or potential no impact losses associated with an involved organization, 

and review their summary. 

Vehicles 

• Document all vehicles involved in the incident. 

• Add losses, recoveries, or potential no impact losses associated with an involved vehicle, and 

review their summary. 
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Items 

• Identify all items involved in the incident. 

• Add losses, recoveries, or potential no impact losses associated with an involved item, and 

review their summary. 

Narratives 

• Add procedure summaries (e.g., Executive Summary, Follow-up, or Interview) to the Incident 

record. 

Attachments 

• Attach a file to the Incident record. 

Links 

• Link the incident to another incident. 

• Link the incident to a case. 

• Link the incident to an activity. 

Losses 

• Record losses (i.e., Losses, Recoveries, and No Impact losses) involved in an incident. 

• View a summary of losses involved in the incident. 

Investigation 

Details 

• Open a new incident investigation. 

• View a summary of the incident’s key investigative data. 

• Assign an investigator to the incident’s investigation. 

Summaries 

• Summarize the incident’s investigation. 

Logs 

• Log investigative tasks and expenses for the incident.  
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Interviews 

• Document investigation interviews for the incident. 

Evidence/Property 

• Track investigation evidence for the incident, including the evidence chain of custody. 

Controls 

Details 

• Set security controls and status of the Incident record. 

• Define which workgroups can access the Incident record. 

Outcome 

• Describe the incident’s causes and subsequent policy changes or corrective actions. 

Reviews 

• Document an incident-related review. 

Assignments 

• Give an incident-related assignment to another user. 

Audit History 

• View the history of all changes made to the Incident record. Visibility of Audit History depends 

on user permissions. 

Cases Form 

Use this form to record the details of a case, track the progress of its investigation, and access 

information on its linked incidents. Every Case record is given a unique number so it is easy to find, 

identify, and organize. Before creating a new record, do a record search to ensure that the information 

has not already been entered. 
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Cases Form 

General 

• Create a new Case record. 

• Assign an investigator to the case’s investigation. 

• View a quick summary of the case’s key data. 

Involvements 

Persons, Organizations, Vehicles, and Items 

• View all persons, organizations, vehicles, or items involved in the case’s linked incidents. 

Narratives 

• Summarize the case or an incident linked to the case. 

Attachments 

• Attach a file to the case or an incident linked to the case. 

Links 

• Link the case to an incident. 

• Link the case to another case. 

Losses 

• View a summary of losses, recoveries, and no impact losses involved in the case’s linked 

incidents. 

Investigation 

Details 

• View key investigative data from the case’s linked incidents. 

Summaries 

• Summarize the case’s investigation or the investigation of an incident linked to the case. 

Logs 
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• Log investigative tasks and expenses for the case or an incident linked to the case. 

Interviews 

• Document investigation interviews for the case or an incident linked to the case. 

Evidence/Property 

• Track investigation evidence for the case or an incident linked to the case. 

Controls 

Details 

• Set the security controls and status of the Case record. 

• Define which workgroups can access the Case record. 

Reviews 

• Document a case-related review. 

Assignments 

• Give a case-related assignment to another user. 

Audit History 

• View the history of all changes made to the Case record. Visibility of Audit History depends on 

user permissions. 

Items Form 

Use this form to record the details of an item. Before creating a new record, do a record search to ensure 

that the information has not already been entered.  

Items Form 

General 

• Create a new Item record. 
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History 

• View the incidents the item has been involved in. 

• Add an incident associated with the item into a case. 

Attachments 

• Attach a file to the Item record. 

Controls 

Details 

• Set security controls for the Item record. 

• Define which workgroups can access the Item record. 

Audit History 

• View the history of all changes made to the Item record. Visibility of Audit History depends on 

user permissions. 

Persons Form 

Use this form to record the details of a person. Every person, from general maintenance users to suspects 

and officers, must have their own record. Records can be created for persons who have the same name, 

as well as for persons who are unknown. Before creating a new record, do a record search to ensure that 

the information has not already been entered.  

Persons Form 

General 

• Create a new Person record. 

• Note the person's unique features or distinguishing marks.  

• Record the person’s identification details. 

• Document the person’s trespass details. 

• Flag the person. 
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Contact(s) 

• List the person's known addresses, phone numbers, and email addresses. 

Links 

• Link the person to another person. 

• Link the person to an organization. 

• Link the person to a vehicle. 

History 

• View the incidents the person has been involved in. 

• Add an incident associated with the person into a case. 

Attachments 

• Attach a file to the Person record. 

Controls 

Details  

• Set security controls for the Person record. 

• Define which workgroups can access the Person record. 

Audit History 

• View the history of all changes made to the Person record. Visibility of Audit History depends on 

user permissions. 

Organizations Form 

Use this form to record the details of an organization. Before creating a new record, do a record search to 

ensure that the information has not already been entered.  

Organizations Form 

General 

• Create a new Organization record. 
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Contact(s) 

• List the organization's known addresses, phone numbers, and email addresses. 

Links 

• Link the organization to a person. 

• Link the organization to another organization. 

• Link the organization to a vehicle. 

History 

• View the incidents the organization has been involved in. 

• Add an incident associated with the organization into a case. 

Attachments 

• Attach a file to the Organization record. 

Controls 

Details  

• Set security controls for the Organization record. 

• Define which workgroups can access the Organization record. 

Audit History 

• View the history of all changes made to the Organization record. Visibility of Audit History 

depends on user permissions. 
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Vehicles Form 

Use this form to record the details of a vehicle. Before creating a new record, do a record search to 

ensure the information has not already been entered. 

Vehicles Form 

General 

• Create a new Vehicle record. 

Links 

• Link the vehicle to a person. 

• Link the vehicle to an organization. 

• Link the vehicle to another vehicle. 

History 

• View the incidents the vehicle has been involved in. 

• Add an incident associated with the vehicle into a case. 

Attachments 

• Attach a file to the Vehicle record. 

Controls 

Details  

• Set security controls for the Vehicle record. 

• Define which workgroups can access the Vehicle record. 

Audit History 

• View the history of all changes made to the Vehicle record. Visibility of Audit History depends 

on user permissions. 

Common Record Functions 

Although most data entry operations are specific to the individual data forms and will be described under 

the corresponding sections (e.g., Incidents, Activities, Items), some functions are identical for a number of 
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data forms, and these will be described only once and then cross-referenced throughout this guide. For 

instance, as you proceed through the Case data form, you will notice that procedures for some 

operations for cases are identical to the ones that are available for incidents. Whenever this is so, the 

Cases section will provide cross-references to the relevant chapters in the Incidents section instead of 

the full descriptions of the corresponding operations. 

 

The common record functions/forms include the following: 

 

• Recording related contact information (the Contact(s) tab). 

 

• Specifying all involvements of an occurrence (the Involvements tab). 

 

• Reviewing related record’s involvements (the History tab). 

 

• Linking a record to another record (the Links tab). 

 

• Attaching a file to a record (the Attachments tab). 

 

• Setting major record’s control options (the Controls tab). 

 

• Auditing the changes made to a record (the Audit History tab). 
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Merging records’ duplicated data (the Merge button).  

Display All Records in the Listing Pane 

1. In the Navigation pane, choose the record entity you intend to work on (e.g., Incidents). 

 

2. To display all of the entity’s records in the Listing pane, with no filters applied, click All Records. 

 

 

Access a Saved Record View 

1. In the Navigation pane, choose the record entity you intend to work on (e.g., Incidents). 

 

2. Click Saved Views and select the particular record view that you want to access.  

 

• The record view will now appear in the Listing pane. 

 

 

Create and Save a New Record View 

1. In the Navigation pane, choose the record entity you intend to work with (e.g., Incidents). 

 

2. In the view menu, click Quick View.  

 

• The Record Views window will open. This is where you specify the parameters of your record 

view. 
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3. Click the Add button in the Saved Views section.  

 

4. Type a name for your customized view in the active Enter View Name field. 

 

5. Customize your desired view starting with the Workgroups section.  

 

• By default, the All Workgroups box is checked to include records for all workgroups in your 

customized view. If you want to restrict your view to the records of a particular group, uncheck 

the All Workgroups box and proceed to select the desired workgroups. 

 

 
 

6. Specify the Criteria for your view: 

 

a. In the top Field Name lookup list, select the field that you want to set as the main criterion for 

narrowing your record view.  
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b. Choose an Operator for the field (e.g., equal (=), greater than (>), less than or equal to (<=), 

starts with, like). 

 

c. Enter the compared criterion Value. If the Selector button  is available, click it to display a 

tree of Value options in a separate window. For example, if you are creating a Saved View of 

Incident records and your chosen Field Name is Access Level, you may select an Operator of 

equal (=) and a Value of Level 2, in order to restrict your view to only those records with an 

Access Level 2.  

 

Note: You may choose any node of the tree as the defining criterion, making your comparison 

value as narrow hierarchically as you want. For example, when specifying a Value for the Class 

Rollup, you may select any node in the Class Rollup hierarchy, ranging from the broadest 

category values, like Criminal, to the narrowest sub-class type values, like Company 

Property/Over $1000.  

 

If you choose to select a date field in the Field Name lookup list, you have the option of using a 

floating date (e.g., Yesterday), rather than a fixed date to narrow your record view by. The 

Floating Date checkbox is only visible once a date field has been selected. For example, if you 

want your view to display incident activity that occurred during a floating period of a previous 

month, choose Occurred From Date/Time as Field Name, equal (=) as the Operator, and then 

check the Floating Date box and select Previous 30 Days as your Value. 

 

d. If you want to include an additional field in your record view criteria, select the And or Or radio 

buttons and complete the Field Name, Operator, and Value fields below. You may include up to 

four fields in your record view criteria. 

 

To specify a static date range, specify two temporal criteria (e.g., one for the greater than (>), 

and one for the less than or equal to (<=) Operator), using the And logic between them to 

combine the criteria into a set date range. 

 

7. Choose a display order for your record view by selecting a field from the Order By lookup list (e.g., 

order records by Incident Number, Access Level, Status). 
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8. Select either the Ascending or Descending radio button to further define the record order.  

 

• The ascending radio button lists the records according to the chosen Order By field in 

alphabetical order, or from lowest number to highest. The descending radio button lists the 

records according to the selected Order By field in reverse alphabetical order, or from highest 

number to lowest. 

 

9. Include archived records in your record view by checking Include Archived Records. 

 

10. Click the Preview button to generate a list of records meeting your set criteria in the order specified.  

 

• The number of records found will be provided under Page Results. 

 

11. To quickly view a particular record in read-only mode, select the record in the Preview list and click 

View.  

 

• A separate window will open with the record details displayed. 

 

12. If you want to save the record view for future use, complete the Saved Views section. Otherwise, 

proceed to the next step. Perspective provides three saving options for your newly created view: 

 

• To save your record view for future use in Perspective, click Save. Your newly-created record 

view will now be available under the Saved Views menu. 

 

• If you want to set this customized view as your default view (the record view that will 

automatically load each time you enter this data form), click the Set as default view box, and 

click Save again. 

 

• To save your record view as an XML or TXT file, click Save View As and select the location for 

the export. The record will be assigned an automatically generated number. 

 



Perspective User’s Guide  Data Forms 

 © Resolver Inc.   Page 55 of 399 

13. To return to the Data Forms window and transfer your record view to the Listing pane, click the 

Select button. 

 

14. Click on a record in the Listing pane to display it in the Viewing pane.  

 

• If you clicked on a particular record in the Record Views window prior to clicking Select, the 

record will be highlighted in the Listing pane and will already be opened in the Viewing pane. 

Edit an Existing Record View 

1. In the Navigation pane, choose the record entity you intend to work on (e.g., Incidents). 

 

2. Expand the Saved Views menu. 

 

3. Select Quick Edit. The Record Views window will open. 

 

4. If you have not yet opened a saved record view and your Listing pane is blank, select an existing 

view you want to edit under the Saved Views menu.  

 

• Its settings will be displayed. However, if your Listing pane displays a selected record view, the 

Record Views window will open with the active record view’s parameters displayed. 

 
 

5. Modify the parameters as required. For options, see the Create and Save a New Record View 

section in the current chapter. 

 

6. To save the view replacing the parameters previously set, click Save.  

To save the modified record view as a new view, complete the Saved Views section, as follows: 
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a. Click Add. A pop-up will appear asking you if you want to clear the current view criteria.  

 

b. Click No to save the criteria specified. If you click Yes, the view will be reset to its original 

settings. 

 

c. Type a name for your edited view in the active Enter View Name field. This way, when you 

save your new view, it will not overwrite the original view.  

 

d. Click Save. Your newly-created record view will now be available in the Saved Views menu. 

 

If you do not want to save the modified view, proceed to the next step. 

 

6. To return to the Data Forms window and transfer your record view to the Listing pane, click the 

Select button. 

 

7. Click on a record in the Listing pane to display it in the Viewing pane.  

 

• If you clicked on a particular record in the Record Views window prior to clicking Select, this 

record will be highlighted in the Listing pane and will already be opened in the Viewing pane. 

 

    If you opened an existing view in the Listing pane, made changes to it, saved it, and 

then re-opened the modified view, you may need to click the Refresh button  in 

the Saved Views menu to refresh the view of your Listing pane with the new 

settings. 

Import a View 

1. In the Navigation pane, choose the record entity you intend to work on (e.g., Incidents). 

 

2. Click Quick View in the Navigation pane. 
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3. In the Record Views window, click the Import View button and browse for the file that contains the 

view in XML or TXT format that you want to import.  

 

• Once you import the view, its settings will be displayed. 

 

4. Optionally, modify the parameters of the newly imported view and/or save them under a new view 

name. For editing and saving options, please see the Create and Save a New Record View section 

in the current chapter. 

 

5. Click the Select button to transfer your record view to the Listing pane.  

 

6. Click on a record in the Listing pane to display it in the Viewing pane.  

 

• If you clicked on a particular record in the Record Views window prior to clicking Select, this 

record will be highlighted in the Listing pane and will already be opened in the Viewing pane. 

Email a Record View 

1. In the Navigation pane, choose the record entity you intend to work on (e.g., Incidents). 

 

2. Click Quick View in the Navigation pane. 

 

3. In the Record Views window, specify the settings of a new record view and save them, as 

described above, or select an existing view you want to email in the Saved Views menu.  

 

4. Click the Export Via Email button.  

 

• A Send Message window will open with your view specifications formatted as an XML 

attachment.  

 

5. Edit the text of the original message, review attachments, and set the message priority, as needed. 

 

6. Specify the recipient’s email address.  
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7. You may type in a recipient’s email address directly into the To and/or CC fields, or import a contact 

from Perspective’s database by clicking To and/or CC and selecting a person from the displayed 

Entity List.  

 

• The Entity List will be populated with user records that contain an email address with the 

Primary Email box checked. 

 

8. Click Send.  

 

9. Close the Record Views window to return to the Data Forms window. 

 

 

Delete a Record View 

1. In the Navigation pane, choose the record entity you intend to work on (e.g., Incidents). 

 

2. Expand the Saved Views menu 

 

3. Click Quick Edit. The Record Views window will open. 

 

4. If you have not yet opened a saved record view and your Listing pane is blank, select an existing 

view you want to edit under the Saved Views menu.  
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• Its settings will be displayed. However, if your Listing pane displays a selected record view, the 

Record Views window will open with the active record view’s parameters displayed. 

 

5. Click the Delete button.  

 

6. In the Delete confirmation box, click Yes.  

 

7. Close the Record Views window to return to the Data Forms window. 

Select a Record from the List 

If the record database displayed in the Listing pane exceeds three pages, you may consider further 

filtering the record list using the following sorting options: 

 

• Use the A to Z sorting icon  located at the top of the Listing pane to switch the record list view in 

the Listing pane between the ascending and the descending alphanumeric order.  

 

Note: If you are using a Quick View or a Saved View and want to re-sort your records list, you must 

use the Order By and Ascending/Descending options available in the Record Views window. 

 

• If you know a part of the name or number of the required record(s), enter a string of alphanumeric 

characters in the filter field at the top of the Listing pane. Since this function only filters text in the 

record name (e.g., the incident number, person name, vehicle license plate number), the filter string 

must correspond to a supposed part of the record number that you require (e.g., INCD00 or 18 for 

the record numbers INCD00000187, INCD00100185). To apply the filter, click the checkmark icon 

. To remove the filter, click the clear icon  and then the checkmark icon, to view the original list. 

 

• Use the visual cues provided for each record entry to select the record that best suits your needs. In 

the Listing pane, records are displayed as either locked from editing , unlocked from previous 

locking , or as unaltered , the latter meaning that the record has never been locked before. The 

number of files attached to a record is displayed in parentheses. The status of the record may be 

displayed as either Closed or Open. Drawn from the Controls tab, a record’s Closed status generally 
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means that the record has been processed up to a point where no further action is required. By 

default, records are created as Open. 

 

 
 

Once you have found the record you would like to work with, click on the record entry in the Listing pane 

to display it in the Viewing pane.  

 

Note: If you clicked on a particular record in the Record Views window prior to clicking Select, this record 

will be highlighted in the Listing pane and will already be opened in the Viewing pane. 

Enter and/or Edit Record Data 

Depending on the data form that is currently open and on your user privileges, a variety of buttons are 

available on the Viewing pane toolbar, allowing you to perform a number of record functions. 

Viewing Pane Toolbar 

 Save  Saves changes made to a record.  

 Edit  
Switches a record into the edit mode. After clicking Edit, select the field 

you want to edit and make the necessary change. 

 Add Creates a new record from scratch. 

 Delete Removes an entire record from the database.  

  Lock Bars a record from editing. 
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 Unlock 
Makes a record available for editing. (This button will only appear if the 

record is currently locked.) 

 Print 

Prints, displays, or saves the PDF copy of a record in the report form. 

After clicking Print, specify which part of the report you would like to 

print. On the Report Visibility form, specify which record sections you 

would like included in the report and whether you want to download 

attachments, and then click OK. Finally, choose to either view a printable 

copy of the report (Open) or save a copy of the report to the location of 

your choice (Save).  

 

Send 

(Activity, 

Incident, and 

Case forms only) 

Emails record details. After clicking Send, a new email window will open 

with general record details included in the body of the message. To 

format the message details in plain text rather than the default HTML 

table, click the Format icon. Specify the user or email address you would 

like the message to be delivered to, review the message details, and click 

Send. For further details on operating the Send Message editor, consult 

Appendix B: Text Editor Navigation at the end of this guide. 

 

 

 

 

Merge 

(Items, Persons, 

Organizations, 

and Vehicles 

forms only) 

Merges partially duplicate records that correspond to a single physical 

referent that is an item, a person, an organization, or a vehicle. The 

function is represented by the Merge Items, Merge Persons, Merge 

Organizations, and Merge Vehicles buttons on the respective Viewing 

pane toolbars. For details on merging of records, see the Merge Records 

section. 

 Cancel Switches the record from edit to read-only mode without saving changes. 

 Audit To find out who created the record (Created By) and who last modified it 

(Last Modified), click the record’s top shield icon. To access similar 

information for one of the record’s entities (e.g., a specific Narrative or an 

Involved Person entry), select the appropriate entity in the grid and hover 

your mouse over the bottom shield icon. You may also click the icon to 

view the information in a pop-up window with added detail.   
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Some tabs consist of sub-tabs for further grouping of the data contained within. Whenever data in tabs 

is further subdivided into sub-tabs, Perspective enables editing of the sub-tabbed data (e.g., Involved 

Persons) with an additional sub-tab-specific toolbar. The quantity and the names of the functions 

included in this toolbar vary depending on the type of information contained in the sub-tab, although 

they may be similar to the ones performed by the buttons included in the Viewing pane toolbar. 

 

 
 

To start editing details inside the record, you have to first put the record into the edit mode by clicking 

Edit  on the Viewing pane toolbar. Then, to apply changes to a record’s entity (e.g., an Involved 

Person), select the entity in the grid and use the functions displayed in the sub-tabbed toolbar. The 

following table presents the common functions that are available in all data form types (the rest of the 

buttons that you may encounter in a sub-tabbed toolbar will be discussed in sections that describe the 

specific entities in detail). 

 

Common Data Form Functions 

Edit  

Opens a pop-up form that contains the data of the entity. Make necessary 

changes to the fields (or plain text) in the form and click OK (or Accept & 

Return) to return to the main record.  

Add New Creates a new entity within a record (e.g., a new Involved Person entity). 

Remove Removes an entity within a record (e.g., an invalid Involved Person entity).  



Perspective User’s Guide  Data Forms 

 © Resolver Inc.   Page 63 of 399 

Go To 

Opens an entity’s corresponding record, typically, in a different data form 

component. For example, going to the Involved Person entity involves opening 

the associated editable Person record in the Persons component of 

Perspective. In order to return the original data form (i.e., Incidents), select the 

required component from the Navigation pane. The views of both forms will be 

preserved. 

Read/View 

The Read and View options function similarly to Go To, with the only difference 

being that they open the entity in a read-only mode, where you may be able to 

zoom its contents, and/or print it, but not edit it. View allows an attachment to 

be saved to your computer, or opened and viewed in an appropriate 

application (i.e., an attached .doc file would open in Microsoft Word). You may 

scroll through the other entities of the same type (e.g., narratives, investigation 

summaries), without leaving the pop-up window, using the Previous and Next 

buttons. 

Seal/Unseal 

Removes/restores editing rights from/for an entity.  

Note: Once you seal the entity, and then save and leave the corresponding 

record, it can never be unsealed. A new entity must be created in order to 

record amendments to the original one. Even if an entity is left unsealed, the 

Author is the only user authorized to edit the entity, unless special privileges 

have been granted to another user to do so. (If this button is not visible to you, 

your Administrator has not granted you the right to seal entities.) 

History 

To see the history of incidents in which a particular case-involved person, 

organization, vehicle, or item has been involved, select the entity of interest in 

the grid and click History. A new window will appear that displays a table of 

the entity’s involvement in the incidents stored in your organization’s 

Perspective database. For further details, see the View All Case’s Involvements 

section. 



Perspective User’s Guide  Data Forms 

 © Resolver Inc.   Page 64 of 399 

In a new data form, field with red titles are required to be completed (Figure 3.2.9). If you save the record 

before completing all required fields, the system will display a system message requesting completion of 

these fields. To see the classification and navigation of the available field types, see Appendix C: Data 

Field Types at the end of the guide. 

 

Note:  Your organization's data forms may contain additional fields, the so-called User Defined Fields. 

Usually, they appear under a separate like-named section. These fields will require entering additional 

pieces of information that may not be covered in this guide. 

Incidents 

Create a New Incident Record 

Note General Details of the Incident 

1. Click the Add button  in the Viewing pane toolbar.  

 

• Perspective will automatically assign an Incident Number when the record is     saved. The e-

Incident Number field is reserved for electronic reports that have been accepted from the 

Gateway into Perspective. Once the report is accepted as a valid Incident record, it is 

automatically assigned a new Perspective Incident Number, while its original e-Incident 

Number is preserved for cross-referencing purposes. 

 

2. If applicable, input a file or reference number under File Number.  

 

3. Indicate when the incident was reported to supervisors under Reported Date/Time. 
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4. Note when the incident began under Occurred From Date/Time and when the incident ended 

under Occurred To Date/Time.  

 

• The Incident Duration will automatically be calculated when the record is saved. 

 

5. Identify the incident’s classification using the Class, Category, Subcategory, and Type lookup lists.  

 

• These fields are hierarchical, meaning that the option selected in the first field (i.e., Class) 

determines the options that are available in the second field (i.e., Category) and so on. The 

options that appear in these lists have been customized by your organization. 

 

• Specify where the incident occurred by making selections from the Site, Building, Location, and 

Section lookup lists.  

 

• Like the fields in the incident’s classification section, these fields are hierarchical. 

 

6. Identify which business unit the incident affected by selecting options from the Level 1 to Level 4 

lookup lists, if applicable. 

 

7. Type a brief overview of the incident in the Summary box.  

 

• To enter a more detailed description of the incident, outline the sequence of events under the 

Narratives tab. 
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Indicate Which Authorities Have Been Notified of the Incident 

1. In the Supplemental Details section, check the Reported to Police box if the police have been 

notified of the incident, and then input the Police File Number. 

 

2. If another division in your organization has been notified of the incident, check the Reported to 

Division box and specify the Division Reported To. 

 

3. If you reported the incident to your supervisor, check the Reported to Supervisor box. Then, select 

the name of your supervisor from the Supervisor Reported To pick list. If no relevant Person record 

is found in the database, use the Quick Add function to create one. 

 

4. If the incident requires follow-up, check the Follow-up Required box and enter the Follow-up Date. 
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Flag the Incident 

1. In the Flags section, select each flag’s Status (i.e., Yes, No, or Unknown), depending on whether or 

not the flag applies to the incident.  

 

• Examples of flags include Hate Crime, Drugs/Alcohol Involved, and Weapon Involved. 

 

2. Add any applicable notes under Flag Notes.  
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Identify All Involved Persons 

Note General Details of an Involved Person 

1. Select the Involvements tab. 

 

2. Select the Persons sub-tab. 

 

3. Click Add New. A pop-up window will open. 

 

4. Select the involved person’s record from the Linked Person pick list. If a Person record does not 

already exist for this individual, use the Quick Add function to create one. 

 

• The First Name and Last Name fields will now automatically populate with the linked person’s 

name. Depending on the data available, some additional fields may also populate with 

information drawn from the linked person’s record.  

 

5. From the Involvement Type lookup list, choose the appropriate description. 

 

6. Enter the person’s Initial, Title (e.g., Mr.) and Designation (e.g., Chartered Accountant). 

 

7. Specify the involved person’s Date of Birth, Gender, and Marital Status.  
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8. Identify the person’s physical characteristics, including Hair Color, Eye Color, Height, and Weight. 

 

9. If the person is an employee of your organization, check the Employee? box and enter the 

Employee Number. 

 

10. If the person was interviewed regarding the occurrence, check the Interviewed? box. 

 

11. If the person received first aid, or was injured or hospitalized as a result of the occurrence, check the 

First Aid Administered?, Injured, and/or Person Hospitalized? boxes. 

 

12. Enter notes about the person’s involvement in the occurrence in the Notes text box. 

 

13. To add a photo of the involved person to the record, click the Add icon  in the image box.  

 

14. Locate the image file in the browser window and click Open. 
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Add the Involved Person’s Clothing Details 

1. Open the Click to Add Clothing Details link. 

 

2. Choose the Clothing Type and Color from the lookup lists.  

 

3. Enter a detailed description of the item in the Description box.  

 

4. Repeat for as many articles of clothing as necessary. 

 

Record the Involved Person’s Sustained Injuries 

1. Open the Click to Add Injury Details link.  

 

2. Specify the Injury Cause and Severity.  

 

3. Include a detailed description of the injury in the Description text box.  

 

 
 

4. Repeat for as many injury entities as necessary. 
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Flag the Involved Person 

1. In the Flags section, specify the Status (i.e., Yes, No, or Unknown) as well as the Severity of each 

flag (e.g., Critical, High, Low).  

 

• Flags may include such descriptions, as Trespasser, Violent, Infectious, Escapee, Wanted, etc. 

 

2. Enter comments in the Flag Notes section. 

 

3. Click OK. 

 
 

4. As you click OK, the newly created entity will be displayed in the Involved Persons list, each entity 

occupying a single row in the list.  

 

• To display the entity’s general information in the bottom Viewing pane, select the 

corresponding row in the list. 
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Add Losses and Recoveries Associated with an Involved Entity 

1. Before you continue with entering losses or reviewing their summary, make sure that you saved the 

involved entity’s sub-record by clicking OK and that you saved the Incident record by clicking Save. 

This will update the calculations the system stores on the previously recorded losses. 

 

2. Double-click the involved entity in the list that you want to associate a loss with (e.g., the Jeff 

Brown’s Person record).  

 

• In the Associated Losses section in the top right corner you will see the summary of the losses 

previously associated with the open entity, including a summary of the entity’s recovery 

(Exposure and Averted Loss), Total Loss, Total Recovered loss, and Net Loss. 
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3. To review the details of the losses associated with the entity, click on the View Losses and 

Recoveries button under the Losses Associated To summary grid.  

 

• A new window will open where you will be able to see the Date a loss was recorded, the Type 

of the loss, the Method/Status/Cause the loss was or could have incurred, and the relevant 

value of the loss. 

 

 
 

4. To add a loss, select one of the following three options: 

• To add a loss that has occurred, click Add Loss. 

 

• To add a loss that has occurred and has been recovered, click Add Recovery. 
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• To add a potential exposure loss or an averted loss that is associated with the involved entity, 

click Add No Impact. 

 

5. Depending on the option you choose, a new screen will display a subform designed for the type of 

loss you selected. Fill out the form’s fields following the guidelines in the Record Losses Involved in 

an Incident and View Their Summary section. 

 

6. Click OK.  

 

• Once the changes are saved, the recorded loss data will populate the relevant columns of the 

Losses Associated To grid. 

 

7. Add as many loss entries as necessary, repeating steps 4 - 6. Then, click OK to save the associated 

losses on the involved entity’s record and see updated summary calculations in the Associated 

Losses section of the subform:  

 

• Exposure: The total value of the Exposure No Impact loss associated with the involved entity. 

 

• Averted Loss: The total value of the Averted No Impact loss associated with the involved entity. 

 

• Total Loss: The total value of the Loss amounts associated with the involved entity. 

 

• Total Recovered: The total value of the Recovery loss associated with the involved entity. 

 

• Net Loss: The value determined by subtracting the Total Recovery amount from the Total Loss. 
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8. Click OK on the main involved entity’s subform.  

 

• The entity’s entry in the list will be updated with a checkmark under the 

Person/Organization/Vehicle/Item Loss? Column. The loss will also be recorded as a separate 

entry under the Losses tab.  

 

9. Click Save to synchronize the recorded data across the Perspective’s components.  
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Identify All Involved Organizations 

Note General Details of an Involved Organization 

1. Select the Involvements tab. 

2. Select the Organizations sub-tab. 

3. Click Add New. A pop-up window will open.  

4. Select the involved organization’s record from the Linked Organization pick list. If an Organization 

record does not already exist, use the Quick Add function to create one.  

• The Organization Name field will now automatically populate with the linked organization’s 

name. Depending on the data available, some additional fields may also populate with 

information drawn from the linked Organization record. 

5. Specify how the organization became involved in the occurrence by selecting a description from the 

Involvement Type lookup list. 

6. If applicable, input the organization’s file, ID, or other tracking number in the Organization Number 

field. 

7. Select an Organization Type from the lookup list. 

8. Specify the means by which the organization has been notified of the occurrence in the Notified By 

lookup list. 

9. If there is any documentation associated with the organization’s involvement in the occurrence (e.g., 

a work order), note the associated tracking number in the Reference Number field.  
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10. Select the name of the organization’s primary contact from the Contact Person pick list. If a Person 

record does not already exist for the individual, use the Quick Add function to create one.  

11. Enter the contact person’s phone number under Contact Phone. Ensure that you use a consistent 

format when entering phone numbers. 

12. Enter notes in the Comments box. 

13. To add the organization’s logo to the record, click the Add icon  in the image box.  

14. Locate the image file in the browser window and click Open. 

Note an Action Request Sent to the Involved Organization 

1. Open the Click to Add Request Details link. 

2. Choose the appropriate description for the requested action from the Request Type lookup list. 

3. If there is a tracking or other ID number, enter it in the Reference Number field. 

4. Enter the date the request was made in the Assigned Date field. 

5. Select the record of the person who has been administered the request from the Request Assigned 

To Person pick list. If a Person record does not already exist for the individual, use the Quick Add 

function to create one. 

6. When the action is complete, input the Completed Date. 

7. Add any necessary Notes. 
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Log the Involved Organization’s Response to the Incident 

1. Open the Click to Add Response Details link.  

 

2. Select the record of the person in the organization who responded to the incident from the 

Responding Person pick list. If a Person record does not already exist for the individual, use the 

Quick Add function to create one.  

 

3. Select the record of the person who called the organization from Notified By Person. 

 

4. Enter the date and time the organization was contacted in the Called Date/Time field. 

 

5. Enter the date and time the organization arrived on site in the Arrived Date/Time field. 

 

6. When the organization’s response is complete and they have vacated the site, enter the completion 

date and time in the Cleared Date/Time field. 

 

7. Click the Calculate Time link to determine how long it took the organization to respond (Response 

Time) and how long they remained on site (Time On Site). 

 

8. Add any useful Response Notes. 

 

9. Click OK. 
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10. As you click OK, the newly created entity will be displayed in the Involved Organizations list, each 

entity occupying a single row in the list. To display the entity’s general information in the bottom 

Viewing pane, select the corresponding row in the list. 

 

 

Add Losses and Recoveries Associated with the Involved Organization 

Complete the operation, as described in the Add Losses and Recoveries Associated with an Involved 

Entity sub-section in the Identify All Involved Persons section. 

Document All Involved Vehicles  

Note General Details of an Involved Vehicle 

1. Select the Involvements tab. 

 

2. Select the Vehicles sub-tab. 
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3. Click Add New. A pop-up window will open. 

 

4. Select the involved vehicle from the Linked Vehicle pick list. If a Vehicle record does not already 

exist, use the Quick Add function to create one.  

 

• The License Plate field will now automatically populate with the linked vehicle’s license plate 

number. Depending on the data available, some additional fields may also populate with 

information drawn from the linked vehicle’s record.  

 

5. Indicate how the vehicle became involved in the occurrence by selecting a description from the 

Involvement Type lookup list.  

 

6. Select the most appropriate description of the vehicle’s current status from the Disposition lookup 

list (e.g., Seized, Stolen, Released to Owner).  

 

7. Specify the vehicle’s Year, Make, Model, Style, and Color. Your selection in the Model field will 

depend on the value recorded in the Make field. 

 

8. If known, enter the vehicle’s VIN and approximate Vehicle Value. 

 

9. If the vehicle belongs to your organization, check the Company Vehicle? box. 

 

10. If known, indicate where the vehicle’s license plate is registered in the Country and State/Province 

fields. 

 

11. If the vehicle’s driver was identified, check the Driver Identified box. Then, select the driver’s name 

from the Vehicle Driver pick list. If a Person record does not already exist for the individual, use the 

Quick Add function to create one. 

 

12. Enter any applicable notes under Comments. 

 

13. To add a photo of the vehicle to the record, click the Add icon  in the image box.  
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14. Locate the image file in the browser window and click Open. 

 

15. Click OK. 

 

 
 

16. As you click OK, the newly created entity will be displayed in the Involved Vehicles list, each entity 

occupying a single row in the list. To display the entity’s general information in the bottom Viewing 

pane, select the corresponding row in the list.  
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Add Losses and Recoveries Associated with the Involved Vehicle 

Complete the operation, as described in the Add Losses and Recoveries Associated with an Involved 

Entity sub-section in the Identify All Involved Persons section. 

Identify All Involved Items 

Note General Details of an Involved Item 

1. Select the Involvements tab. 

 

2. Select the Items sub-tab.  

 

3. Click Add New. A pop-up window will open.  

 

4. Select the involved item’s name from the Linked Item pick list. If an Item record does not already 

exist, use the Quick Add function to create one.  

 

• The Item Name field will now automatically populate with the linked item’s name. Depending on 

the data available, some additional fields may also populate with information drawn from the 

linked item’s record.  

 

5. If known, enter the serial or ID number of the item in the Serial Number field.  
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6. Select the most appropriate description of the item’s current status from the Disposition lookup list 

(e.g., Seized as Evidence, Destroyed, Returned to Owner).  

 

 
 

7. Enter the item’s exact or estimated value in the Item Value field. 

 

8. If applicable, check the Item is Evidence? box. 

 

9. Identify the general classification of the item by making selections from the Item Category and Item 

Type lookup lists. These fields are hierarchical. 

 

10. Specify the Item Make and Item Model. These fields are hierarchical. 

 

11. If the item’s owner is known, check the Owner Identified/Known? box. Then, select the name of the 

organization or person that owns the item from either the Organization Owned By or Person 

Owned By pick lists. If an Organization or a Person record does not already exist, use the Quick 

Add function to create one. 

 

12. Add comments about the item in the Notes field. 

 

13. To add a photo of the item to the record, click the Add icon  in the image box.  
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14. Locate the image file in the browser window and click Open. 

 

15. Click OK. 

 

16. As you click OK, the newly created entity will be displayed in the Involved Items list, each entity 

occupying a single row in the list. To display the entity’s general information in the bottom Viewing 

pane, select the corresponding row in the list.  

 

 

Add Losses and Recoveries Associated with the Involved Item 

Complete the operation, as described in the Add Losses and Recoveries Associated with an Involved 

Entity sub-section in the Identify All Involved Persons section.  

Summarize an Incident or a Case 

1. Select the Narratives tab. 

 

2. Click the appropriate Add link. The Narrative Editor window will open.  

 

3. Choose the applicable description from Narrative Type (e.g., Executive Summary, Original 

Narrative, Follow-up). By default, your name will appear in the Author field.  

 

4. Type your narrative in the text box.  
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• For details on operating the Narrative Editor, consult Appendix B: Text Editor Navigation at the 

end of this guide. 

 

5. When finished composing your narrative, click Accept & Return. The Narrative Editor window will 

close, and the new narrative record will populate the Narratives grid. 

 

 

Attach a File to a Record 

1. Select the Attachments tab. 

 

2. Select the Files sub-tab. 

 

3. Click the applicable Add link. A pop-up window will open. 

 

4. Add attachments by either dragging and dropping or clicking Browse.  

 

5. For each attachment, do the following:  

 

a. The Attachment Title field will automatically populate with the name of the attached file. If 

necessary, modify the name.  

 

b. From the Attachment Type lookup list, select the appropriate designator for the attachment 

(e.g., Document, Picture, Video, Voice Recording). 
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c. Give an overview of the attachment in the Description text box. 

 

d. For image files (e.g., .bmp, .gif, .jpg, .png), check the Include when Printing? box to have a 

copy of the image included with every print-out of the record. 

 

e. Click Remove to remove any unwanted attachments. 

 

6. Once you are finished working with attachments, click OK. 

 

 
 

7. To preview an attachment, ensure the attachment is highlighted in the grid and click View.  

 

8. Once the attachment is loaded, click Open. The attachment file will open in a separate window.  

 

9. Close the window to return to the record. 
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View Attachments 

There are two ways to view attachments in Perspective. The first way to view an attachment is the 

following: 

 

1. Select the Attachments tab. 
 

2. Select the Files sub-tab. 
 

3. Click the file name you want to view from the list of attached files. 
 

4. Click the View link. 
 

5. Click Open. 
 

The second way to view an attachment is the following: 

 

1. Select the Attachments tab. 
 

2. Select the Pictures sub-tab. Thumbnails of attached files will be visible. 
 

3. Left-click the thumbnail for a full screen view of the attachment.  
 

4. To close the full screen view of the attachment, click the X icon in the top right corner.  
 

a. Right-click the thumbnail to view the title and description of the attachment. Right-click to go 

back to the thumbnail. 

Link the Incident to an Activity 

1. Select the Links tab. 
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2. In the Activity Links section, click Add New. A pop-up window will open. 

 
3. Specify how the incident and activity are related in the Link Type field (e.g., Common Call Source, 

Common Location). 
 

4. Select the appropriate activity from the Linked From Activity pick list. 
 

5. Indicate the date that the incident became associated with the activity in the Link Effective Date 
field. 
 

6. Type any additional information about the link in the Notes field. 
 

7. Click OK. 

 
 

8. Click Save, after which this link will be automatically cross-referenced in the linked activity’s record 

under the Links tab. 
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Link an Incident to Another Incident 

1. Select the Links tab.  

 

2. In the Incident Links section, click Add New. A pop-up window will open.  

 

3. Select the appropriate incident from the Linked To Incident pick list.  

 

4. Specify how the two incidents are related in the Link Type field (e.g., Common Suspect, Similar 

Description). 

 

5. Indicate the date that the two incidents became associated with each other in the Link Effective 

Date field. 

 

6. Type any additional information about the link in the Notes field. 

 

7. Click OK.  

 
 

8. Click Save, after which this link will be automatically cross-referenced in both Incident records 

under the Links tab. 
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To link all incidents in the grid and then open Incident record to a case, follow the procedures described 

below:  

 

1. Click Add to Case. A pop-up window will open. 

 

2. Specify how the incidents are related to the case in the Link Type field (e.g., Common Person, 

Related Incidents). 

 

3. Select the appropriate case from the Linked To Case pick list. 

 

4. Indicate the date that the incidents became associated with the case in the Link Effective Date 

field. 

 

5. Type any additional information about the link in the Notes field.  

 

6. Click OK.  

 

7. A confirmation message will notify that links were created successfully. Click OK. These links will be 

automatically cross-referenced in the linked Case record under the Links tab. 
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Link an Incident to a Case 

1. Select the Links tab. 

 

2. In the Case Links section, click Add New. A pop-up window will open. 

 

3. Specify how the incident and case are related in the Link Type field (e.g., Common Person, Related 

Incidents). 

 

4. Select the appropriate case from the Linked From Case pick list. 

 

5. Indicate the date that the incident became associated with the case in the Link Effective Date field. 

 

6. Type any additional information about the link in the Notes field. 

 

7. Click OK. 
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8. Click Save, after which this link will be automatically cross-referenced in the linked case’s record 

under the Links tab. 

 

 

Record Losses Involved in an Incident and View Their Summary 

The Losses tab within an Incident record can be used to add the following types of incident losses: 

 

• Loss: A monetary loss that occurred in the course of the incident. 

 

• Recovery: A loss amount associated with an incident that has been restored or regained as a result 

of an action that had been implemented after the incident took place.   

 

• No Impact Loss: A loss that has been associated with an incident that has either been prevented or 

remains a potential loss and, hence, does not impact the Net Loss amount.\ 
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1. To add a loss, open the Losses tab and click on the Add Loss, Add Recovery, or Add No Impact 

hyperlink, depending on the type of loss that you want to record. Depending on the option you 

choose, a new screen will display a subform designed for the type of loss you selected.  

 

Note: Some of the following fields may not be available on the form that you see on the screen; 

those fields will be supplied with additional directions. 

 

2. In the process of adding a loss, you may choose to either associate the loss with the broader 

Incident record or with one of the incident’s existing involvements (i.e., an involved person, 

organization, vehicle, or item). To specify the type of data you want to associate your loss entry 

with, select one of the options from the Associated Type lookup. 

 

Note: If you want to add a loss associated with an incident’s involvement that has not been 

recorded yet, you must first create an involved record under the Involvements tab before creating 

the loss record. For a detailed description of the procedure of adding involved persons, 

organizations, vehicles, or items to an Incident record, see the Identify All Involved Persons, Identify 

All Involved Organizations, Document All Involved Vehicles, and Identify All Involved Items sections. 

 

3. If you chose to associate the loss with any of the incident’s involvements (e.g., Person Involvement), 

select the specific unit of involvement that has been previously recorded under the Incident form 

from the Associated To lookup (e.g., Brown, Jeff).  

 

Note: The options available on the lookup have been cross-populated from each of the 

involvement’s sub-tabs and can only contain involvement records that had been created and saved 

prior to adding the loss.  

The same function is available under each of the involvements’ sub-tabs. For details, please see the 

Add Losses and Recoveries Associated with an Involved Entity section. 

 

4. Enter the Date that is associated with the loss (e.g., a date when the loss or the recovery occurred, 

or a date when the no impact loss is most probable). 

 



Perspective User’s Guide  Data Forms 

 © Resolver Inc.   Page 94 of 399 

5. Enter the number of loss units, as well as the approximate value of each unit in the Unit(s) and 

Value Per Unit fields. The Total field below will automatically calculate the total value of loss 

multiplying the Unit(s) by the Value Per Unit values. 

 

6. Identify the nature of the loss under Loss Type (e.g., Direct or Indirect, Averted, or Exposure). 

 

7. If applicable, specify the reason for the actual or the potential loss you are recording under Loss 

Cause (e.g., Accident, Deliberate, or Unintentional Act). 

 

8. If you are recording a loss that has actually occurred, determine the current state of the lost unit(s) 

under Loss Status (e.g., Compromised, Lost, Stolen, or Damaged). 

 

9. Under Method, select a descriptor that best defines the way in which the loss occurred or can 

potentially occur (e.g., Wired Transfer or Cash). 

 

10. For actual and no impact losses, select the name of the person who recovered the loss or defined 

the incident as incurring potential loss from the Recovered/Determined By Person pick list. By 

default, the field will contain the name of the person recording the loss. 

 

11. If you are recording a recovery, also complete the Recovered From Person and the Recovered 

From Organization fields, as applicable. 

 

12. Enter any additional comments under Notes. 

 

13. Click OK. Once the changes are saved, the recorded loss data will populate the relevant columns of 

the Losses grid. For optimal analysis, you may arrange the loss entries by a column header (e.g., 

Associated To, Date, or Type) and change the position of the columns in the grid. 

 

14. Click Save to synchronize the recorded data within the relevant involvement records and update the 

summary calculations displayed to the right of the grid. 

 

• Total: 
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• Total Exposure: The total value of the Exposure No Impact loss associated with the incident 

and the involved entities. 

 

• Total Averted: The total value of the Averted No Impact loss associated with the incident and 

the involved entities. 

 

• Total Loss: The total value of the Loss amounts associated with the incident and the involved 

entities. 

 

• Total Recoveries: The total value of the Recovery loss associated with the incident and the 

involved entities. 

 

• Net Loss: The value determined by subtracting the Total Recoveries amount from the Total 

Loss. 

• Losses: The total values of Loss amounts arranged by Loss Type (e.g., Direct or Indirect). 

 

• Recoveries: The total values of Recovery amounts arranged by Recovery Type (e.g., Physical or 

On-line Purchase). 

 

• No Impact: The total values of Recovery amounts arranged by No Impact Type (i.e., Averted or 

Exposure). 
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Record Incident Investigation Data 

Note General Details of an Investigation 

1. Select on the Investigation tab. 

 

2. Select on the Details sub-tab. 

 

3. In the General section, select the name of the person who ordered the investigation from the 

Investigation Initiated By Person pick list. If a Person record does not already exist for the 

individual, use the Quick Add function to create one.  

 

4. Enter the date the investigation was initiated under Investigation Start Date.  

 

5. If the investigation has undergone a review, enter the applicable date in the Investigation Last 

Review Date field. 

 

6. When the investigation is complete, enter this date in the Investigation Closed Date field. 

 

7. Input general notes in the Investigation Comments box. 
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Assign an Investigator to an Incident’s Investigation 

1. In the Investigators section, click Add New. A pop-up window will open.  

 

2. Specify the applicable role of the investigator in the Investigator Type field (e.g., Lead Investigator, 

Assisting Investigator, Forensic Specialist). 

 

3. Select the record of the investigator from the Investigator pick list.  

 

4. In the Assigned Date field, enter the date and time the person was assigned to the investigation 

team. 

 

5. If the investigator is removed from the investigation team at some point, you may enter the 

applicable date and time in the Completed Date field. 

 

6. Enter any relevant notes in the Comments box. 

 

7. Click OK. 
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8. Add as many investigators to the Investigators list as necessary. 

 

 
 

9. Click Save. An Auto Notification pop-up window will appear. 

 

• To send an email notification of the assigned investigation to the investigator, ensure the 

appropriate checkbox is selected and click Send. Notifications are automatically sent in HTML. 

Deselecting the Send Formatted box, prior to clicking Send, will format the notification details 

in plain text rather than the default HTML table. 

 

• If the investigator does not have a primary email address entered in the system, an error 

message appearing beside the investigator’s name will indicate that an email cannot be sent. In 

this case, click Close to exit the window. 
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Summarize an Incident’s or a Case’s Investigation 

1. Select the Investigation tab 

 

2. Select the Summaries sub-tab.  

 

3. Click the appropriate Add link. The Summary Editor window will open. 

 

4. In the window, choose the applicable description from the Summary Type lookup list (e.g., 

Investigation Summary, Follow-up). By default, your name will appear in the Author field. 

 

4. Type your summary in the text box. For details on operating the Summary Editor, consult Appendix 

B: Text Editor Navigation at the end of this guide. 

 

5. When finished with your summary, click Accept & Return. The Summary Editor window will close, 

and the Summary’s grid will populate with the new investigation summary. 
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Log Investigative Tasks and Expenses 

1. Select the Investigation tab. 

 

2. Select the Logs sub-tab.  

3. Click the appropriate Add link. A pop-up window will open.  

 

4. Specify the nature of the task in the Task Type field. 

 

5. Select the name of the person who completed or must complete the task from the Task Done By 

Person pick list. If a Person record does not already exist for the individual, use the Quick Add 

function to create one.  

 

6. If applicable, specify the date the task was finished under Task Date, and the time it took to 

complete under Time Spent. 

 

7. If there is an expense associated with the task, enter the Expense Type and the total Expense 

Amount. 

 

8. Check the Follow-up Required? checkbox, if applicable. 

 

9. Enter any additional information about the task under Log Notes. 
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10. Click OK. The investigative task and/or expense will be added to the Logs grid. 

 

Document Investigation Interviews  

1. Select the Investigation tab. 

 

2. Select the Interviews sub-tab. 

 

3. Click the appropriate Add link. The Interview Editor window will open.  

 

4. In the window that appears, choose the applicable description from the Interview Type lookup list 

(e.g., Interview or Interrogation). 

 

5. Select the name of the person who was interviewed from the Subject of Interview pick list. If a 

Person record does not already exist for the individual, use the Quick Add function to create one. 
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6. From the Subject’s Involvement Type lookup list, specify the nature of the interviewee’s 

involvement in the occurrence.  

 

7. Select the name of the person who conducted the interview from the Interview Conducted By pick 

list. If a Person record does not already exist for the individual, use the Quick Add function to create 

one.  

 

8. Specify the Start Date/Time and the End Date/Time of the interview. 

 

9. State where the interview was conducted in the Location of Interview field. 

 

10. Identify the person who formally witnessed the interview in the Witness field. 

 

11. Check the Interview Recorded? box, if applicable. 

 

12. Type the interview transcript in the text box. For details on operating the Interview Editor, consult 

Appendix B: Text Editor Navigation at the end of this guide. 
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13. When finished composing the transcript, click Accept & Return. The Interview Editor window will 

close, and the new interview record will be entered in the Interviews grid. 

 

Track Investigation Evidence 

1. Select the Investigation tab. 

 

2. Select the Evidence/Property sub-tab. 

 

3. Click the appropriate Add link. A pop-up window will open. 

 

4. Input the item name under Evidence/Property Name. 

 

5. Choose the applicable description from the Evidence/Property Type lookup list (e.g., Found, 

Recovered, Seized). 

 

If known, select the name of the organization or person who owns the item from the Owner Name 

Organization or Owner Name Person pick lists. If an Organization or Person record does not 

already exist, use the Quick Add function to create one. 

 

6. Specify the date and time the item was found/seized in the Found/Seized Date/Time field. 

 

7. Describe where the item was found or seized in the Found/Seized Location field. 
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8. Select the person who seized the item from the Seized By Person pick list. 

 

9. Indicate who the item was seized from by making a selection from the Seized From Person pick list. 

 

10. Type any additional information about the item in the Notes textbox. 

11. To add an image of the item to the record, click the Add icon  in the image box.  

 

12. Locate the image file in the browser window and click Open. 

 

13. In the Current Status section, choose the appropriate descriptors from the Evidence Status and 

Disposition lookup lists. 

 

14. If the item is secured, enter the current location of the item in the Secured/Storage Location field. 

 

15. Select the person who is currently in possession of the item from the Person In Possession pick list. 

 

16. Input the applicable number in the Evidence/Property Tag field. 
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17. Click OK to save the entity in the Evidence/Property grid. 

 

 
 

If you need to update the evidence’s current standing, you have to open the relevant evidence entity in 

the edit mode, make the necessary changes to the fields listed under Current Status, and follow the 

procedures described below: 

 

1. Click the Update Chain of Custody link. A pop-up window will open indicating that one or more of 

the status fields have been changed. 

 

2. By default, the current date will appear in the Status Changed Date/Time field. Modify this if the 

item’s status actually changed at an earlier date. 

 

3. Explain the change to the item’s status in the Reason for Status Change textbox. 
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4. Click OK. A new entry will now appear in the evidence record’s Chain of Custody section, detailing, 

among other things, when and why the change was made. 

 

5. If you want to print the Chain of Custody grid, click the Print hyperlink.  

 

Note: The Chain of Custody is not included in the Investigation Report. Therefore, this printing 

option is only available via the Evidence/Property sub-tab. 
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View an Incident’s Key Investigative Data Summary 

1. Select the Investigation tab. 

 

2. Select the Details sub-tab. The incident’s key investigative data will be displayed in the form of a 

table next to the general details of the investigation: 

 

• Total Time Spent: The total number of hours spent on the investigation to date, drawn from the 

Logs sub-tab. 

 

• Total Expenses: The total cost of investigation to date, drawn from the Logs sub-tab. 

 

• Total Evidence: The total number of evidence pieces that investigators have collected to date, 

drawn from the Evidence/Property sub-tab. 

 

• Number of Interviews: The total number of interviews that investigators have conducted to 

date, drawn from the Interviews sub-tab. 

• Number of Investigators: The total number of investigators examining the incident, drawn from 

the Investigators section of the Details sub-tab. 

 

• Investigation Duration: The length of the investigation, based on the time elapsed from the 

Investigation Start Date to the Investigation Closed Date (or current date if the investigation is 

not yet closed). 

 

3. To refresh the information in the summary table, click the Update link. 

 

4. Every time a review of the investigation is conducted, make sure to change the Investigation Last 

Review Date field. 

 

5. Once the investigation is completed, enter the relevant date in the Investigation Closed Date field. 
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Control a Record’s Processing Options 

Set the Security Controls and Status of a Record 

1. Select the Controls tab; the Details sub-tab will open by default.  

 

2. In the Controls section, fill out the Org Level fields to set the record visibility settings for the various 

groups within your organization. Organizational rollups are hierarchical, so the option you select in 

the Org Level 1 field will determine what options are available in the Org Level 2 field, and so on. As 

you move down the hierarchy, organizational rollups become more specific, naming groups within 

your organization that are increasingly specialized by company division or region. 

Only users with organizational rollups corresponding to or higher than the organizational rollup you 

select for the record will have access to it. For example, if a record’s rollup is North 

America/Canada/Alberta, the user whose organizational rollup is North America or North 

America/Canada/Alberta will have access to the record, while the user whose organizational rollup 

is North America/Canada/Alberta/Edmonton will not. 
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3. In the Access Level field, set the security level from 1 to 5. Each security level corresponds to a 

specific security description, such as Classified. Only users with the same security Access Level as 

the one you select (or higher) will be able to view the record. 

 

4. If you want to archive the record making it unavailable for users to access, check the Archive 

(Record is not visible) box. 

 

5. Set the Status of the record to Open or Closed. Meanings of open and closed are dependent on 

your organization’s definition of these statuses. Generally, an open record means that it is actively 

being worked on or, possibly, is inactive for a finite amount of time. The closed status in this case 

would mean that the record is no longer being worked on due to completion or inactivity for an 

indefinite amount of time. 

 

6. Select the most appropriate description of the record’s current standing in the Disposition field 

(e.g., Inactive, Pending Court, Waiting for Approval). 

 

7. If any policy, legislation, or business rule pertinent to your organization’s procedures requires 

information about the record, or the persons involved in the record, to be kept for a certain length of 

time, enter the end date of that period in Expiry Date.  

 

Note: No information will automatically be deleted on this date; it is for tracking purposes only. 

 

8. From the Record Owner pick list, select the Person record that corresponds to the individual who is 

responsible for the closing the record. If a Person record does not already exist for this individual, 

use the Quick Add function to create one. 
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Define Which Workgroups Can Access a Record 

1. In the Workgroup Visibilities section, give one workgroup the ability to read and modify the record 

by selecting them under Owner Workgroup (Full Rights). Initially, the field will contain the name of 

your default workgroup. Once you attempt to change it, the system will display a confirmation 

dialog asking you if the Full Access rights that belong to the original owner workgroup should be 

transferred to the workgroup you have chosen.  

 

2. Click OK if the change was intentional. 

 

3. Determine the access right for All Other Workgroups, selecting from the Read, Update, or None 

access right options. 

 

4. To set customized access for a workgroup that does not conform to the other control settings 

specified, click Add Exception(s). A pop-up window will open. 

 

5. Select the workgroup and then select the workgroup’s visibility for this record (Read, Update, or 

None). Continue to customize workgroup visibility for as many workgroups as you like.  

 

Note: Workgroup visibility exceptions override the access settings assigned under All Other 

Workgroups. 
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6. Click OK. The selected workgroups and their corresponding modified access settings will be 

transferred to the Workgroup Visibilities grid. 

 

 

Describe the Incident’s Causes and Consequences 

1. Select the Outcome sub-tab.  

 

2. If any polices or procedures were implemented, breached, or affected as a result of the incident, 

note this by checking the Policy Affected box and entering the Policy Name.  

 

3. Once you have established why the incident occurred, select your conclusions from the Primary 

Cause lookup list and, if applicable, the Secondary Cause lookup list. 

 

4. Add new policy information or action taken in the Corrective Action Summary text box. 
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Document a Record-Related Review 

1. Select the Reviews sub-tab. 

 

2. Click Add New. A pop-up window will open. 

 

3. Choose the applicable description from the Review Type lookup list. 

 

4. By default, your name will appear in the Reviewed By Person field. If you are not the person who 

conducted the review, select the applicable person from the pick list.  

 

5. Enter the date and time that the review was completed in the Review Date field. 

 

6. Enter observations, results, notes, or other details pertaining to the review in the Comments box.  

 
 

7. Click OK. The review entry will be added to the list of existing reviews in the main window. 
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Give a Record-Related Assignment to Another User 

1. Select the Assignments sub-tab.  

 

2. Click Add New. A pop-up window will open.  

 

3. Choose the applicable option from the Assignment Type lookup list. 

 

4. By default, your name will appear in the Assigned By Person field. If you are not the person who 

created the assignment, select the applicable person from the pick list.  

 

5. Select the user who must complete the assignment from the Assigned To Person pick list.  

 

6. Complete the Assigned Date, and enter the date the assignment must be completed under Due 

Date. 

 

7. When the assignment is finished, check the Completed? box and enter the appropriate date in the 

Completed Date field. 

 

8. Enter notes or instructions in the Message/Task text box. 
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9. Click OK. The new assignment will be added to the Assignments grid. 

 
 

10. Click Save. An Auto Notification pop-up window will appear. 

 

• To send email notifications of the assignments to the Assigned To Persons and/or of the 

completed assignments to the Assigned By Persons, ensure the appropriate checkboxes are 

selected and click Send. Notifications are automatically sent in HTML. Deselecting the Send 

Formatted box prior to clicking Send will format the notification details in plain text rather than 

the default HTML table. Once the notifications are sent, the Dashboards of the persons involved 

in the assignment will be populated with relevant Assignment records. 
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• If the person does not have a primary email address entered in the system, an error message 

appearing beside the person’s name will indicate that an email cannot be sent. In this case, click 

Close to exit the window. 

 
 

11. Every time you add a new assignment to the Assignments list or edit the old one and click Save, the 

system will automatically prompt you to send an email notification about the changes made. 

However, if you want to send an email notification of any of the record’s old unedited assignments, 

you will need to select the specific assignment in the list and click Notify. An email message will 

open that contains the assignment and the record details. 

 

12. Check the message details, adding any other information that you think is necessary, and then click 

Send.  
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Track Changes Made to a Record 

1. Select the Audit History tab.  

 

2. Click Get Audit History to view all modifications made to the record since its creation. The Viewing 

pane will display entries for each change made to the record. Among the available data categories 

are the following: 

 

• DateTime indicates the time when the change was made in GMT. 

 

• UserID reveals who made the change. 

 

• Record Action describes what type of change was made. 

 

• Control Changes displays any modifications made under the Controls tab. 
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• Machine Info specifies which computer was used to make the change. 

 
 

3. Select an entry to view further details in the Audit tree displayed on the right. 

 

4. Expand the nodes of the audit tree to see exactly what the data value was Before and After the 

change was made. 

 

5. To group entries of the Audit History by one of the column headers, drag the header to the field at 

the top of the grid. The black arrows will indicate a legitimate place for dropping the header. The 

entries will be grouped under the criteria available in the column, each criterion corresponding to a 

single group of entries. 

 

6. If you want to further subgroup the entries in the available groups, drag the next column header to 

the grouping field. In this case, the first column header will remain the main grouping option, while 

all the subsequently added headers will create an internal grouping hierarchy within the main 

grouping.  
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7. You may invert the hierarchy at any time by dragging the corresponding column header to the 

appropriate node in the grouping tree. 

 

Cases 

A case is a convenient tool that organizes multiple incidents that have a common reference subject or 

object (e.g., a common subject of interest, a similar organization where incidents took place) into a single 

entity that is designed for a more effective investigation process. Multiple incidents can make up one 

case. Therefore, many operations implied in completing a Case data form require you to choose if you 

would like to add data to the currently open Case record, or to an Incident that is linked to the currently 

open Case record.  

 

This choice is controlled by the relevant functions on the Viewing pane: 

 

• Click Add to Cases to connect a data entry operation to the currently open case. 
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• Click Add to Incident and select the appropriate incident from the pick list to connect the data entry 

operation to an incident linked to the currently open case. 

Create a new Case record 

1. Click the Add button  on the Viewing pane toolbar.  

 

2. Give the case a descriptive Case Name. 

 

3. Identify the general classification of the case under Case Category. 

 

4. Indicate when the case was opened under Case Start Date. 

 

5. If the case has undergone a review, enter the applicable date in the Last Reviewed Date field.  

 

6. When the case has been closed, enter this date in the Case Closed Date field. 

 

7. Select the name of the Case Manager, as well as the Case Supervisor, from the applicable pick list 

fields.  

 

8. Type a very brief overview of the case in the Case Description box. To enter a more detailed 

description of the case, use the Narratives tab. 

 

9. Perspective will automatically assign the case a Case Number when the record is saved. 
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Assign an Investigator to a Case’s Investigation 

1. In the Investigators section of the General tab, click Add New. A pop-up window will open. 

 

2. Specify the applicable role of the investigator in the Investigator Type field (e.g., Lead Investigator, 

Assisting Investigator, Forensic Specialist). 

 

3. Select the name of the investigator from the Investigator pick list. 

 

4. In the Assigned Date field, enter the date and time the person was assigned to the investigation 

team. 
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5. If the investigator is removed from the investigation team at some point, you may enter the 

applicable date and time in the Completed Date field.  

 

6. Enter any relevant notes in the Comments field. 

 
 

7. Click OK and proceed to enter as many investigators as necessary. 

 

 
 

8. If you save the Case record changes at the time of entering a new Investigator, an Auto Notification 

pop-up window will appear. 

 

• To send an email notification of the assigned investigation to the investigators, ensure the 

appropriate checkboxes are selected and click Send. Notifications are automatically sent in 

HTML. Deselecting the Send Formatted box prior to clicking Send will format the notification 

details in plain text rather than the default HTML table. 
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• If the investigator does not have a primary email address entered in the system, an error 

message appearing beside the investigator’s name will indicate that an email cannot be sent. In 

this case, click Close to exit the window. 

 

View All Case’s Involvements 

1. Select the Involvements tab. 

 

2. Depending on the type of involvement data required, select the Persons, Organizations, Vehicles, 

or Items sub-tab. A list of all corresponding entities contained in the case’s linked incidents, as well 

as their essential details, will appear in form of a grid. 

 

3. Select an entity in the grid to display its details in the form at the bottom of the window. 

 

4. To view the history of the entity’s involvements, select the entity in the grid, and click History. All 

incidents the entity has been involved in will be displayed in a pop-up window. 
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5. To transfer to an entity’s main record, select the entity in the grid and then click Go To 

Persons/Organizations/Vehicles/Items. To return to the Case record, select Cases in the Navigation 

pane. 

 

6. To transfer to an entity’s Involvement subform within its Incident record that is linked to the 

currently open Case record, select the entity in the grid and click Go To Incidents. To return to the 

Case record, select Cases in the Navigation pane. 
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Note: If an involvement is added to multiple incidents and then you create a case with one of those 

incidents, the Linked Incidents tab will display all incidents with the involvement. 

Summarize a Case or an Incident Linked to a Case 

Open the Narratives tab and complete the operation, as described in the Summarize an Incident or a 

Case section in the Incidents chapter. 

Attach a File to a Case Record 

Open the Attachments tab and complete the operation, as described in the Attach a File to a Record 

section in the Incidents chapter. 

Link an Incident to a Case 

Note: This function is also accessible via Link New Incident      under the General tab. 
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1. Select the Links tab. 

 

2. In the Linked Incidents section, click Add New. A pop-up window will open. 

 

3. Specify how the incident and the case are related in the Link Type field (e.g., Common Suspect, 

Similar M.O.). 

 

4. Select the appropriate incident from the Link Incident To Case pick list. 

 

5. Indicate the date that the incident became associated with the case in the Link Effective Date field. 

 

6. Type any additional information about the link in the Notes field. 

 

7. Click OK.  

 
 

8. After saving, the created link will be automatically cross-referenced in the linked Incident record 

under the Links tab.  

 

Note: The data contained in the linked Incident record (including Involvements, Narratives, 

Attachments, Investigation, and Loss Summary) will be automatically imported into your Case 

record. This will be reflected in the Summary section on the right side of the Viewing pane under 

the General tab. 
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Link a Case to Another Case 

Note: This function is also accessible via Link New Case  under the General tab. 

 

1. Select the Links tab.  

 

2. In the Linked Cases section, click Add New. A pop-up window will open. 

 

3. Specify how the two cases are related in the Link Type field (e.g., Common Suspect, Similar M.O.). 

 

4. Select the case that you want to link to the open case from the Linked To Case pick list. 

 

5. Indicate the date that the two cases became associated with each other in the Link Effective Date 

field. 

 

6. Type any additional information about the link in the Notes field. 

 

7. Click OK.  
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8. After saving, the created link will be automatically cross-referenced in both Case records under the 

Links tab. 

 
 

View a Summary of Losses Involved in a Case 

1. Select the Losses tab. 

 

2. If involvement losses have been recorded for any of the case’s linked incidents, the Loss and 

Recovery Details grid will display each recorded loss entry arranged by Incident ID and supplied 

with such information as the Date the loss was recorded, the record or sub-record type the loss has 

been Associated To, the Type of loss, and the relevant value of the loss by loss category (i.e., Loss, 
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Recovery or No Impact). For optimal analysis, you may arrange the loss entries by a column header 

(e.g., Associated To, Date, or Type) and change the position of the columns in the grid. 

 

3. Click Save to update the summary calculations displayed to the right of the grid: 

 

• Totals: 

 

Total Exposure: The total value of the Exposure No Impact loss associated with Incident 

records linked to the case. 

 

Total Averted: The total value of the Averted No Impact loss associated with Incident records 

linked to the case. 

 

Total Loss: Total value of Loss amounts associated with Incident records linked to case. 

 

Total Recoveries: The total value of the Recovery loss associated with Incident records linked to 

the case. 

 

Net Loss: The value determined by subtracting the Total Recoveries amount from the Total 

Loss. 

 

• Averages: 

 

Average Exposure: The average value of the Exposure No Impact loss across the Incident 

records linked to the case (i.e., Total Exposure divided by Total Incidents). 

 

Average Averted: The average value of the Averted No Impact loss across the Incident records 

linked to the case (i.e., Total Averted divided by Total Incidents). 

 

Average Loss: The average value of the Loss amount across the Incident records linked to the 

case (i.e., Total Loss divided by Total Incidents). 
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Average Recoveries: The total value of the Recovery loss across the Incident records linked to 

the case (i.e., Total Recoveries divided by Total Incidents). 

 

Average Net Loss: The value determined by subtracting the Average Recoveries amount from 

the Average Loss. 

 

 
 

View and Record Case Investigation Data 

View Key Investigative Data From a Case’s Linked Incidents 

Select the Investigation tab, and then select the Details sub-tab. 

 

The General section lists all incident investigations that have been linked to the case, including such 

details as Incident Number, name of the person who initiated the investigation (Initiated By), and 

Investigation Start Date, Review Date, Close Date, and Duration. 

 

In the Linked Incident Investigators section, you will find a list of all the investigators of incidents linked to 

the case. The grid lists such details as Incident ID, Investigator Type, date, and time the investigator was 

assigned to the incident (Assigned Date), date the investigator was removed from the incident’s 

investigation (Completed Date), and Comments. 

 

Note: Do not confuse the Linked Incident Investigators with the Investigators that are assigned to the 

currently open case added under the case’s General tab. 
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Summarize a Case’s Investigation or the Investigation of an Incident Linked to a Case 

Select the Investigation tab, the Summaries sub-tab, and complete the operation, as described in the 

Summarize an Incident’s or a Case’s Investigation section in the Incidents chapter. 

Log Investigative Tasks and Expenses for a Case or an Incident Linked to a Case 

Select the Investigation tab, the Logs sub-tab, and complete the operation, as described in the Log 

Investigative Tasks and Expenses section in the Incidents chapter. The summary of all tasks and 

expenses data associated with the related records will be calculated above the grid. 

Document Investigation Interviews for a Case or an Incident Linked to a Case 

Select the Investigation tab, the Interviews sub-tab, and complete the operation, as described in the 

Document Investigation Interviews section in the Incidents chapter. 

Track Investigation Evidence for a Case or an Incident Linked to a Case 

Select the Investigation tab, the Evidence/Property sub-tab, and complete the operation, as described in 

the Track Investigation Evidence section in the Incidents chapter. 
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Control a Case Record’s Processing Options 

For control options available for Case records, refer to the Control Record’s Processing Options section.  

 

Note: The option to describe an occurrence’s causes and consequences under the Outcome sub-tab is 

only available within the Incidents component, and is absent on a Case form. 

View a Quick Summary of a Case’s Key Data 

As you open your Case record, click the General tab. Key information, summarizing data from a number 

of forms within the Case record, will be collected along the right side of the Viewing pane. 

Case Summary 

• Status: The status of the case (e.g., Open or Closed), drawn from the Controls tab. 

 

• Case Duration: The length of the case, based on the time elapsed from the Case Start Date to the 

Case Closed Date (or current date if the case is not yet closed), drawn from the General tab > 

Details section. 

 

• Number of Case Investigators: The total number of investigators assigned to the case, drawn from 

the General tab > Investigators section. 

 

• Number of Linked Incidents: The total number of incidents linked to the case, drawn from the Links 

tab > Linked Incidents section. 

 

• Initial Incident Occurred: The earliest date and time that any of the incidents linked to the case 

occurred (i.e., the earliest Occurred From Date/Time), drawn from the Links tab > Linked Incidents 

section. 

 

• Disposition: The current standing of the case (e.g., Active, Pending Court, etc.), drawn from the 

Controls tab. 



Perspective User’s Guide  Data Forms 

 © Resolver Inc.   Page 132 of 399 

 

Investigation Summary 

The data for the Investigation Summary section is drawn from the Investigation tab. 

 

• Total Time Spent: The total number of hours spent on the case’s investigation to date, plus the 

investigations of all incidents linked to the case, drawn from the Logs sub-tab. 

 

• Total Expense: The total cost of the case’s investigation to date, plus the investigations of all 

incidents linked to the case, drawn from the Logs sub-tab. 

 

• Total Evidence: The total number of evidence pieces collected in the case’s investigation to date, 

plus the investigations of all incidents linked to the case, drawn from the Evidence/Property sub-

tab. 

 

• Number of Interviews: The total number of interviews conducted in the case’s investigation to date, 

plus the investigations of all incidents linked to the case, drawn from the Interviews sub-tab. 

 

• Number of Incident Investigators: The total number of investigators assigned to the case’s linked 

incidents, drawn from the Details sub-tab > Linked Incident Investigators section. 

 

• Total Investigation Duration: The total length of the investigations of all incidents linked to the 

case, based on the time elapsed from each of their Investigation Start Dates to their Investigation 

Close Dates (or current date if an investigation is not yet closed), and drawn from the Details sub-

tab > General section. 
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• Number of Incidents Investigated: The total number of incidents linked to the case that are 

undergoing (or have already undergone) investigation, drawn from the Details sub-tab > General 

section. 

 

• Incidents Not Investigated: The total number of incidents linked to the case that are not 

undergoing (or have not undergone) investigation, determined by subtracting the Number of 

Incidents Investigated (stated above) from the Number of Linked Incidents (listed in the preceding 

Case Summary section). 

 

 

Involvement Summary 

The data for the Involvement Summary section is drawn from the Involvements tab. 

 

• Number of Persons: The total number of involved persons from all the incidents linked to the case, 

drawn from the Persons sub-tab. 

 

• Number of Organizations: The total number of involved organizations from all the incidents linked 

to the case, drawn from the Organizations sub-tab. 

 

• Number of Items: The total number of involved items from all the incidents linked to the case, 

drawn from the Items sub-tab. 

 

• Number of Vehicles: The total number of involved vehicles from all the incidents linked to the case, 

drawn from the Vehicles sub-tab. 
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Loss Summary 

The data for the Loss Summary section is drawn from the Losses tab > Totals section. 

 

Track Changes Made to a Case Record 

Open the Audit History tab and complete the operation, as described in the Track Changes Made to a 

Record section in the Incidents chapter. 

Activities 

Create a New Activity Record 

Generally, activities are created and dispatched using the DispatchLog module embedded in Perspective 

or Dispatch, the separately managed application. (See the Resolver Support site for more information on 

DispatchLog or Dispatch). Once an activity is closed in DispatchLog or Dispatch, it is transferred to the 

main Activities database in Perspective, maintaining any information that has been recorded in 

DispatchLog or Dispatch. The information that is imported from DispatchLog or Dispatch includes 

general activity details, location and responsible persons, officers’ and organizations’ responses, 

involvements, attachments, activity notes, and the basic Controls options (i.e., Activity Status, Owner 

Workgroup, Access Level, and Workgroup Visibilities). However, if required, an Activity record may be 

created from scratch within the centralized database in Perspective. 

 

 

https://support.resolver.com/hc/en-ca/sections/201705483-Documentation
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1. Click the Add button      in the Viewing pane toolbar.  

 

2. Indicate when the activity was reported to supervisors under Reported Date/Time. By default, the 

field will populate with the current date and time. 

 

3. Indicate when the activity call was assigned to an officer or organization under Assigned 

Date/Time. 

 

4. Select the activity category under the Level 1, Level 2, and Level 3 lookups. These fields are 

hierarchical, meaning that the option selected in the first field (i.e., Level 1) determines the options 

that are available in the second field (i.e., Level 2), and so on. The options that appear in these lists 

have been customized by your organization.  

 

5. Depending on the category specifications selected for the activity, the system will build the 

appropriate activity Code. Alternatively, you may quickly enter the code to auto-populate the 

activity category Levels. 

 

6. Specify the Priority for the activity, selecting from the lookup options. The default value in the 

Priority field is determined by the category specifications/code selected for the activity. 

 

7. If the activity has been closed, enter the date of its closure in the Closed Date/Time field. For the 

Activity records that have previously been closed within the DispatchLog or Dispatch, this field will 

already contain the date of closure. 

 

 
 

8. Specify the location of the activity by making selections from the Site, Building, Location, and 

Section lookup lists.  
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9. The address fields (i.e., Address, Address 2, Postal Code, Country, State/Province, and City) will 

automatically populate according to the site specifications entered. Alternatively, you may enter/edit 

the address manually. If the activity took place off site, mark the corresponding checkbox and enter 

the exact address of the off-site activity location. 

 

10. In the Description text field, type in a detailed description of the activity.  

 
 

11. In the Supplemental Details section, select the Call Source for the activity (e.g., Alarm, External 

Caller – Cell). 

 

12. Click the corresponding Add icons  and select the names of the following responsible persons: 

 

• Call Taken By—The user who is responsible for recording the call. Usually, the call taker is the 

person who creates the original Activity record. 

 

• Initiated By—The user who initiated the call and provided basic information for creation of the 

activity. Enter the initiator’s Contact Number in the field on the left. 

 

• Dispatched By—The person who dispatches officers/organizations for the activity. 
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13. To enter a brief update to the activity’s disposition or status, type the notes in the Activity Notes 

text box and click Add Notes. Each note will be supplied with a date stamp and the user name of 

the reporting person. 

 

Note: Perspective will automatically supply the Activity record with an Activity Number when the 

record is saved.  

Record an Officer’s Response to an Activity 

1. Select the Responses tab. 

 

2. Select the Officer Responses sub-tab. 

 

3. Click Add New. A pop-up window will open. 

 

4. Select the responding officer’s record from the Officer Name pick list. 

 

5. The Call Sign field will auto-populate with the selected officer’s call sign abbreviation. 

 

6. Track the temporal progress of the officer’s response specifying the following time points: 

 

• Assigned Date/Time—The date and time the officer was dispatched for the activity.  

 

• Abandoned—Check the Abandoned box if the officer has been assigned to the activity, but did 

not manage to carry out the response tasks due to the reassignment for another activity, or if 

they did not arrive at the site of the activity. 

 

• Start Date/Time—The date and time the officer started to respond to the activity. 
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• Arrived Date/Time—The date and time the officer arrived on the activity’s site. 

 

• Cleared Date/Time—The date and time the officer completed the activity and vacated the site. 

 

7. Once the appropriate dates and times have been entered, the system will calculate how long it took 

the officer to respond (Response Time) and how long they remained on site (Time On Site). 

 

8. Enter any additional information about the officer’s response in the Officer Response Notes text 

box. 

 
 

9. Click OK. The new officer’s response entity will be saved as an entry in the Officer Responses grid.  

 

 
 

Record an Organization’s Response to an Activity 

1. Select the Responses tab. 
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2. Select the Organization Responses sub-tab. 

 

3. Click Add New. A pop-up window will open. 

 

4. Select the responding organization’s record from the Organization pick list. If the corresponding 

Organization record does not already exist, use the Quick Add function to create one. 

 

5. The Organization Name field will now automatically populate with the linked organization’s name. 

Depending on the data available, some additional fields may also populate with information drawn 

from the linked Organization record. 

 

6. To add the organization’s logo to the record, click the Add icon  in the image box.  

 

7. Locate the image file in the browser window and click Open. 

 

8. Specify the category of the organization’s response (e.g., Emergency Service, Responding 

Service/Agency, Indirectly Involved) by selecting a description from the Involvement Type lookup 

list. 

 

9. If applicable, input the organization’s file, ID, or other tracking number in the Organization Number 

field. 

 

10. Select the applicable Organization Type from the lookup list. 

 

11. Specify the mode by which the organization has been notified of the activity in the Notified By 

lookup list. 

 

12. If there is any documentation associated with the organization’s response to the activity (e.g., a 

work order), note the associated tracking number in the Reference Number field. 

 

13. Select the name of the organization’s primary contact from the Contact Person pick list. If a Person 

record does not already exist for the individual, use Quick Add to create one.  
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14. Enter the contact person’s phone number under Contact Phone. 

 

15. Select the record of the person in the organization who responded to the activity from the 

Responding Person pick list and the record of the person who called the organization from the 

Notified By Person pick list. If a Person record does not already exist for the individual, use the 

Quick Add function to create one. 

 

15. Track the temporal progress of the organization’s response by specifying the following time points: 

 

• Called Date/Time—The date and time the organization was contacted about the activity. Check 

the No Responses box if the organization did not respond. 

 

• Arrived Date/Time—The date and time the organization arrived on site. 

 

• Cleared Date/Time—The date and time the responding organization vacated the site after 

having had completed the response. 
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16. Once the appropriate dates and times are entered, the system will calculate how long it took the 

organization to respond (Response Time) and how long they remained on site (Time On Site). 

 

17. Enter any additional information about the organization’s response in the Response Notes text box.  

 

18. Click OK. The new organization’s response entity will be saved as an entry in the Organization 

Responses grid. 

 

 
 

Note an Action Request for an Activity 

1. Select the Requests tab. 

 

2. Select Add New. A pop-up window will open. 

 

3. Select the requested organization’s record from the Organization pick list. If the corresponding 

Organization record does not already exist, use the Quick Add function to create one. 

 

4. The Organization Name field will now automatically populate with the linked organization’s name. 

Depending on the data available, some additional fields may also populate with information drawn 

from the linked Organization record. 

 

5. To add the organization’s logo to the record, click the Add icon  in the image box.  
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6. Locate the image file in the browser window and click Open. 

 

7. Specify the type of services offered by the requested organization selecting a description from the 

Involvement Type lookup list. 

 

8. If applicable, input the organization’s file, ID, or other tracking number in the Organization Number 

field. 

 

9. Select the applicable Organization Type from the lookup list. 

 

10. Specify the mode by which the action has been requested in the Notified Type lookup list (e.g., via 

Perspective DispatchLog, Investigator, or Control Center). 

 

11. Note the organization’s associated Reference Number. 

 

12. Select the name of the requested organization’s primary contact from the Contact Person pick list. 

If a Person record does not already exist for the individual, use the Quick Add function to create 

one.  

 

13. Enter the contact person’s phone number under Contact Phone. 

 

14. Choose the appropriate description for the requested action (e.g., Maintenance, Escort, Window 

Repair) from the Request Type lookup list. 

 

15. Select the record of the person who has been administered the request from the Request Assigned 

To Person pick list. If a Person record does not already exist for the individual, use the Quick Add 

function to create one. 

 

16. Enter the date and time the request was made in the Assigned Date/Time field.  

 

17. When the action is complete, input the Completed Date/Time. 
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18. If there is a tracking or other ID number assigned to the action request, enter it in the Tracking 

Number field. 

 
 

19. Enter any additional Request Notes. 

 

20. Click OK. The new action request entity will be saved as an entry in the Organization Responses 

grid. 
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Identify All Persons Involved in an Activity 

The Persons sub-tab in the Involvements tab provides space to record persons that have been involved 

in the selected activity. The procedures of identifying persons involved in an activity are identical to the 

processes described for Incident records with one exception: in an Activity record, there is no option to 

add a loss or recovery associated with the involved person. For details, please refer to the Identify All 

Involved Persons section. 

Identify All Organizations Involved in an Activity 

The Organizations sub-tab in the Involvements tab provides space to record organizations that have 

been involved in the selected activity. The procedures of identifying organizations involved in an activity 

are identical to the processes described for Incident records with one exception: in an Activity record, 

there is no option to add a loss or recovery associated with the involved organization. For details, please 

refer to the Identify All Involved Organizations section. 

 

To note an action request sent to the organization, use the options under the Requests tab. For details, 

refer to the Note an Action Request for an Activity section. 

 

To log the organization’s response to the activity, use the options under the Responses tab. For details, 

refer to the Record an Organization’s Response to an Activity section. 
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Document All Vehicles Involved in an Activity 

The Vehicles sub-tab in the Involvements tab provides space to record vehicles that are involved in the 

selected activity. The procedures of identifying these vehicles are identical to the processes described for 

Incident records with one exception: in an Activity record, there is no option to add a loss or recovery 

associated with the involved vehicle. For details, please refer to the Document All Involved Vehicles 

section. 

Identify All Items Involved in an Activity 

The Items sub-tab in the Involvements tab provides space to record items that are involved in the 

selected activity. The procedures of identifying these items are identical to the processes described for 

Incident records with one exception: in an Activity record, there is no option to add a loss or recovery 

associated with the involved item. For details, please refer to the Identify All Involved Items section. 

Attach a File to an Activity Record 

Open the Attachments tab and complete the operation, as described in the Attach a File to a Record 

section in Incidents chapter. 

Link an Activity to Another Activity 

1. Select the Links tab. 

 

2. Select the Activity Links sub-tab. 

 

3. Click Add New. A pop-up window will open. 

 

4. Specify how the two activities are related in the Link Type field (e.g., Identical, Common Location). 

 

5. Select the activity that you want to link to the open activity from the Linked to Activity pick list. 

 



Perspective User’s Guide  Data Forms 

 © Resolver Inc.   Page 146 of 399 

6. Indicate the date that the two activities became associated with each other in the Link Effective 

Date field. 

 

7. Type any additional information about the link in the Notes field. 

 

8. Click OK.  

 
 

9. After saving, the created link will be automatically cross-referenced in both Activity records under 

the Links tab. To review a complete record of an activity linked to the currently open activity, select 

the correct link from the list of Linked Activities and click Go To. 

 

 

Link an Activity to an Incident 

1. Select the Links tab. 

 

2. Select the Incident Links sub-tab. 
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3. To create the link between an existing Incident record and your Activity record, click Add New. A 

pop-up window will open. 

 

4. Specify how the activity and the incident are related in the Link Type field (e.g., Escalated to 

Investigation, Follow-up). 

 

5. Select the appropriate incident from the Linked To Incident pick list. 

 

6. Indicate the date that the activity became associated with the incident in the Link Effective Date 

field. 

 

7. Type any additional information about the link in the Notes field. 

 
 

8. Click OK. After saving, the created link will be automatically cross-referenced in the linked Incident 

record under the Links tab. 
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Control an Activity Record’s Processing Options 

Set the Security Controls and Status of the Activity Record 

1. Select the Controls tab; the Details sub-tab will open by default. 

 

2. In the Controls section, fill out the Org Level fields to set the record visibility settings for the various 

hierarchically organized groups within your organization. Only users with organizational rollups 

corresponding to, or higher than, the organizational rollup you select for the record will have access 

to it. 

 

3. In the Access Level field, set the security level from 1 to 5. Each security level corresponds to a 

specific security description, such as Classified. Only users with the same security Access Level as 

the one you select (or higher) will be able to view the record. 

 

4. Set the Activity Status to one of the following descriptors: 

 

• Open - Report Required—The meaning of open is dependent on your organization’s definition 

of this status. Generally, an open record means that it is actively being worked on or, possibly, is 

inactive for a finite amount of time. This status would normally be assigned to an open activity 

that requires additional information. 

 

• Closed - Report Completed—The meaning of closed is dependent on your organization’s 

definition of this status. Generally, a closed status means that the record is no longer being 

worked on due to completion or inactivity for an indefinite amount of time. This status would 
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normally be assigned to a closed activity that is no longer being worked on and that contains a 

report. 

 

• Closed - No Report—This status would normally be assigned to a closed activity that is no 

longer being worked on and that does not contain a report. 

 

5. Select the most appropriate description of the activity’s current standing in the Disposition field 

(e.g., Inactive, Under Investigation, Waiting for Approval). 

 

6. From the Record Owner pick list, select the Person record that corresponds to the individual who is 

responsible for the closing the record. If a Person record does not already exist for this individual, 

use the Quick Add function to create one. 

 

7. If you want to archive the Activity record making it unavailable for users to access, check the 

Archive (Record is not visible) box. 

 

8. If any policy, legislation, or business rule pertinent to your organization’s procedures requires 

information about the record, or the persons involved in the record, to be kept for a certain length of 

time, enter the end date of that period in Expiry Date.  

 

Note: No information will automatically be deleted on this date; it is for tracking purposes only. 
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Define Which Workgroups Can Access the Activity Record 

In the Workgroup Visibilities section of the Details sub-tab, define access options for the record, as 

described in the Define Which Workgroups Can Access the Record section in the Incidents chapter. 

Review the Standard Operating Procedures for the Activity Record’s Specifications 

Note: The function to review the Standard Operating Procedures (SOPs) for an Activity record is only 

available if the Activity’s specifications correspond to a SOP that was previously recorded in the 

Administration component of Perspective. For further details, see the Perspective Administrator’s Guide. 

If the Standard Operating Procedures sub-tab is absent, then there are no specific procedures to follow 

for this type of activity. 

 

1. Select the Controls tab. 

 

2. Select the Standard Operating Procedures sub-tab. 

 

3. Review the Procedure Description of the Standard Operating Procedures (SOP) available for the 

activity’s Call Category, Site, and/or Status.  

 

4. Check off the SOP procedures that have been completed under SOP Checklist. 

 

5. Click Save. 
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6. View the relevant SOP Attachments by double-clicking on them. 

 

7. Click on the individual SOP Links to open the related network locations, files, or Web links. 

 

8. To view mass notifications and/or individual email notifications that have been sent in relation to the 

activity, click on the View Details and the View Email hyperlinks correspondingly. The record of the 

selected notification will appear in a separate window. 

 

 
 

Give an Activity-Related Assignment to Another User 

In the Assignments sub-tab, give an activity-related assignment to another user, as described in the Give 

a Record-Related Assignment to Another User section in the Incidents chapter. 

Track Changes Made to an Activity Record 

Open the Audit History tab and complete the operation, as described in the Track Changes Made to a 

Record section in the Incidents chapter. 
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Escalate an Activity Record to an Incident 

If an Activity record has exceeded the scope of the provided Activity data form functions and requires a 

more detailed analysis and investigation, you may escalate it to a full-fledged Incident record on the basis 

of the information stored in the original Activity record. 

 

To perform this operation, click on the Create Incident  button on the Viewing pane and complete the 

remaining Incident form data, as described in the Incidents chapter. All the data contained in the original 

Activity record that matches a regular Incident form will be copied to the new Incident record, while the 

Activity Notes will be saved as unsealed Original Activity Notes under the Narratives tab.  

 

Click Save to assign the new Incident record an Incident Number and save it in the system. The new 

Incident record creation information will be documented under the Audit History tab as a new record 

action.  

 

Note: The original Activity record will remain intact. 

Items 

Create a New Item Record 

Perspective provides two ways to create a new Item record: with the help of the standard Add function, 

and by importing an Item record from the Gateway. To create an Item record using the standard Add 

function, follow the steps described below. 

 

1. Click the Add button  on the Viewing pane toolbar. 

 

2. Give the item a descriptive Item Name. 

 

3. If known, type in the item’s Serial Number.  

 

4. Enter the item’s exact or estimated value in the Original Value field. 
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5. Identify the general classification of the item by making selections from the Item Category and Item 

Type lookup lists. These fields are hierarchical. 

 

6. Specify the Item Make and Item Model. These fields are hierarchical. 

 

7. If the item’s owner is known, check the Owner Identified box.  

 

8. Then, select the name of the organization or person that owns the item from either the Owner 

Name Organization or Owner Name Person pick lists. If an Organization or Person record does not 

already exist, use the Quick Add function to create one. 

 

9. Add comments about the item in the Notes field. 

 

10. To add an image of the item to the record, click the Add icon  in the image box.  

 

11. Locate the image file in the browser window and click Open.  

 

To import a record from the Gateway, consult the Import Record’s Settings From the Gateway section. 
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Import Record’s Settings from the Gateway 

The function to add a record by importing it from the Gateway is an additional method of creating a 

record that complements the standard method of the Add button . Both can be accessed from the 

Viewing pane toolbar. 

 

1. Open the appropriate data form. 

 

2. Click the small arrow to the right of the Add icon, and select From Source. The Import pop-up 

window will appear. 

 
 

3. Select the Gateway sub-tab, if it is not displayed by default. 

 

4. To display the top 1000 imported records that have been added to Perspective or are available to 

be added, click Search.  

 

Note: Only items with the Available status in Gateway will be searched and displayed. 

 

5. To search for a particular imported record, set specific search criteria: 

 

a. In the Field Name lookup list, select the field that you want to set as the main criterion for 

narrowing your results.  

 

b. Choose an Operator for the field (e.g., =, <>, Starts With, Ends With, Like). 

c. Enter the compared criterion Value. If the Selector button  is available, click it to display a 

tree of Value options in a separate window.  

 

Note: You may choose any node of the tree as the defining criterion, making your comparison 

value as narrow hierarchically as you want.  
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d. If you want to include a second field as an additional search criterion, select the And or Or radio 

buttons and complete the Field Name, Operator, and Value fields below. You may add as many 

search criteria as you want. To remove a field from your search criteria, click the Delete button 

. 

 

e. By default, your search will display the top 1000 imported records matching the criteria that 

you set. To display more or less than the top 1000 records, adjust the number in the Select Top 

field (from 1 to 2000). 

 

f. Click Search to generate a list of records matching your search criteria. A count of the number 

of records in the list, as well as the total number of imported records matching your search 

criteria, will be displayed at the bottom of the window. 

 

To make changes to the ongoing search, click Stop Search first, and then make the necessary 

changes to the search criteria. 

 

If you change your search criteria at some point, click Refresh  to update the record list 

according to the changes made. 

 

6. Choose the correct record from the list and click Import . The pop-up window will close and the 

form fields of the new record will automatically populate with the selected record’s information. To 

cancel the selection at any time, click Close . 
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View Record’s Incident Involvements 

1. Select the History tab. The Activity History sub-tab opens with a list of entities (i.e., Persons, 

Organizations, Vehicles, and Items) that have been involved in the record you are viewing.  

 

a. The Incident History sub-tab displays a list of any modifications that have been made to the 

record since its creation. 

 

2. To link all of an incident in the grid to a case, select any incident in the grid and click Add to Case. A 

pop-up window will open. 

 

3. Specify how the incidents are related to the case in the Link Type field (e.g., Similar M.O., Same 

Class, Location). 

 

4. Select the appropriate case from the Linked to Case pick list. 

 

5. Indicate the date that the incidents became associated with the case in the Link Effective Date 

field. 

 

6. Type any additional information about the link in the Notes field. 
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7. Click OK. 

 
 

8. Click Save.  

 

Note: These links will automatically be cross-referenced in the linked case’s record, as well as in 

each of the linked incidents’ records, under the Links tab. 

 

 

Attach a File to an Item Record 

Open the Attachments tab and complete the operation, as described in the Attach a File to a Record 

section in the Incidents chapter. 
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Control Record’s Processing Options 

Set the Security Controls and Status of the Record 

1. Select the Controls tab; the Details sub-tab will open by default.  

 

2. In the Controls section, fill out the Org Level fields to set the record visibility settings for the various 

hierarchically organized groups within your organization. Only users with organizational rollups 

corresponding to or higher than the organizational rollup you select for the record will have access 

to it. 

 

3. In the Access Level field, set the security level from 1 to 5. Each security level corresponds to a 

specific security description, such as Classified. Only users with the same security Access Level as 

the one you select (or higher) will be able to view the record. 

 

4. If you want to archive the record making it unavailable for users to access, check the Archive 

(Record is not visible) box. 

 
 

Define which workgroups can access the record 

1. In the Workgroup Visibilities section, give one workgroup the ability to read and modify the record 

by selecting them under Owner Workgroup (Full Rights). Initially, the field will contain the name of 

your default workgroup. Once you attempt to change it, the system will display a confirmation 

dialog asking you if the Full Access rights that belong to the original owner workgroup should be 

transferred to the workgroup you have chosen. Click OK if the change was intentional. 
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2. Determine the access right for All Other Workgroups, selecting from the Read, Update, or None 

access right options. 

 

3. To set customized access for a workgroup that does not conform to the other control settings 

specified, click Add Exception(s). A pop-up window will open. 

 

a. Select the workgroup and then select the workgroup’s visibility for this record (Read, Update, or 

None). Continue to customize workgroup visibility for as many workgroups as you like.  

 

Note: Workgroup visibility exceptions override the access settings assigned under All Other 

Workgroups. 

 
 

b. Click OK. The selected workgroups and their corresponding modified access settings will be 

transferred to the grid in the Viewing pane of the main window. 
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Track Changes Made to an Item Record 

Open the Audit History tab and complete the operation, as described in the Track Changes Made to a 

Record section in the Incidents chapter.  

Persons 

Create a New Person Record 

Note General Details of the Person 

Perspective provides three ways to create a new Person record: using the standard Add function, by 

importing a Person record through your Microsoft Active Directory®, or from the Gateway. 

To create a Person record using the standard Add function, follow the steps described below: 

 

1. Click the Add button      on the Viewing pane toolbar. 

 

2. Enter the person's Title (e.g., Mr. or Mrs.) and Designation (e.g., B.Sc. or Chartered Accountant). 

 

3. Type their First Name, Last Name, and middle Initial. 

 

4. Specify their Date of Birth, Gender, and Marital Status.  

 

5. Identify the person’s physical characteristics, including Eye Color, Hair Color, Height, and Weight. 
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6. Add any other relevant personal information or notes in the Additional Information box. 

 

7. To add a photo of the person to the record, click the Add icon  in the image box.  

 

8. Locate the image file in the browser window and click Open.  

 
 
To add a person imported through your Microsoft Active Directory:  

 

1. Click the down arrow to the right of the Add icon . 

 

2. Click From Source. 

 

 
 

3. In the pop-up window, select the Active Directory tab. 

 

4. Find and select the correct person from the source list. 

 

5. Click Import. The pop-up window will close and some of the Person form’s fields will automatically 

populate with the selected person’s information. 
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To import person’s settings from the Gateway, perform the steps described in the Import Record’s 

Settings From the Gateway section in the Items chapter.  

Identify the Person’s Unique Features 

1. In the Unique Features section, click Add New. A pop-up window will open.  

 

2. Select the appropriate descriptor of the person’s unique feature from the Feature Type lookup list 

(e.g., Distinguishing Marks, Ethnic/Racial, Scars/Disfigurements, Tattoos). 

 

3. Specify the Location of the unique feature on the person’s body, and provide its Description. 
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4. Click OK. 

 

Record the Person’s Pieces of ID 

1. In the Identifications section, click Add New. A pop-up window will open.  

 

2. Specify the Identification Type (e.g., Driver’s License or Birth Certificate) and the Identification 

Number. 

 

3. Identify the organization/governing body that issued the identification in the Issued By field. 

 

4. Add any other notes in the Comments text box. 
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5. Click OK. 

 

Document the Person’s Trespass Details 

1. In the Trespass Details section, click Add New     . A pop-up window will open. 

 

2. Specify the Site, Building, Location, and Section where the trespass occurred. 

 

3. If a trespassing notice was created, check the Notice Printed box.  

 

4. If there is an expiry date for the trespassing notice, or for the offence, enter this in the Expiry Date 

field. 

 

5. Include any additional information about the trespass under Comments. 
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6. Click OK. 

 

Flag the Person 

1. In the Flag Details section, select each flag’s Status (i.e., Yes, No, or Unknown), depending on 

whether or not the flag applies to the person. Also, select the Severity of the flag. Examples of flags 

include Violent, Trespasser, and Wanted. 

 

2. Type any other comments under Flag Notes.  
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Record Contact Information 

1. Select the Contact(s) tab. 

 

2. In the Address section, click Add New. A pop-up window will open. 

 

a. Specify the Address Type (e.g., Business, Head Office). 

 

b. Enter the person’s full address in the fields provided. 

 

c. If the address entered is the person’s main address, check the Primary Address box. 

 

d. Click OK. 
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3. In the Phone Numbers section, click Add New. A pop-up window will open. 

 

a. Select the Phone Type (e.g., Main, Work). 

 

b. Enter the person’s Phone Number. To avoid duplicate entries and to facilitate accurate 

searches, it is best to use a consistent format when entering phone numbers (e.g., hyphens in 

place of spaces, no parentheses). 

 

c. If the phone number entered is the person’s main number, check the Primary Phone box. 

 

d. Click OK. 

 
 

4. In the Email Address section, click Add New. A pop-up window will open. 

 

a. Specify the Email Type (e.g., Home, Work, etc.). 

 

b. Enter the person’s Email Address. 

 

c. If the email address is the person’s main email address, check the Primary Email box. 

 

d. Click OK. 
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5. Add as many contact entries as you want. 

 

Link a Record to a Person 

1. Select the Links tab. 

 

2. In the Person Links section, click Add New. A pop-up window will open. 

 

3. Indicate how the record is related to the person in the Link Type field (e.g., Partner, Employer, 

Driver). 

 

4. Select the person you want to link to the record from the (Linked To) Person pick list. If a Person 

record does not already exist for the individual, use the Quick Add function to create one. 

 

5. Enter the date that the person became associated with the record in the Link Effective From Date 

field. If this association no longer exists, indicate the date that it terminated in the Link Effective To 

Date field. 

 

6. Type any additional information about the link in the Notes text box. 

 

7. Click OK. 
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8. Once you click Save to save the changes made to the record, this link will automatically be cross-

referenced in both the current record and linked Person record under the Links tab. 

 

 

Link a Record to an Organization 

1. Select the Links tab. 

 

2. In the Organization Links section, click Add New. A pop-up window will open.  

 

3. Specify how the record and the organization are related in the Link Type field (e.g., Employer, 

Parent Company, Owns/Owned By).  

 

4. Select the organization you want to link to the record from the Organization pick list. If an 

Organization record does not already exist, use the Quick Add function to create one.  
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5. Enter the date that the record and the organization became associated with each other in the Link 

Effective From Date field. If this association no longer exists, indicate the date that it terminated in 

the Link Effective To Date field.  

 

6. Type any additional information about the link in the Notes text box.  

 

7. Click OK. 

 

 
 

8. Once you click Save to save the changes made to the record, this link will automatically be cross-

referenced in both the current record and the linked Organization record under the Links tab. 

 

Link a Record to a Vehicle 

1. Select the Links tab. 
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2. In the Vehicle Links section, click Add New. A pop-up window will open. 

 

3. Specify how the record and the vehicle are related in the Link Type field (e.g., Registered Owner, 

Owns/Owned By, Same Fleet).  

 

4. Select the vehicle you want to link to the record from the Vehicle pick list. If a Vehicle record does 

not already exist, use the Quick Add function to create one.  

 

5. Enter the date that the record and the vehicle became associated with each other in the Link 

Effective From Date field. If this association no longer exists, indicate the date that it terminated in 

the Link Effective To Date field.  

 

6. Type any additional information about the link in the Notes text box.  

 

7. Click OK. 

 

 

8. Once you click Save to save the changes made to the record, this link will automatically be cross-

referenced in both the current record and linked Vehicle record under the Links tab. 
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View Person’s Incident Involvements 

Access the History tab and complete the operation, as described in the Items section, the View Record’s 

Incident Involvements chapter. 

 

The Persons Data Form has an additional sub-tab; Detailed Person History. This sub-tab shows a 

detailed history view of every time the person in the record you are looking at was linked or referenced in 

Perspective. 

Attach a File to a Person Record 

Open the Attachments tab and complete the operation, as described in the Incidents section, the Attach 

a File to a Record chapter. 

Control a Person Record’s Processing Options 

Set the Security Controls and Status of the Person Record 

1. Select the Controls tab; the Details sub-tab will open by default.  

 

2. In the Controls section, fill out the Org Level fields to set the record visibility settings for the various 

hierarchically organized groups within your organization. Only users with organizational rollups 

corresponding to or higher than the organizational rollup you select for the record will have access 

to it. 
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3. In the Access Level field, set the security level from 1 to 5. Each security level corresponds to a 

specific security description, such as Classified. Only users with the same security Access Level as 

the one you select (or higher) will be able to view the record. 

 

4. If you want to archive the record making it unavailable for users to access, check the Archive 

(Record is not visible) box. 

 

5. Check the Employee box, if the person is employed by your organization, and then enter the 

person’s Employee Number. 

 

 

Define Which Workgroups Can Access the Person Record 

In the Workgroup Visibilities section, define access options for the record, as described in the Incidents 

section, the Define which workgroups can access the record chapter. 

Track Changes Made to a Person Record 

Open the Audit History tab and complete the operation, as described in the Incidents section, the Track 

changes made to a record chapter. 

Organizations 
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Create a New Organization Record 

Perspective provides two ways to create a new Organization record: with the help of the standard Add 

function, and by importing an Organization record from the Gateway.  

 

To create an Organization record using the standard Add function: 

 

1. Click the Add button  on the Viewing pane toolbar. 

 

2. Enter the Organization Name.  

 

3. If known, input the organization’s file, ID, or other tracking number in the Organization Number 

field. 

 

4. Choose the appropriate description from the Organization Type lookup list. 

 

5. If the organization has a Web site, specify the Web address under Organization Webpage URL. 

Clicking the adjacent Microsoft Internet Explorer® icon  will open the Web page in a separate 

browser window. 

 

6. Enter any additional information about the organization in the Notes box.  

 

7. To add an image to the Organization record, click the Add icon  in the image box. Locate the 

image file in the browser window and click Open. 
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To import organization’s settings from the Gateway, perform the steps described in the Items section, the 

Import Record’s Settings from the Gateway chapter. 

Record an Organization's Contact Information 

Open the Contact(s) tab and complete the operation, as described in the Persons section, the Record 

Contact Information chapter. 

Link an Organization to a Person 

Select the Link tab and complete the operation, as described in the Persons section, the Link a Record to 

a Person chapter. 

Link an Organization to Another Organization 

Select the Link tab and complete the operation, as described in the Persons section, the Link a Record to 

an Organization chapter. 
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Link an Organization to a Vehicle 

Select the Link tab and complete the operation, as described in the Persons section, the Link a record to 

a vehicle chapter. 

View Organization’s Incident Involvements 

Access the History tab and complete the operation, as described in the Items section, the View Record’s 

Incident Involvements chapter. 

Attach a File to an Organization Record 

Open the Attachments tab and complete the operation, as described in the Incidents section, the Attach 

a File to a Record chapter. 

Control an Organization Record’s Processing Options 

For control options available for Organization records, refer to the Items section, the Control Record’s 

Processing Options chapter. 

Track Changes Made to an Organization Record 

Open the Audit History tab and complete the operation, as described in the Incidents section, the Track 

Changes Made to a Record chapter. 

Vehicles 

Create a New Vehicle Record 

Perspective provides two ways to create a new Vehicle record: with the help of the standard Add 

function, and by importing a Vehicle record from the Gateway. 

 

To create a Vehicle record using the standard Add function, do the following steps: 
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1. Click the Add button  on the Viewing pane toolbar. 

 

2. Enter the License Plate number. To avoid duplicate entries and to facilitate accurate searches, it is 

best to use a consistent format for entering license plate numbers (e.g., no spaces or special 

characters). 

 

3. If known, indicate where the vehicle’s license plate was registered in the Country and 

State/Province fields. 

 

4. If known, enter the vehicle’s VIN, Vehicle Value, and Year.  

 

5. Specify the vehicle’s Make, Model, Style, and Color. 

 

6. If the vehicle is a company vehicle, specify the Division and Branch it belongs to.  

 

7. Add any additional information in the Comments text box. 

 

8. To add a photo of the vehicle to the record, click the Add icon  in the image box. Locate the 

image file in the browser window and click Open. 
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To add a vehicle imported through the Gateway, perform the steps described in the Items section, the 

Import Record’s Settings From the Gateway chapter. 

Link a Vehicle to a Person 

Select the Link tab and complete the operation, as described in the Persons section, the Link a Record to 

a Person chapter. 

Link a Vehicle to an Organization 

Select the Link tab and complete the operation, as described in the Persons section, the Link a Record to 

an Organization chapter. 

Link a Vehicle to Another Vehicle 

Select the Link tab and complete the operation, as described in the Persons section, the Link a Record to 

a Vehicle chapter. 
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View Vehicle’s Incident Involvements 

Access the History tab and complete the operation, as described in the Items section, the View Record’s 

Incident Involvements chapter. 

Attach a File to a Vehicle Record 

Open the Attachments tab and complete the operation, as described in the Incidents section, the Attach 

a File to a Record chapter. 

Control a Vehicle Record’s Processing Options 

Set the Security Controls and Status of the Vehicle Record 

1. Select the Controls tab; the Details sub-tab will open by default.  

 

2. In the Controls section, fill out the Org Level fields to set the record visibility settings for the various 

hierarchically organized groups within your organization. Only users with organizational rollups 

corresponding to or higher than the organizational rollup you select for the record will have access 

to it.  

 

3. In the Access Level field, set the security level from 1 to 5. Each security level corresponds to a 

specific security description, such as Classified. Only users with the same security Access Level as 

the one you select (or higher) will be able to view the record. 

 

4. If you want to archive the record making it unavailable for users to access, check the Archive 

(Record is not visible) box. 

 

5. Check the Company Vehicle box if the vehicle belongs to your organization. 
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Define Which Workgroups Can Access the Vehicle Record 

In the Workgroup Visibilities section, define access options for the record, as described in the Incidents 

section, the Define Which Workgroups Can Access the Record chapter. 

Track Changes Made to a Vehicle Record 

Open the Audit History tab and complete the operation, as described in the Incidents section, the Track 

Changes Made to a Record chapter. 

Merge Records 

The Merge function is only available on four Perspective’s data forms, i.e., Items, Persons, Organizations, 

and Vehicles. It is a method of merging partially duplicate records that correspond to a single physical 

referent (e.g., an item, a person, an organization, or a vehicle). The function is represented by the Merge 

button on the Viewing pane toolbar. 

 

Note: The Merge function is irreversible and cannot be undone. Be absolutely certain you want to merge 

records before proceeding! 

 

1. Open a record that will function as the primary record of your merging process, typically, the one 

with the most accurate information and the most details. 
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2. Click the Merge button on the Viewing pane. A Quick Merge form will open with the general details 

of the selected record on the left, and an equivalent blank record form on the right.  

 

3. Select the appropriate Secondary Record with which you would like to merge the primary record 

from the pick list at the top of the blank form.  

 

The blank form will populate with the data contained in the General tab of the selected record. The 

checkmarks will mark the pieces of information that can be merged between the records. For the 

fields, where the secondary record contains no information, the checkmarks will be inactive. This 

means that the corresponding values in the primary record will remain unchanged. 

 

4. Select (or deselect) the fields in the second form you want to save (or leave out) using the 

appropriate checkmarks.  

 

Click Select/Deselect All to toggle the selection of all the available data fields for merging. 

 

Note: Deselecting all fields in the secondary record form does not mean that the merging of the 

records will not occur. The Merge function performs both merging of the general data that is 

displayed in the Quick Merge form, as well as the rest of the data that is contained in the merging 

records and hidden from the Quick Merge forms (e.g., contacts, attachments, links, history). 

 

5. Click Merge. 
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6. Once the merging of the selected records is complete, a confirmation dialog will be displayed. Click 

OK. The secondary record will disappear from the Listing pane, while the resulting merged record 

will display in the Viewing pane in editing mode.  

 

 
 

The result of the merge will be a single record that contains the following components: 

 

a. The values from the primary record data (including the image of the record’s reference item, 

person, organization, or vehicle, and the user defined fields) that were not selected for merging 

on the secondary record form; 

 

b. The values of the secondary record data (including the image of the record’s reference item, 

person, organization, or vehicle, and the user defined fields) that were selected for merging on 

the secondary record form; 
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c. The hidden data entries pulled from both the primary and the secondary record that correspond 

to all or some of the following data types: 

 

The records’ Contacts: Addresses, Phone Numbers, Email Addresses; 

The records’ Links: Person, Organization, and Vehicle Links; 

The records’ Histories of all incident involvements; 

The records’ Attachments; 

If you were merging two Person records, the data will also be pulled from the Unique Features, 

Identifications, and Trespass Details sections from both records. 

 

 The data that never gets merged (i.e., that is left unchanged, with the primary record’s values) 

includes the settings of the Controls tab. If you were merging two Person records, the Flags 

Details contained in the primary record will be saved as the default settings for the resulting 

merged record too. 

 

 Under the Audit History tab, the occurred merge is documented with the help of two Record 

Action entries: the Merge entry stands for the occurred merging of the records’ general and 

hidden data, whereas the Update entry documents the merging of the specific fields in the 

primary and the secondary record forms. 
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7. Scan the final record for possible repetitions of data that were merged and resulted in unintentional 

duplication of the same information. 

 

8. Click Save to save the changes made. 

Construct a Visual Link Chart for a Record 

Visual Analysis allows you to create a visual link chart representing the data relationships between the 

selected types of records.  

 

To activate this function, select the main record of focus (e.g., a Person record) in the Viewing pane and 

click the Visual Analysis icon  on the Ribbon. A separate Perspective Visual Analysis window will 

open with the selected record displayed as an icon in the centre. 

 

See the Perspective Visual Analysis section for further information on building a link chart. 
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Analyze and Report 

The Analyze and Report module includes three components: Analysis Expert, Reports, and Custom 

Reports.  

 

Analysis Expert: Analysis Expert is an internal search engine that scans the data in all Activity, Incident, 

Case, Item, Person, Organization, and Vehicle records, and returns results that meet the defined search 

requirements. 

 

Reports: Perspective contains a number of preset reports that you may use to generate statistics and 

analyze trends in your data.  

 

Custom Reports: You have the ability to take queries that you’ve built in Analysis Expert and customize 

them into custom reports. 
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Analysis Expert 

Analysis Expert is an internal search engine that scans the data in all Activity, Incident, Case, Item, 

Person, Organization, and Vehicle records, and returns results that meet the defined search 

requirements. Search results reflect assigned user access rights and privileges. Use Analysis Expert to 

create a query, and then turn your query’s results into a spreadsheet, a chart, a printed grid, or a report. 

User Interface 

The interface of the Analysis Expert component transforms according to the stages of query building, by 

which it evolves into two separate screens – the initial query designer window and the subsequent 

query results window.  

 

The query designer window of Analysis Expert enables you to set specific query criteria, grouping and 

search options, and is aimed at producing optimal query results. It is divided into the following six 

sections: 

 

1. Ribbon: Contains an additional set of buttons that perform saving, adding, cloning, deletion, 

sharing, and execution of queries.  

 

Note: Some functions of the Ribbon buttons are accessible directly from the right-click menu of a 

record entry or a query. Specifically, you may add, clone, share, remove, rename, execute it, and edit 

a query by right-clicking the corresponding query entry and selecting the relevant option in the 

menu. 

 

2. Listing pane: Arranges queries that you create according to their access options (i.e., Shared 

Queries or Private Queries) and query category. By default, all new queries are Private Queries 

available only to the user who created them. In order to make a saved query available to users 

across your organization, you must share it. Refer to the Share a Query chapter for more 

information on how to do this. 

 

file://///ppm2000.com/Corp/Departments/Product%20Management/Private/beth.blackstock/My%20Documents/Beth/NEW%20Reports.docx%23shareaq
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3. Form(s) pane: Depending on the query selected in the Viewing pane, displays a list of forms 

available for querying. Once you select a form in the Form(s) pane, the corresponding fields will be 

checked in the Field(s) pane and recorded in the Selection(s) pane. 

 

4. Field(s) pane: Depending on the form selected in the Form(s) pane, displays specific fields that can 

be selected for display in the query results. The selected fields will automatically populate the 

Selection(s) pane under Display. The Field(s) pane also enables sorting and grouping of the query 

results by specific fields that are imported as query criteria into the Selection(s) pane and Criteria 

Designer. 

 

5. Selection(s) pane: Displays the selected query criteria, as well as grouping and display options for 

the query results. 

 

6. Criteria Designer: Contains three tabs (Criteria, Properties, and Audit) that control the process of 

query building.  

 

• The Criteria tab displays the fields that were selected as search criteria from the Field(s) pane 

and enables settings of their search values.  

 

• The Properties tab displays the text expression of the criteria selected under the Criteria tab. 

 

• The Audit tab tracks the history of the runs of the query. 
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Navigating Data Forms Overview 

To complete a full cycle of creating a query in Analysis Expert and then using the resulting data for 

further analysis, follow the general navigation principles described below: 

 

1. In the initial query designer window, create a customized query that exactly corresponds to your 

specific criteria. From this window, you may also edit, clone, share, delete, save, and/or execute your 

query. 

 

2. Once the query is executed, a new window will pop up with the results of the query displayed in the 

form of a grid. At this point, you may start working with your query results, which includes 

searching, grouping, exporting, charting, and printing them, as well as performing an internal 

analysis (i.e., building a visual link chart or performing calculations) of the individual records that 

compose the query results. 
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3. If you chose to chart your results, a new charting window will appear with a set of standard 

charting tools and an option to elaborate the design of the chart even further with the Chart Wizard 

tool. When your chart is complete, you may choose to print it or copy it to clipboard. 

 

The following chapters will address the options available for each of these steps in greater detail. 

About Operators 

Analysis Expert uses operators to determine what data to display. The following table explains what 

each operator means. 

 

Symbol Read as Explanation of Result 

= equals 

Will display records where the field’s value is 

equal to the value specified. Note that only 

exact matches will be displayed. 

>= 

is greater 

than or equal 

to 

Will display records where the field’s value is 

greater than or equal to the value specified. This 

operator is only available for criteria with 

numerical values, such as dates, quantities, 

amounts of money, etc. 

<= 
is less than or 

equal to 

Will display records where the field’s value is 

less than or equal to the value specified. This 

operator is only available for criteria with 

numerical values. 

> 
is greater 

than 

Will display records where the field’s value is 

greater than the value specified. This operator is 

only available for criteria with numerical values. 
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< is less than 

Will display records where the field’s value is 

less than the value specified. This operator is 

only available for criteria with numerical values. 

<> is not equal to 
Will display records where the field’s value is 

not equal to the value specified. 

Like like 
Will display records where the value specified is 

contained somewhere in the selected field.  

Starts with starts with 
Will display records where the field’s value 

starts with the value specified.  

Ends with ends with 
Will display records where the field’s value ends 

with the value specified.  

Between between 
Will display records where the field’s value is 

between the dates specified. 

Not Between not between 
Will display records where the field’s value is 

not between the dates specified. 

Today today 
Will display records where the field’s value is 

today’s date. 

Yesterday yesterday 
Will display records where the field’s value is 

yesterday’s date. 

This Week this week 
Will display records where the field’s value 

contains records from this week. 

This Month this month 
Will display records where the field’s value 

contains records from this month. 

This Year this year 
Will display records where the field’s value 

contains records from this year. 
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Last # Days last # days 

Will display records where the field’s value 

contains records from the last specified number 

of days. Will not display the day you are 

currently in. 

Last # Weeks last # weeks 

Will display records where the field’s value 

contains records from the last specified number 

of weeks. Will not display the week you are 

currently in (reads as Sunday-Saturday). 

Last # Months last # months 

Will display records where the field’s value 

contains records from the last specified number 

of months. Will not display the month you are 

currently in. 

Last # Years last # years 

Will display records where the field’s value 

contains records from the last specified number 

of years. Will not display the year you are 

currently in. 

Is Empty is empty 

Will display records where the field’s value is 

N/A. Using the operator is empty will lock (make 

uneditable) the Value field. 

 

Create a Query Category 

You can create query categories so that similar queries appear in a table together. For example, you may 

have a Quarterly category for all queries you run every quarter, or a Thefts category for any Activity, 

Incident, or Case query pertaining to thefts. Any queries that you do not put into a category will 

automatically be placed under the Miscellaneous Queries category. You can create query categories 

when you create or edit a query. 
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Query Design Process 

Create a Query 

1. Make sure the query category you want your created query to appear under is highlighted (i.e., 

Private Queries, Shared Queries). 

 

 
 

2. To start a new query, choose one of the following options: 

 

• Click Add  on the Ribbon.  

 

• Right-click in the listing pane, and select Add from the drop-down menu that appears.  
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3. A Create New Query dialog box will open.  

 

4. Enter a title for the query in the Name field.  

 

• By default, the system will name the new query, according to the template <New Query>. 

 

5. Make sure the Query Category is correct. If you want to create a new Category, type it in this field. 

 

6. From the Type lookup list, choose the record entity you would like Analysis Expert to search (e.g., 

Incident, Person, Case). 

 

7. In the Description text box, identify the type of query and/or its purpose. 

 

Note: The Description field can be left blank. The Name and Query Category fields must be filled in. 

 
 

8. Click Add.  

 

9. The new query entry will be added to the relevant record entry node. The Form(s) pane will 

automatically populate with the names of the selected record entity’s respective forms (e.g., 

Incident Details, Incident Flags, Incident Losses). 
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Specify Query Criteria 

Before specifying criteria for your query, take some time to think about the design of your query by 

considering the following questions: 

 

• Do you want to search the whole database or just a portion of data (e.g., incident data recorded 

within a particular time period, person data for employees only)? 

 

• If you want to search a portion of data, what parameters do you want in your search? 

 

• What type of data do you want to see in your query results (e.g., incident time, place, losses)? 

 

• How do you want to present your data? Do you want to summarize your results or see lists of 

actual data values? 

 

In the example below, we will be looking at a query design with the following specifications: 

 

• Type of query: Incident query. 

 

• Scope of data: Incidents that happened since 2007 and involved net losses (e.g., Net Loss of each 

incident is above 0.50 cents). 

 

• Data of interest: Number of incidents, Year, Category, Site, Total Loss, and Net Loss. 

 

• Data grouped by: Year, Category, and Site. 

 

OPTION 1a: If you want to search the whole database, proceed to select the specific types of data 

that you want to see in your query results. 

 

1. Expand the relevant form nodes in the Form(s) pane to see all constituent subforms. 

 

2. To view fields available in a form in the Field(s) pane, click once on the name of the relevant form. 

To select all the fields in a particular form, check the form box. 
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3. In the Field(s) pane, check the boxes of the fields you want to see as headers in your query results 

and reports. The field names will automatically populate the Selection(s) pane under Display in the 

order they were selected. 

 

• To reorder the fields appearing in your query results, select the field in the Selection(s) pane and 

then use the up and down arrows in the top right corner of the pane to rearrange the field’s 

position in the Display list. 

 

• To delete a field from display in your query results, select the field name in the Selection(s) pane 

and click the Remove icon  in the top right corner of the pane, or uncheck the field’s checkbox 

in the Field(s) pane. 

 

 
 

OPTION 1b: If you want to search a portion of data, set the parameters of your data sample. 

 

1. In the Field(s) pane, right-click a field that corresponds to the parameter of interest, and select the 

Search By option from the menu. If you do not want a parameter field to be displayed in the query 

results, unselect the checkbox beside the field’s name in the Field(s) pane. 
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The selected field will now appear in the Criteria Designer pane below. 

 

 
 

2. To specify a comparison value for the selected parameter, select the relevant Operator from the 

lookup list (e.g., =, <>, >, Like, Starts With, Ends With). Depending on the type of parameter, you 

will have an option of either entering the comparison value in the Value field, or selecting it from the 

lookup list.  

 

3. Add as many parameters for your data sample as needed. 

 

 
 

4. As you continue to specify the parameters, the system will edit the corresponding Boolean logic 

statement at the bottom of the Criteria Designer pane. By default, Perspective searches for data 

that meets both criterion A AND criterion B, and so on. If you want to only generate results that 
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meet either criterion A OR criterion B, or some variation thereof, you must modify the statement to 

reflect this. It is best to modify the statement after you have entered all your data parameters first.  

 

Note: Deleting a parameter symbol (e.g., A, B, C) from the statement will not remove the 

corresponding parameter from the list. However, if a parameter is deleted from the statement, it will 

not appear in the executed query results. Ultimately, the Boolean logic statement contains the 

defining formula for your data sample, while the list of parameters provides the parameters you 

may search by, and serves as a reference point for the statement. 

 

 
 

• To reorder the parameters in the Criteria Designer list, select the corresponding row and use the up 

and down arrows in the top right corner of the pane to rearrange the parameter’s position in the list. 

 

• To delete a parameter from the list, select the corresponding row and click the Remove icon  in 

the top right corner of the pane, or uncheck the field’s checkbox in the Field(s) pane. 

 

• To view the text expression of the Boolean logic statement for your data, select the Properties tab 

of the Criteria Designer pane.  
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OPTION 2a: If you want to see lists of raw data values in your query results, proceed to execute your 

query. 

 

OPTION 2b: If you want to see your query results summarized, select the fields by which you would 

like to group your results. 

 

1. To group your query results by a particular field, ensure the field’s box in the Field(s) pane is 

checked. Then, right-click the field and select Group By from the menu.  

 

Note: Not all fields are available for group by. In order to group by a particular field, it must have 

only one reference value, i.e., its value cannot be cumulatively derived from several fields. For 

example, an incident’s Total Loss field cannot be grouped by, since it potentially draws data from 

multiple involved items and vehicles with recorded losses. In contrast, the Site field in an Incident 

record can refer to only one site value, which makes it a legitimate candidate for a Group By 

criterion. Moreover, it is not possible to group by a child data field (e.g., Assigned Date of Incident 

Investigators). 

 

 
 

The Summary function is activated when at least one Group By field is selected. This will reflect in 

the view of the Selection(s) pane: the selected field name will automatically populate the pane 

under both Group By and Summary, while the field names that were listed under Display, will all be 

transferred to the Summary list. 

 

If you delete a field name from the Group By list, all the fields contained under Summary will be 

transferred back to Display. 
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Note: If your Display list contains fields from child data (e.g., Incident Investigators’ Assigned Date, 

Completed Date, or Last Name), selecting a Group By field (e.g., Year) will transfer all the parent 

data fields to the Summary list and delete all the child data fields. 

 

2. In the query results, the system will perform data calculations on all the fields that appear under 

Summary. The fields’ actual data values will not appear in the query results (unlike when they were 

selected for Display); only the products of the specified data calculation for the fields will appear. In 

order to see the actual data values together with the calculations, you will need to duplicate all the 

relevant field names under Group By using the Field(s) pane, as described above.  

 

To quickly locate the field names in the Field(s) pane, one by one click on the field names in the 

Section(s) pane. The system will automatically display the relevant field list in the Field(s) pane. 

Right-click the field you want to import to the Group By list of the Selection(s) pane and select 

Group By from the menu. 

 

 
 

Some of these calculations are meaningful; for instance, the COUNT for Incident Number will 

produce counts of Incident records for specific categories by which you chose to group your query 

results (e.g., Category, Site). Others may refer to unique categorical entries (e.g., DISTINCT COUNT 

for Site or Year), and will not produce meaningful results, unless you choose to display the actual 

values of the field (i.e., transfer the field to the Group By list). Therefore, you will need to think very 

carefully about selecting the right fields for summaries (e.g., sums and averages for losses, counts 

for items), and leaving the rest as actual values (e.g., names of categories, sites, years). 
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Note: Once a field appears in both Summary and Group By lists, its calculation node disappears, 

which means that the system will display the actual value of the field (not a calculation) in the query 

results.  

 

3. Proceed to save or execute the query. 

Save a Query 

1. Complete the design of your query. 

 

2. Store the query for access at a later date by clicking Save  on the Ribbon. 

Edit a Query 

1. Make sure the query you want to edit is highlighted. 

 

 
 

2. To open and begin editing the query, choose one of the following options: 

 

• Click Edit  on the Ribbon.  

 

• Right-click in the listing pane, and select Edit from the drop-down menu that appears.  

 

3. The Query dialog box will open.  
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• You can change the query Name, Category, and/or Description. 

 

4. Click the Edit button to open the query or the Cancel button if you have selected the wrong query. 

 

5. To view a query’s specifications, select the query from the tree on the Navigation pane. Review the 

Form(s), Field(s), Selection(s), and Criteria information and make changes to the selected 

checkboxes, if necessary. 

 

6. Store the query for access at a later date by clicking  Save on the Ribbon. 

Clone a Query 

1. Make sure the query you want to clone is highlighted. 

 
 

2. To clone the query, choose one of the following options: 

 

• Click Clone  on the Ribbon.  

 

• Right-click in the listing pane, and select Clone from the drop-down menu that appears.  
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3. A prompt will appear, asking if you are sure you want to clone the query. Click the Yes button to 

clone the query, or No to cancel the cloning process.  

 

 
 

Note: If you do not have Manage rights, you will be unable to clone a query. Additionally, you are only 

able to clone a query that has already been shared to you. 

Share a Query 

1. Make sure the query you want to share is highlighted. 

 

 
 

2. To share the query, choose one of the following options: 

 

• Click Share  on the Ribbon.  

 

• Right-click in the listing pane, and select Share from the drop-down menu that appears.  

 

3. The Share Query dialog box will open.  

 

4. Click the Add User button and/or Add Role button.  
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5. Select the user(s) and/or role(s) you want to share the query to by typing his/her name and/or role in 

the text field, or scrolling through all users and/or roles.  

 

6. Double-click the user’s name and/or role to confirm your selection. 

 

• Click the Allow Manage checkbox if you want the user or users in a particular role to have the 

ability to edit, share, delete, or clone the shared query. 

 

• If you share to a user and a role, and that user is in the role as well, the query will be shared to 

him/her twice. 

 

Note: If you give a user Manage rights when sharing a query, the user is able to modify the 

original query. To keep a copy of the original query that cannot be edited, clone it for yourself. 

 

 
 

7. Click the Add Roles button.  

 

8. Select the role you want to share the query with by typing its name in the text field, or scrolling 

through all roles.  

 

9. Double-click the role’s name to confirm your selection. 

 

• Click the Allow Manage checkbox if you want those with that role to have the ability to edit, 

share, delete, or clone the shared query. 
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10. Click Save. 

 

• Shared queries will have the  Share icon displayed beside the title. 

 

 

Delete a Query 

1. Make sure the query you want to delete is highlighted. 

 

 
 

2. To delete the query, choose one of the following options: 

 

• Click Delete  on the Ribbon.  

 

• Right-click in the listing pane, and select Delete from the drop-down menu that appears.  

 

3. A prompt will appear, asking if you are sure you want to delete the query. Click the Yes button to 

delete the query, or No to cancel the deletion process.  

Execute a Query 

1. Once your query is created, you may either run it immediately, or save it for further use, and then 

run it. To run a saved query, select the name of the query you want to run from the query list in the 

listing pane.  
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2. To execute the query, choose one of the following options: 

• Click Execute  on the Ribbon.  

 

• Right-click in the listing pane, and select Execute from the drop-down menu that appears.  

 

3. A new window will open displaying the Criteria for the query. You do have the ability to modify the 

Criteria values if needed. Click the Execute button inside this window. 

 

Note: Queries can be run in the background. As a result, you can set up the next query, design a 

report, or review a record while waiting for the results notification to appear. 

 

  

Track Query Runs 

To track the history of query runs, open the Audit tab of the Criteria Designer pane. The tab will display 

the following information: 

 

• Last Run By User: The user who last ran the query. 

 

• Last Run Time: The time when the query was last run. 

 



Perspective User’s Guide  Analysis Expert 

 © Resolver Inc.   Page 207 of 399 

• Last Run Returned Rows: The number of data entries in the query results. 

 

• Last Run Duration (second): The time Analysis Expert needed to generate the query.  

 

• Where Clause and SQL Statement: Technical data on the query data, criteria, and location.  

 

 

 

Working with Query Results 
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View Query Results 

Once the query is executed, a new window will open with the results of the query displayed in the form 

of a grid. The number of returned records will be displayed at the bottom of the screen.  

 

 

Search for Specific Data in Query Results 

To search for specific data in your query results, use the Text Search function. Type a keyword in the 

Text Search field, and click Search Grid.  

 

• The color of the highlighted search text can be modified using the Backcolor of Search Results 

lookup list. 

 

• Check Include Child Record to search all records in the query results.  
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• Check Exact Match of Text to search only for text that corresponds exactly to the text entered in 

the Text Search field.  

 

• Check Case Sensitive to only search for text containing the correct uppercase or lowercase 

characters specified in the search text. 

 

 

Group Query Results by a Field 

• To group the results by a field, drag the column heading to the gray box above the grid and drop it. 

All query results will automatically collapse, grouped by the column heading you just selected. 

Grouped By query results may contain child records. To view child records, click Expand All to view 

all records contained under nodes. Once clicked, the name of this button will change to Collapse All. 

Click this to hide all child records again. 

 
 



Perspective User’s Guide  Analysis Expert 

 © Resolver Inc.   Page 210 of 399 

• To add another tier to the grouping, first expand one of the nodes to view its data in grid format. 

Then, click and drag a different column heading to the gray box. The query results will once again 

collapse, grouped first by your initial selection, and then by your second selection. You may continue 

to add tiers to your grouping using the same method. 

 

• To reorder the tiers in your grouping, click and drag the column headings in the gray bar.  

 

 
 

• To remove a field from your grouping, drag the column heading in the top gray bar and place it 

anywhere in the query results screen. 

Perform Calculations on Query Results 

1. To perform calculations on data in query results that were created using the Group By option, select 

the Outlook Group By radio box in the View Style section. The Sigma (Ʃ) symbol will appear on all 

column headings. (If the Group By function was used to build the query, Sigma will automatically 

appear on column headings.) 

 

2. To perform data calculation on a column of data, click the Ʃ button at the top of the respective 

column. The Select Summaries dialog box will open.  

3. Select the type of calculation that is required for the column (Average, Count, Maximum, Minimum, 

and/or Sum). You can select more than one calculation option.  
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4. Click OK.  

 

 
 

The calculation results will be displayed below the appropriate columns at the bottom of the query 

results. If your results were grouped by a field within the query results window, then the calculations will 

apply and be displayed for each group. 
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Export Query Results 

1. To export query results, click  Export on the top toolbar. A Windows Explorer window will open. 

 

2. Choose the location for the new file and name the file and indicate the file type (e.g., Excel-Data 

(*.xls). Click Save. 

 

3. You will receive a confirmation message stating the export was successful. Click OK. 

Print Query Results 

1. To print the query results, first estimate the layout of your grid in relation to the portrait layout. If 

deemed necessary, scale the query results window to fit one portrait page. 

 

2. Click  Print Grid on the top toolbar. A Print Preview window will open. 

 

3. Review the layout of the grid using the toolbar at the top of the screen.  

 

4. Click the Print icon  to print the grid. 
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Access Records in Query Results and Print Reports 

Note: These functions are not available if the Group By function was used to build the query. 

To view a record from the list of records contained in your query results, select the record and click  

View Detail. The record will open in a separate window in the read-only mode. 

 

To print, email, or save one of the records listed in the query results, follow the steps below: 

 

1. Select the record and click  Print Detail Report.  

 

2. A Report Visibility window will appear. This window contains checkboxes for all report sections 

containing data. By default, all boxes will be checked. Uncheck the boxes for any sections you do 

not want to appear in your report. Check the Download All Attachments? box if you want to 

download the attachments included in the record for printing. Then, click OK. 

 

 
 

a. The Report Options window will open.  

 

b. Click the Open icon to instantly view a printable PDF copy of the report.  

 

c. Click the Send icon to send an email message with a PDF copy of the report attached. 

 

d. Click the Save icon to save a PDF copy of the report to the location of your choice.  
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e. Click the Close icon to cancel the report. 

 

 

Construct a Visual Link Chart From Query Results 

With Perspective Visual Analysis, you can create a visual link chart representing the data relationships 

between records listed in the query results.  

 

Note: If the Group By function was used to build the query, this feature will be disabled. 

 

Click anywhere in the query results and then select  View in Visual Analysis. A separate Perspective 

Visual Analysis window will open with all the records listed in the query results contained within.  

 

See the Perspective Visual Analysis section for further information on building a link chart, or click the 

Help icon in the Visual Analysis window. 

file://///ppm2000.com/Corp/Departments/Product%20Management/Private/beth.blackstock/My%20Documents/Beth/NEW%20Reports.docx%23_Perspective_Visual_Analysis
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Chart Query Results 

1. To begin charting your query results, click  Chart. If your query results contain child data, you 

may choose to chart either parent records (e.g., Person Detail) or child records (e.g., Person 

Incidents Involvement) by selecting the appropriate data label under the attached lookup.  

 

2. A charting window will open with a blank Viewing pane, a list of variables available for charting 

listed in the Data pane on the left, and a grid with raw chart data listed at the bottom Data tab. (In 

this section, we will be looking at the case of an organization that wants to know the proportions of 

marital statuses of their employees by gender.) 

 

3. In the Data pane, select an X-Field (e.g., Gender) and a Y-Field or multiple Y-Fields (e.g., Last 

Name) for your chart from the available options. The X-Field data will appear on the horizontal x-

axis of your chart. The Y-Field data will appear on the vertical y-axis of your chart. If you select more 

than one Y-Field, ensure that they have the same unit of value (e.g., dollars, items). Note that Y-

Fields are always charted as numerical values. Generally, text fields are counted (e.g., quantity of 

Incident Numbers or Last Names), while numerical fields are summed (e.g., amounts of Incident 

Losses). 
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4. Your chart will appear in the Viewing pane. By default, your initial chart will be formatted as a 

column chart. The bottom pane will display your selected Chart Data. 

 

5. You may copy and paste data from the Data or Chart Data tabs into Excel by highlighting the data 

and then using the Ctrl+C and Ctrl+V keyboard commands.  

 

 
 

6. If you want to select an additional variable for your chart (e.g., Marital Status) to see the distribution 

of one of your variables by another (e.g., Marital Status by Gender), right-click the variable under X-

Fields, and select Add Series. The chart type will switch to a pivot chart. The new variable will be 

added to the x-axis and will be explained in the chart’s legend. 

 

Note: Once a Series variable is incorporated into your chart, only one Y-Field will be charted. 

Additional Y-Fields will automatically be dropped from your chart.  
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7. If the chart does not have a series field, you may use the available toolbar options to adjust its 

appearance. These options are also available with a greater range of functionality in the Chart 

Wizard. For description of the various chart customization options in Chart Wizard, see Appendix 

D: Chart Wizard. 

 

a. To change the default column chart to a different chart type, choose an option from the  

Chart Types lookup list (e.g., pie, bar, area). The Charts pane will automatically populate with 

the name of the selected chart.  

 

b. To change the default 2D (two-dimensional) chart to a 3D (three-dimensional) chart, choose 3D 

in the drop-down menu on the toolbar. Click and drag the chart to rotate it and adjust its 

perspective. 

 

c. Enter a name for the chart in the Title text box. 

 

d. From the Border lookup list, select a border or frame style for the chart. 

 

e. In the  Themes lookup list, select a color theme for your chart. 

file://///ppm2000.com/Corp/Departments/Product%20Management/Private/beth.blackstock/My%20Documents/Beth/NEW%20Reports.docx%23_Appendix_D:_Chart
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If the chart does include a series field, any customizing of the chart, including changing the chart 

type, must be done in the Chart Wizard.  

 

8. To copy your chart to clipboard  or print it , click the appropriate icon on the toolbar. 

 

9. If you want to erase this chart and construct a new chart of the query results, click  Clear on the 

toolbar, or right-click in the chart area and select Clear. 

Analyze Results 

Analyze Results allows you to choose how you view your query results. You can filter by variables and 

continually modify the results displayed. You can change the appearance of your results, as well as 

narrow or expand your results by hierarchy levels, building locations, criminal activity type, etc. The Pivot 

Grid in the Analyze Results module allows you to determine the data you want displayed, while the Data 

Chart section and Pie Chart section gives you the ability to dig deeper into your results and display them 

in a visually appealing way.  
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Table 

The table section of Analyze Results is where you decide what to analyze and how you want it to be 

displayed. 

 

1. In the Navigation pane, open the Analyze and Report module. 

 

2. From Analysis Expert, choose the query record that you want to view. To execute the query, do one 

of the following: 

 

• Click Execute  on the Ribbon.  

 

• Right-click in the listing pane, and select Execute from the drop-down menu that appears.  

 

3. If you have user rights, you may make modifications to the Value field in the window that appears. 

Then click the Execute  button.  

 

4. Click the Analyze Results  button.  

 

5. The Analyze Results window will open. By default, you will be in the Show as Table tab. From here, 

you can begin organizing and filtering your data into a table. 

 

6. Choose the variables you want to see displayed in your table by dragging them from the Fields 

section into the Filters, Columns, Rows, or Measures windows.  

 

• Filters: Allows you to limit the data you see by filtering out the fields you don’t want displayed. 

Select the variables you want to filter by.  

 

Note: You can change the variables on the Tables, Data Charts, and Pie Charts tab. 

 

• Columns: Organizes the selected fields into columns. 
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• Rows: Organizes the selected fields into rows. 

 

• Measures: Shows a count of the data you want displayed. 

 

  
 

 
 

Note: Selecting the Defer Update checkbox will prevent your data from automatically being 

shown on your screen. If this checkbox is selected, you will have to click the Update Layout 

button whenever you want to see a current display of your data. 
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7. Once you have selected the data you want to appear in the table, you can dig deeper by using the 

Data Slicer to narrow or expand your results by hierarchy and level.  

 

• Once you have decided how you want to slice your data, click on the specific hierarchy and level 

you want to view.  

 

Note: To hide the hierarchy and level drop-down menus, click the  button. To bring it back into 

view, click the  button. Additionally, if you want to reset the hierarchy and level, click the  

button. 

 

 
 

Note: You can hide the Data Slicer section of Analyze Results by clicking the  button, found in the 

top left corner of the Analyze Results window. Click the button to bring the Data Slicer back into 

view. 

 

8. To show different counts of your data (Average, Count, Minimum, Maximum, or Sum), use the 

Aggregator drop-down menu. 
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9. Now that you have organized your data by the information you want displayed, you can do any of 

the following: 

 

• Click the Export to Excel button. 

 

• Click the Show as Data Chart tab to view your results in a chart. 

 

• Click the Show as Pie Chart tab to view your results in a pie chart. 

 

Note: You can save how your results are displayed by clicking the Add button in the upper left corner of 

the Analyze Results window. Type a name for your saved view and press the Save button (which 

appears after you click Add). To cancel, click the Cancel button. Saved views are visible to people you 

share the queries with. Each shared query has a common set of saved views. This means that if anyone 

adds a view to a shared query, everyone that query is shared to will be able to see it. 

Data Chart 

The data chart tab allows you to modify how you view your data results. The following section will give 

you an in-depth understanding of the options you can use in the Data Chart section of Analyze Results. 

 

1. Click the Show as Data Chart tab. 

 

2. From the Chart Type drop-down menu, select the type of chart you want your results to be 

displayed in.  

 

 
 

3. Enter a title for your chart in the Title field.  
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4. Enter a subtitle for your chart in the Subtitle field. 

 

5. Select the Show Marker Values checkbox to see exact counts. 

 

6. Select the Enable DataPoint Tracking checkbox to allow you to track exact numbers for different 

variables. Hover over the chart to have these numbers displayed. 

 

7. Select the Show Shadows checkbox to better define particular variables on your chart. 

 

8. Select the Show Zoom Options checkbox if you want to be able to zoom into specific areas of your 

chart. To do this, hover over the small replica of your chart to decide if you want to: 

 

• Zoom out  

 

• Zoom in  

 

• Reset your zoom to default , or 

 

• Select the default mouse drag interaction by right-clicking the  button (zoom into selection 

area , or pan ) 

 

Note: If you Copy Chart as Image, you need to deselect the Show Zoom Options checkbox or else it 

will appear in your copied image. 

 

9. By default, the Show Legend checkbox is selected. To hide the legend, deselect the Show Legend 

checkbox. 

 

10. From the Legend Position drop-down menu, select where you want your legend to appear in 

relation to the chart. 
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11. You can copy the chart and paste it into a document (e.g., Microsoft Word or Excel). To do this, click 

the Copy Chart as Image button, open the program that you want to copy the chart to, and paste it. 

Or, you can save your chart to your desktop by clicking the Save Chart as Image button. 

 

  

Note: Hide the charting options by clicking the Chart Options  button. Bring the options back into view 

by clicking the  button. 

Pie Chart 

The Pie Chart tab, while a different type of chart from the Data Charts tab (with different options to view 

your results by), allows you to modify how you view your data results. The following section will give you 

an in-depth understanding of the options you can use in the Pie Chart section of Analyze Results.  

 

1. Click the Show as Data Chart tab. 

 

2. Enter a title for your chart in the Title field.  

 

3. If you want to see exact numbers, hover your mouse over the pie chart. 
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4. You can copy the chart and paste it into a document (e.g., Microsoft Word or Excel). To do this, click 

the Copy Chart as Image button, open the program that you want to copy the chart to, and paste it. 

Or, you can save your chart to your desktop by clicking the Save Chart as Image button. 

 

Note: Hide the charting options by clicking the Chart Options  button. Bring the options back into view 

by clicking the  button. 
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Reports 

Perspective contains a number of preset reports that you may use to generate statistics and analyze 

trends in your data.  

User Interface 

The interface of the Reports component of Perspective is built around the specific type of report that is 

selected from the Navigation pane, and can be roughly divided into three parts: 

 

1. Navigation pane: Allows you to select various preset reports from five general categories. Once 

selected, the name of the report will appear at the top of the Report System pane. 

 

• Administrator Only: Reports that list groups of administrative hierarchies available in 

Perspective (e.g., Roles, Users, etc.). 

 

• Detail Reports: Condensed summaries of individual records stored in Perspective. 

 

• List: Reports that contain lists of records, assignments and losses. 

 

• Lookups: Reports that list values available in various Perspective’s lookups. 

 

• Summary Reports: Reports with a summary of data analysis; results are summarized in 

assorted bar and pie charts. 

 

2. Report System pane: Assists in filtering data for future reports and executes their creation. 

 

3. Report Settings toolbar: The invariable part of the Report System pane that provides options for 

refreshing the report settings view, generating reports in PDF, and opening previously run reports 

locally.  
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4. Report Settings pane: The variable part of the Report System pane that displays tabs, panes, and 

tools for specifying parameters for the data used in your report. 

 

Types of Reports 

Administrator Only 

• Role List: Lists all system roles, along with their respective descriptions and organizational rollups. 

 

• Test Report: For testing purposes only; successfully running this report demonstrates that SQL 

Reporting Services is operating properly. 

 

• User List: Lists all system users, along with their assigned security controls (roles, workgroups, 

organizational rollups, and access levels), and groups them by a security control of your choice. 

 

• Workgroup List: Lists all workgroups, along with their respective descriptions, organizations, and 

Perspective e-Reporting access status.  

Detail Reports 

• Incident Executive Summary: Displays the selected Incident record in brief detail, providing a short 

summary of the incident, its investigation and outcome, which is intended for managerial review.  
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• Activity Landscape: Displays the selected Activity record in great detail in a landscape-format 

report. 

 

• Activity Portrait: Displays the selected Activity record in great detail in a portrait-format report. 

 

• Case: Displays the selected Case record. 

 

• Incident Condensed Landscape: Displays the selected Incident record in great detail in a 

landscape-format report. 

 

• Incident Condensed Portrait: Displays the selected Incident record in great detail in a portrait-

format report. 

 

• Incident: Displays the selected Incident record, including some of its investigation data. 

 

• Item: Displays the selected Item record. 

 

• Organization: Displays the selected Organization record. 

 

• Person: Displays the selected Person record. 

 

• Vehicle: Displays the selected Vehicle record. 

 

• Investigation: Displays investigation data from the selected Incident record. 

List 

• Case Assignment By Person: Lists all case-related assignments along with key assignment details, 

such as the particular case in which the assignment was created, the user who created the 

assignment, and the user who was given the assignment. 

 

• Case Losses: Groups and totals case loss values by category, manager, supervisor, status, or 

workgroup; results are displayed in list form and are summarized in a bar chart. 
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• Case Summary: Groups and totals cases by category, manager, supervisor, status, or workgroup; 

results are displayed as brief case summaries. 

 

• Case Totals: Groups and totals cases by category, manager, supervisor, status, or workgroup; 

results are displayed in list form and are summarized in a bar chart. 

 

• Incident Assignment By Person: Lists all incident-related assignments, along with key assignment 

details, such as the particular incident in which the assignment was created, the user who created 

the assignment, and the user who was given the assignment. 

 

• Incident Losses: Groups and totals incident loss values by business unit, class, organizational rollup, 

site, or workgroup; results are displayed in list form and are summarized in a bar chart. 

 

• Incident Summary: Groups and totals incidents by business unit, class, site, status, or workgroup; 

results are displayed as brief incident summaries. 

 

• Incident Totals: Groups and totals incidents by business unit, class, disposition, organizational 

rollup, owner workgroup, or site; results are displayed in list form and are summarized in a bar 

chart. 

Lookups 

• Business Unit Hierarchy: Lists all combinations of lookup list values for the four-tier business unit 

rollup. 

 

• Class Hierarchy: Lists all combinations of lookup list values for the four-tier class rollup. 

 

• Lookup List: Lists all System English values for the selected lookup list, as well as their alternative 

labels in other languages. 

 

• Organization Hierarchy: Lists all combinations of lookup list values for the four-tier organizational 

rollup. 
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• Site Hierarchy: Lists all combinations of lookup list values for the four-tier site rollup. 

Summary Reports 

• Officer Category By Time: Calculates the time officers spent on activities providing the number of 

activities, the total and the average time, and the percentage of the total time per activity category. 

 

• Officer Log Report: Lists the officer log status changes by officer, including such details as Call 

Sign, Location, Status, Date/Time of the change, and Notes. 

 

• Response Time By Site: Provides short activity processing summaries by activity category, 

including activities’ Start Time, Arrive Time, End Time, and calculating the Response Time and the 

Total Time per activity and per category. 

 

• Frequency Distribution: Compares the total number of incidents that took place in two separate 

time periods by year, quarter, month, weekday, and hour; results are summarized in bar charts. 

 

• Case Classification: Groups and totals case loss values by category; results are summarized in 

assorted bar and pie charts. 

 

• Incident Classification: Groups and totals incident loss values by class and category; results are 

summarized in assorted bar and pie charts. 

 

• Yearly/Quarterly/Monthly Summary: Provides descriptive statistics for the number of incidents that 

took place during the time periods of years, quarters, and months; results are summarized in bar 

charts. 

Creating a Report 

1. Select a report from the list in the Navigation pane. 
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2. The Parameters tab will open by default. Each report has a unique set of one or more parameters 

that can be specified before running your report. As in all other Perspective forms, red parameter 

fields are required and all others are optional. 

 

• Select a Language: Choose a label set or a language of your report (e.g., System English). 

 

• Select Group By: Choose the entity your report’s results will be grouped or organized by (e.g., 

Access Level, Role, Workgroups, Status, Class Rollup). 

 

• Select a Date Range: Set a date range(s) your report’s data will be drawn from. Some reports 

may provide an option of selecting more than one date range for comparison. 

 

• Year/Quarter/Month (for the Frequency Distribution Report): Select the time period for which 

you would like your report to display statistics. 

 

• Workgroups checkboxes: Select the workgroups you would like the report to generate 

statistics from. Check All Workgroups to select all workgroups in the list. 

 

• Select a Business Type, Class Type, Lookup Type, Org Type, or Site Type: Specify the 

particular lookup list or rollup for which you would like to view available options or values. 

 

• Select an Officer (only for Officer reports): Choose the officer for which you would like to see 

the report data. 

 

• Select an Activity, Incident, Case, Item, Organization, Person, or Vehicle: Indicate the 

particular entity your report will be based on (e.g., Incident record INC-2010-000124, Jane 

Doe’s Person record). 

 

• Select Series (only for Totals reports): Specify the entity that your report’s charts will be 

grouped or organized by, next to the selected Group By field (i.e., Status, Disposition, Access 

Level, or Workgroups). 
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• Select Net Loss Over/Under (only for the Yearly / Quarterly / Monthly Report): Specify the Net 

Loss threshold value by which you would like to organize your report. 

 

• Completed? (only for Assignment reports): Indicate whether you would like completed, 

incomplete, or both completed and incomplete assignments to be included in your report. 

 

• Include Locked? (only for the Role List report): Indicate whether or not you would like locked 

roles to be included in your report.  

 

 
 

3. In addition to the Parameters tab, some Summary Reports have an option of filtering data that you 

would like to include in your report. To further qualify your report results, select the Criteria tab. 

 

a. Check the All Workgroups for Lookups and Rollups box to search across lookup lists and 

rollup values for all workgroups. 

 

b. In the Searchable Fields pane, select a form entity to display its available fields in the yellow 

pane to the right. 
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c. Highlight and right-click a field you would like to specify settings for, and select Search By to 

add the field to your search criteria. The chosen field will automatically populate the Field Name 

box in the search pane on the right half of the screen. 

 

d. Select a field operator from the Opt lookup list (e.g., =, >). 

 

e. Enter the comparative value in the Value field or select an option from the list by clicking on the 

plus icon . 

 

f. Click Enter to add the field specification to your report search criteria.  

Every time you add a new field specification to the search criteria, the pane on the left will 

populate with a new symbol associated with the added criterion (e.g., A, B, C). The 

arrangement of the symbols in the pane defines the relationships between the criteria, which 

are also reflected in the Boolean logic statement outlined below. By default, every criterion 

added is in the OR relationship with the previous and next. 

 

g. To modify these relationships (and the logic statement), creating an internal hierarchy within 

the criteria, select a symbol from the pane on the left and click the adjacent up or down arrows. 

Criteria that appear in separate nodes are in the OR relationship to each other, while criteria 

that appear in sub-nodes are in the AND relationship to the main criterion at the top of the 

node.  

 

h. To modify your search criteria, select the criteria you want to modify, make changes in the Opt 

and Value fields, and click Update. The changes will be applied to the criterion on both the level 

of the criteria list and the Boolean logic statement.  

 

i. To remove a field from your search criteria list, select the field and click Remove. 

 

4. Click Preview in the Report Settings toolbar to generate the report.  

 

5. For some reports, you will have to select parts of the report that you want to include in the report 

from the Report Visibility window. This window contains checkboxes for all report sections 

containing data. By default, all boxes will be checked. Uncheck the boxes for any sections you do 
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not want to appear in your report. Check the Download All Attachments? box if you want to 

download the attachments included in the record for printing (this checkbox only appears if the 

report includes attachments). Click OK. 

 

 
 

6. A Report Options window will open.  

 

a. Click the Open icon to instantly view a printable PDF copy of the report.  

 

b. Click the Send icon to send an email message with a PDF copy of the report attached. 

 

c. Click the Save icon to save a PDF copy of the report to the location of your choice.  

 

d. Click the Close icon to cancel the report. 
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7. To access the most recently generated report, click the Open Local button in the Report Settings 

toolbar.  

 

Note: The Preview button should always be used to generate new reports with the most up-to-date 

data available in Perspective. The Open Local button should only be used to quickly reference 

recently run reports.
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Custom Reports 

You have the ability to take queries that you’ve built in Analysis Expert and customize them into custom 

reports. You define what information goes into the report and how it looks. 

 

Note: You need user permissions to access Custom Reports. 

User Interface 

The interface of the Custom Reports component evolves into separate screens depending on how far 

along you are in building your custom report – the initial custom reports window and the subsequent 

reports designer window. The reports designer window of the Custom Reports component is where you 

modify the appearance of your report, including changing the background, font colors and sizes, adding 

logos, etc. The initial custom reports window is divided into the following sections: 

 

1. Ribbon: Contains the buttons that perform adding and execution of custom reports.  

Note: Right-click the listing pane to open a menu with the following options: Add, Edit, Share, 

Delete, Clone, and Execute your custom report. 

 

2. Listing pane: Arranges custom reports that you create according to their access options (i.e., 

Shared Custom Reports or Private Custom Reports) and Custom Report category. By default, all 

new Custom Reports are Private Queries available only to the user who created them. In order to 

make a saved Custom Report available to users across your organization, you must share it. Refer 

to the Share a Custom Report chapter for more information on how to do this. 

Custom Report Design Process 

The following chapter involves working with Perspective’s Report Designer. To understand how to use 

the Report Designer, please refer to the Report Designer section for details. 

file://///ppm2000.com/Corp/Departments/Product%20Management/Private/beth.blackstock/My%20Documents/Beth/NEW%20Reports.docx%23shareaq
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Create a Custom Report 

1. Make sure the custom report category you want your created custom report to appear under is 

highlighted (i.e., Private Queries, Shared Queries). 

 

2. To start a new custom report, choose one of the following options: 

 

• Click Add      on the Ribbon.  

 

• Right-click in the listing pane, and select Add from the drop-down menu that appears.  

 

3. A Create New Custom Report dialog box will open.  

 

4. Enter a title for the custom report in the Report Name field.  

 

Note: Use specific names for your custom reports, because if same-named reports are shared, the 

user will only see the first query with that name. 

 

5. Make sure the Report Category is correct. If you want to create a new Category, type it in this field. 

 

6. In the Report Description text box, identify the type of custom report and/or its purpose. 

 

Note: The Report Description field can be left blank. The Report Name and Report Category fields 

must be filled in. 
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7. Click Design.  

 

8. The new custom report entry will be added to the relevant record entry node. The Perspective 

Report Designer window will open (refer to the Report Designer section for details on how to use 

the Report Designer). 

Save a Custom Report 

1. Complete the design of your custom report. 

 

2. Store the custom report for access at a later date by doing one of the following actions: 

 

• Click Save  on the Ribbon. 

 

• Click File, and from the drop-down menu that appears, click Save. 

Edit a Custom Report 

1. Make sure the custom report you want to edit is highlighted. 
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2. To open and begin editing the custom report, choose one of the following options: 

 

• Click Edit  on the Ribbon.  

 

• Right-click in the listing pane, and select Edit from the drop-down menu that appears.  

 

3. The Custom Report dialog box will open.  

 

4. Make changes to the Report Name, Report Category, and Report Description fields as needed. 

 

5. If the report’s query has been modified in Analysis Expert, click Update Queries at the bottom of 

the window. This will modify the report to reflect the updated query. 

 

6. To modify the design of the report, click Design at the bottom of the window. 

 

7. Make the appropriate changes in the Custom Report Designer. 

 

8. Store the custom report for access at a later date by clicking Save  on the Ribbon, or click File and 

then Save from the drop-down menu that appears. 

Clone a Custom Report 

Note: If you do not have Manage rights, you will be unable to clone or edit a custom report. 

 

1. Make sure the custom report you want to clone is highlighted. 

 

2. To clone the custom report, choose one of the following options: 

 

• Click Clone  on the Ribbon.  

 

• Right-click in the listing pane, and select Clone from the drop-down menu that appears.  
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3. A prompt will appear, asking if you are sure you want to clone the custom report. Click the Yes 

button to clone the report, or No to cancel the cloning process.  

Share a Custom Report 

1. Make sure the custom report you want to share is highlighted. 

 

2. To share the custom report, choose one of the following options: 

 

• Click Share  on the Ribbon.  

 

• Right-click in the listing pane, and select Share from the drop-down menu that appears.  

 

3. The Share Custom Report dialog box will open.  

 

4. Click the Add User or the Add Role button.  

 

5. Select the user you want to share the custom report with by typing his/her name and/or role in the 

text field, or scrolling through all users and/or roles.  

 

6. Double-click the user’s name and/or role to confirm your selection. 

 

• Click the Allow Manage checkbox if you want the user or a particular role to have the ability to 

edit, share, delete, or clone the shared custom report. 

 

7. Click Save. 

 

• Shared custom reports will have the  Share icon displayed beside the title. 

Delete a Custom Report 

Note: A custom report that has been shared to you by another user cannot be deleted. 
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1. Make sure the custom report you want to delete is highlighted. 

 

2. To delete the custom report, choose one of the following options: 

 

• Click Delete  on the Ribbon.  

 

• Right-click in the listing pane, and select Delete from the drop-down menu that appears.  

 

3. A prompt will appear, asking if you are sure you want to delete the custom report. Click the Yes 

button to delete the report, or No to cancel the deletion process.  

Execute a Custom Report 

1. Once your custom report is created, you may either run it immediately, or save it for further use, and 

then run it. To run a saved custom report, select the name of the report you want to run from the 

custom reports list in the listing pane.  

 

2. To execute the query, choose one of the following options: 

 

• Click Execute  on the Ribbon.  

 

• While in the Report Designer, click File, Export and from the menu that appears, select the file 

type you want the report to be run in.  

Report Designer 

In the Report Designer, you have all your query data at your disposal and can prepare it for printing in 

different ways.  
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Getting Started 

Insert a Company Logo into the Report  

For the company logo, please use the sunshine.gif file, which you will find in the directory for the Sample 

Application. We also need a Picture object. Proceed as follows:  

 

1. Click Insert > Picture (Objects > Insert > Picture).  

 

 

 

Note: Objects are your project's building blocks. They are generated in the workspace where they 

are also given a border with which their size and position can be changed. This border defines the 

space that the object takes up and thus also the maximum size to which the contents of the 

respective object can be expanded. Objects may overlap fully or partly.  

 

2. In the workspace, point the mouse to the position where the upper left corner of the object is to 

begin. The mouse cursor changes to a crosshair. Hold down the left mouse button and drag the 

crosshair to the lower right corner of the planned object. Release the mouse button when the object 

(the dashed border) is the right size.  

 

Note: Objects can be added to the workspace in different ways: via the menu Objects > Insert, via 

the toolbar or via keyboard shortcuts, or with Drag and Drop from the list of variables.  

 

3. Select if the picture is loaded from a file or if the content is defined by a formula/variable.  

 

Note: This dialog is not available in Windows XP, the file selection dialog will appear directly.  
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4. If you select File, a file selection dialog will appear. Select the image file.  

 

Note: The following formats are available: LL, BMP, DOCX, HTML, JPG, PDF, PNG, RTF, SVG, TXT, 

TIFF, XLS, XLSX, XML, and XPX. As a general rule, you should use the RGB color space (not CYMK). 

Transparency in PNG files is supported by using the corresponding Windows functions. In our 

experience the majority of printer drivers do not support transparency so that reports with e.g., 

partly transparent PNG files should thoroughly be tested on the actual hard-software combination. 

If that is not possible we recommend doing without the alpha channel.  

Insert the picture into the project by enabling the Embed image in project file checkbox option.  

 

 

 

5. After you select the file, select the Embed image in project file checkbox, and click Open, the logo 

will be inserted into your report.  
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Add a Title to the Report  

Use a text object to add a title to the report. Text objects let you place text in the workspace. As well as 

fixed text, you can also insert the contents of fields (variables) from the database (e.g., company name), 

or you can use functions (page number, date, etc.).  

 

1. Click Insert > Text (Objects > Insert > Text).  

 

 

2. In the workspace, hold down the left mouse button and pull the object to the required size. Text 

objects should always be created in the maximum size you want, the object shrinks at print time to 

the required size.  
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3. The formula wizard will now appear which you can use to define the contents of the text object.  

This dialog consists of a series of tabs each containing different elements to be edited. The 

following chapters explain the meanings of these elements in more detail.  

 

• Data and Functions: the available variables, fields, and functions.  

 

• Condition: for defining IF-THEN-ELSE conditions.  

 

• Text: for entering fixed text and tabs.  

 

• Date Format: different date formats.  

 

• Number Format: different number formats.  

 

• Operators: available conjunction operators.  

 

You can also enter the expression that you want directly in the edit box or modify the text that is 

there (e.g., put something in brackets).  

 

Therefore, enter our title Products directly. Fixed text must be enclosed in quotation marks. Enter 

names of data and functions without brackets.  
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Note: Please note that there are two ways of writing expressions, depending on their use. You will 

find more information about this in the chapter Variables, Fields and Expressions.  

 

4. The title will be displayed when you close the dialog with OK.  

 

5. Use the tab Texttools > Text (mini-toolbar) to enlarge the font size.  

 

6. You have now added the title:  
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Insert the Table for the Product List  

Use the Report Container object to add a table to the report. As the name says, a report container can 

hold several objects: tables, charts and crosstabs can be added in any order.  

 

Note: The report container is not available in all applications. In applications that don't have the report 

container, use the Table object.  

 

1. Click Insert > Report Container (Objects > Insert > Report Container).  

 

 
 

2. In the workspace, hold down the left mouse button and pull the object to the required size.  
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3. A selection dialog will appear for the chosen element type. Choose the Table element type.  

 

 

 

 

4. Now supply the data source in the following dialog. All available tables are shown hierarchically; in 

other words, under the tables, you will find the relational tables in each case.  

 

 

Select the Products table because it contains the fields that we want for our product list.  
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5. A selection wizard will appear with all the fields in the Products table. In addition, underneath the 

Products table, you will also find the fields in the tables Categories and Suppliers which have a 

1:1.relationship with Products.  

 

  

In this dialog, now choose the columns for the table. Double-click a field, e.g., ProductName. The 

field will be added to the Columns area.  

 

6. Repeat this step for all fields that are to be shown in the table; i.e., also the CategoryName field 

from the linked table Categories and the UnitPrice field for the unit price. Confirm your selection by 

clicking OK.  

 

7. The table will now be displayed in the workspace.  

 

• The selected fields are displayed in the data line, in other words, the data line contains the data.  
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• In addition, a header line is automatically produced. Header lines are used mostly as column 

titles, i.e., the selected field names are now shown here as text.  

 

• If you pull the report container widthwise to make it wider or narrower while holding down the 

CTRL key, the columns will be adjusted proportionally to fit.  

 

• The width of the columns adjusts automatically. You can adjust the width of a column manually 

by moving the separating line to the right or the left with the mouse.  

 

Note: This changes all table columns, whose separators are within +/-2 mm from the mouse 

position. If you hold down the CTRL key, the action will only be carried out for the line on which the 

mouse is positioned. If the Column width modification affects next column option is enabled (File > 

Options > Workspace), you can alter the column width while making the next column smaller.  
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Format Table Fields  

Only a few basic formatting options are explained here.  

 

1. In the product category column title, the field name CategoryName is shown. Click the respective 

field in order to change this text to Category. The formula wizard will now appear, which you can 

use to change the contents of the field. Text must be enclosed in quotation marks.  

 

  

 

2. In addition, we want to format the unit price as currency and align the entire column to the right. 

You will find both formatting options in the tab Table Tools > Table (mini-toolbar). Click in the 

upper left corner to select the field containing the unit price.  

 

 

 

3. Click the button % Format for the formatting dialog  
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4. A selection dialog will now appear in which you can select the formatting that you want for the 

numeric field. To do this, choose the type on the left hand side i.e., Currency. In the right pane, you 

can specify the currency formatting in detail. The settings for the relevant application will be used in 

each case as standard. Alternatively, you can choose the system setting or a user defined setting.  

 

     

 

5. Finally, select both fields (the header and the data line) to align them to the right. To do this, hold 

down the CTRL key and select both fields by clicking in the upper left corner in each case. Then 

click the button for right alignment.  

 

Display a Preview of the Report  

Until now, you have only seen the report in layout view as a structure with a record. To get an impression 

of the result, you can display a preview of the report. Use the tabs in the bottom margin of the workspace 

to change to the preview.  

 

Note: Real data preview mode is not supported by all applications.  
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The report will now be displayed with the data from the Products table. You can also change the number 

of products or data records in the Sample Application.  

 

1. To do this, save the report with File > Save.  

 

2. End the Designer with File > Close.  

 

3. In the Sample Application, choose Options > Settings, and increase the maximum number of root 

records to 50.  

 

4. Open the print template that you created again via Design > Extended Samples, and switch to 

preview mode. Your report will look roughly like this:  
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Add a Page Number  

It's a good idea to add a page number in the lower area of the page. To do this, add a new text object. 

You will be using functions (such as the page number function) as well as fixed text with this object.  

 

1. Choose Insert > Text (Objects > Insert > Text).  

 

 
 

2. In the workspace, hold down the left mouse button and pull the object to the required size.  

 

3. The formula wizard will now appear which you can use to define the contents of the text object. 

The available functions are shown in the right pane. You can use an auto filter with this list. Type 

page in the filter field. This will cause all functions containing the expression page to be displayed.  

 

• The Page$ () function returns the page number.  

 

• The TotalPage$ () function returns the total number of pages.  

 

Add the Page$ () function to the result area by double-clicking.  

 

4. If you now want to output a footer in the form of Page 1 of 2, you can enter the text of directly in 

the usual way. Please consider that individual parts must be joined with a + and that text must be 

enclosed in quotation marks.  

 

5. Now add the TotalPages$ () function by double-clicking to get the total number pages. The formula 

will look like this:  
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6. You can center this line in the report in the usual way:  

 

 

 

7. Switch to preview mode to view the result:  
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General Procedures 

Choose a Page Layout 

The first task in a new project is to set up the page layout that you want. Click Project > Layout Regions 

(Project > Page Layout) to specify properties such the choice of printer, paper size, and orientation.  

 

If multiple layout areas are defined, the active workspace can be selected via the Active Design Layout 

project property. 

Zoom 

It is possible to zoom in on the workspace. Use Zoom In, Zoom Out, and 100% to adjust the view in the 

workspace. Use the Zoom slider in the status bar to slide to the zoom percentage you requires (50% - 

500%).  
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Use Select Area to select the view area with the left mouse button. Click Start> Select Area (objects 

toolbar > Select). 

Status Line 

The status line is divided in three sections.  

 

• The current mouse position from upper left.  

 

• The active operation (e.g., selection).  

 

• Name, position upper left, position lower right, width, height, and layer of the selected object.  

 

• Zoom slider for Workspace and Preview.  

 

Ribbon 

The Ribbon contains command buttons on different tabs. The commands are arranged according to how 

often they are used. Frequently used commands are available prominently; less frequently used 

commands are located on less prominently. 

 

Note: Alternatively, you can work with a classic menu and toolbars. Select the type of display in the 

project options (Project> Options> Workspace). 

 

 

Some other commands are displayed only when you might need them, in response to an action. 
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Text Tools 

If you insert a text object, the Text Tools and the tab Text are displayed. The tab contains the commands 

you need for working with text objects. When you have finished the work on the text object, the Text 

Tools are hidden. 

 

 

With the Text Tools you can append/insert a paragraph, move paragraphs upwards/downwards, apply 

fonts, font sizes, text colors and formatting as well as arrange objects.  

 

• To select a complete paragraph, click onto the bar on the left. Hold CTRL or SHIFT to select multiple 

paragraphs or a complete range.  

Table Tools 

If you insert a table, the Table Tools and the tab Table are displayed. The tab contains the commands you 

need for working with table objects. When you have finished the work on the text object, the Table Tools 

are hidden. 

 

 
 

With the Table Tools you can define a new line, insert a new row, move selected rows/cells to the 

left/right, borders, apply fonts, font sizes, text colors, and formatting, as well as arrange objects. 

 

• To select a field, click in the top left corner of the field. Hold CTRL or SHIFT to select multiple fields 

or a complete range.  

 



Perspective User’s Guide  Custom Reports 

 © Resolver Inc.   Page 259 of 399 

 
 

• To select a complete line, click onto the bar on the left. Hold CTRL or SHIFT to select multiple 

paragraphs or a complete range.  

 

 
 

• To select a complete column, hold ALT. Hold CTRL or SHIFT to select multiple columns or a 

complete range.  

 

 

 

Drawing Tools 

 

If you insert a drawing object, the Drawing Tools and the tab Design are displayed. The tab contains the 

commands you need for working with drawing objects (e.g., Outline color, Lineweight). 
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Minimize the Ribbon 

 

The ribbon can be minimized in order to save screen space.  

 

• Right-click the ribbon, and then click Minimize the Ribbon.  

 

• To quickly minimize the ribbon, double-click the name of the active tab. Double-click a tab again to 

restore the ribbon.  

 

• To minimize or restore the ribbon via Keyboard shortcut press CTRL+F1.  

 

To use the ribbon while it is minimized, click the tab you want to use, and then click the option or 

command you want to use. 

 

File Menu 

 

The File menu contains commands for saving, printing, exporting the project, and the project options. 
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Quick Access Toolbar 

 

The Quick Access Toolbar is a customizable toolbar that contains a set of commands that are 

independent of the tab on the ribbon that is currently displayed. You can move the Quick Access Toolbar 

from one of the two possible locations, and you can add buttons that represent commands to the Quick 

Access Toolbar.  

 

On the ribbon, click the appropriate tab or group to display the command that you want to add to the 

Quick Access Toolbar. Right-click the command, and then click Add to Quick Access Toolbar on the 

shortcut menu. In order to delete a command, right-click the command you want to remove from the 

Quick Access Toolbar, and then click Remove from Quick Access Toolbar on the shortcut menu. 

Mini-toolbar 

When you select a text object or a table object, a convenient toolbar in miniature format is displayed, the 

mini-toolbar.  

 

Note: The Mini toolbar is especially useful if you use the classic menu and toolbars instead of the ribbon. 

You can select the type of display in the project options (Project> Options> Workspace). When using the 

ribbon, the functions of the mini-toolbar will be displayed in the tabs Text Tools and Table Tools.  

 

• With the mini-toolbar you can add a text paragraph, define a new table line, insert a new table row, 

apply fonts, font sizes, orientations, text colors and formatting as well as open the object dialog.  

 

• You can close the mini-toolbar by pressing ESC. With the project option Show mini-toolbar (File > 

Options > Workspace) it can be suppressed permanently.  
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Default Settings for Font and Frame 

Click File > Options > Objects.  

 

The Select button under Object font lets you choose the default font to be used for objects. Under Color 

preferences, you can specify the border and the filling for objects.  

New objects will be created according to these settings. However, you can change the settings later 

individually for each object.  

 

When you start a new project, it's a good idea to configure these settings using suitable values to keep 

the effort required for making manual changes to a minimum. The settings only apply for the current 

project.  

 

The Default parameter in the respective object properties (Font/Frame/Background) is active as standard 

for all objects. Therefore, if the default values are changed later, this will also affect all objects whose font 

has not been changed manually. 

Create a Professional Table 

In this chapter, we will extend the previous examples to include more functions, output grouped data, 

use appearance conditions and layers to allow multiple pages to be output and add more elements to the 

report container. 

Use Advanced Features with the Report Structure 

You use the Report Container object to add a table. As the name says, a report container can hold several 

objects.  

 

Tables, charts, crosstabs and Gantt charts can be added in any order, even as sub-elements of tables. 

This lets you define sub-reports with almost any relationships between tables.  

 

However, only one report container is permitted and you cannot define any separate tables, charts, 

crosstabs or Gantt charts.  
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You define new elements in the Report Structure tool window along with the hierarchical structure that 

you want. All elements and respective sub-elements of a report structure are shown here, with object 

type and data source [relation name, sort name], in the order in which they will later be printed (sequence 

plan).  

 

The currently selected item will be highlighted in the workspace. By using the checkboxes in the tool 

window Report Structure, you can toggle the visibility of elements, sub elements and branches. 

 

 
 

All actions are available in a context menu. There are additional buttons in the top toolbar for the 

frequently used actions.  

 

To add a new element to the report container, select the Append an element or the Append a sub-

element button. Sub-elements are only possible with tables.  

 

Only one element is displayed at any time in the workspace. This means that with the Report Structure 

toolbar, you select the element that you want to be displayed in the workspace.  

Practice: Define the Report Structure Correctly 

Let’s assume that you want to produce a list of all customers, showing the orders of the respective 

customers and all order items.  

 

You want the result to look roughly like this: 
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Perspective User’s Guide  Custom Reports 

 © Resolver Inc.   Page 265 of 399 

To achieve this, proceed as follows: 

 

1. Click Insert > Report Container (Objects > Insert > Report Container).  

 

 

 

2. In the workspace, hold down the left mouse button and pull the object to the required size.  

 

3. A selection dialog will appear for the chosen element type. Choose the Table element type.  

 

 
 

4. You specify the data source in the following dialog. All available tables are shown hierarchically, in 

other words, under the tables, you will find the relational tables in each case.  
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For the list of invoices, you need the following structure: Customers > Orders > Order_Details.  

 

You have two alternative procedures at this point:  

 

a. You select the Customers table to first create the top table. This corresponds to a top-down 

procedure; meaning that you then add the Orders sub-table followed by the Order details sub-

table by means of the Report Structure tool window.  

 

b. Or you choose the structure that you want right from the start by selecting the lowest table. 

This corresponds to a bottom-up procedure, meaning that you create all three tables starting by 

designing the lowest table.  

 

5. You will be using the second method in this example. Accordingly, you select the table Customers > 

Orders > Order_Details.  

 

6. A selection wizard will appear with all the fields in the Order_Details table.  
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In this dialog, now choose the columns for this sub-table. For example, double-click the ProductID, 

Quantity, UnitPrice and ProductName fields from the Products table which has a 1:1 relationship. 

This will add the fields to the Columns area. You can change the order with the arrow button. 

 

7. All tables will now be displayed in the workspace, the currently selected item Order_Details will be 

highlighted in the workspace.  

 

• The selected fields are displayed in the data line, in other words, the data line contains the data.  

 

• In addition, a header line is automatically produced. Header lines are used mostly as column 

titles, i.e., the selected field names are now shown here as text.  

 

• The width of the columns adjusts automatically. You can adjust the width of a column manually 

by moving the separating line to the right or the left with the mouse.  

 

Note: This changes all table columns whose separators are within +/-2 mm from the mouse 

position. If you hold down the CTRL key, the action will only be carried out for the line on which the 
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mouse is positioned. The Column width modification affects next column option lets you alter the 

column width while making the next column smaller.  

 

8. To define the columns of the Orders table, double-click the table in the Report Structure tool 

window.  

Modify Fields and Columns 

There are two possibilities for adding additional columns to tables or for editing and formatting them in 

detail. 

 

Table Tools and Mini-toolbar 

 

If you insert a table, the Table Tools and the tab Table are displayed. The tab contains the commands you 

need for working with table objects. When you have finished the work on the text object, the Table Tools 

are hidden.  

 

Optionally, you can activate a mini-toolbar for the tabel-objects (File > Options > Workspace). 

 

 
 

With the Table Tools you can define a new line, insert a new row, move selected rows/cells to the 

left/right, borders, apply fonts, font sizes, text colors and formatting as well as arrange objects.  

 

• To select a field, click in the top left corner of the field. Hold CTRL or SHIFT to select multiple fields 

or a complete range.  

 

• To select a complete line, click onto the bar on the left. Hold CTRL or SHIFT to select multiple 

paragraphs or a complete range.  
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• To select a complete column, hold ALT. Hold CTRL or SHIFT to select multiple columns or a 

complete range.  

Object Dialog 

 

Use the object dialog for more advanced functionalities. You open this dialog via the corresponding 

button in the mini-toolbar or by double-clicking the element in the report structure. 

 
 

There is a tab for each type of line where you can specify the different definitions and columns for the 

respective line. The following types of line are available: header line, data line, footer line, group header, 

group footer. A checkmark on the tab indicates that a line type has one or more line definitions.  

 

• Header lines are mostly used as titles for the columns of the table.  

 

• Data lines contain the formatting for the actual table rows and the data that is to be shown in the 

table.  
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• Footer lines are displayed at the very end of the table and can hold final information about the data 

lines that are output above.  

 

• Group header and footer lines are used to structure the data lines by means of Intermediate 

headings and Intermediate footers.  

 

All line types can be defined independently of one another.  

 

• This means that the columns of a header line can have a different appearance as the data lines or 

footers that follow.  

 

• You can also create different line layouts or line definitions for the individual line types. It is then 

possible to activate the different line definitions with special appearance conditions as required.  

Variables-/Field-List, and Drag and Drop 

The Variables-/Field-List (Project > Variables/Fields) shows all available variables and fields of the 

current project. To add more columns to existing rows you can simply drag the desired fields from the list 

onto the corresponding position with the mouse (drag and drop). The field can be inserted to the left or 

right of the corresponding column, a symbol shows the insert position. The column (standard width 

30mm) will be inserted in the corresponding row. Please note that columns could be created in the non-

visible area. 

Define Multiple Line Layouts 

You can define different layouts for each type of line. Depending on the appearance conditions, the 

appropriate layout is used in each case according to the situation. For example, you can output two table 

lines for each data record in this way: 
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Proceed as follows to create table lines in the object dialog.  

 

1. First select the line type that you want to edit by clicking the relevant tab, e.g., Data Line.  

 

2. Now choose Insert Table Line in the context menu. Alternatively, you can select an existing Line 

definition and then click the New (Append line definition) button.  

 

3. In the Choose a Table Line Definition dialog that follows, you have the option of: 

 

• using an already existing layout as a template for the new line definition (very useful if the 

layout is similar).  

 

• starting the data selection wizard (very useful if you want to create several columns in one 

operation)  

 

• or creating an empty line definition so that you can then add the columns by means of the 

object dialog.  
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4. You have now created the new line. Edit the columns as described in Defining Column Contents. 

Change the order of the line with the arrow button or with Drag & Drop.  

 

5. You can then specify the appearance of the new line as a whole. Various properties are available for 

this including:  

 

• Appearance Condition with which you can specify when the line is to be printed. This is useful if 

you define multiple line layouts that are to be printed depending on certain values. The familiar 

dialog for defining logical expressions opens up here.  

 

 
Appearance condition: not Lastpage() 

 

 
Appearance condition: Grand total only on last page 

 

• Name of the line e.g., data first line. This makes it easier to find the line in complex layouts.  
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• Display in Designer: with this property, you can hide the lines in the workspace – this is very 

useful if you have a lot of line definitions.  

 

• Spacing (margins): here you define the top, bottom, right and left spacing of the line. The top or 

bottom values cause a corresponding space between the individual table rows. With the left 

and right spacing values, you can specify the margin in relation to the table object, i.e., you can 

indent lines or columns.  

 

• The Default Font property sets the font for the entire table row. Newly inserted columns appear 

initially in this font.  

 

• Outline Level (index level) of the bookmark in preview mode or for PDF export.  

 

 

Define Column Contents 

You can define as many columns as you want for each line. You must only make sure that these columns 

can be displayed within the width defined for the table.  
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The individual columns are shown in the object dialog as a tree structure. The buttons let you edit, delete, 

cut, copy, insert and move the selected columns. You can also move columns outside of the line 

definitions by using Drag and Drop.  

 

Proceed as follows to create new columns in the object dialog: 

 

1. First select the line in which you want to insert a new column.  

 

2. Now choose Append column in the context menu. (ALT+INS). Alternatively, you can select an 

existing Column definition and then click the New (Append column) button or the small downwards 

arrow next to this button to specify the type.  

 

3. Each column has a certain type. Various properties are available for the column type including: text, 

drawing, barcode, RTF text, chart, gauge, HTML text and OLE container. When selecting a field, this 

data type will be set automatically.  

 

4. To define the contents, the familiar formula wizard will appear in which you can define the column 

contents in the form of expressions. You will find more information about this under Variables, 

Fields and Expressions.  

 

5. Now define the column's properties. Each column in a line can be edited and formatted separately. 

Select the column that you want in the tree structure in the object dialog.  
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To select multiple columns, hold down the ALT or the SHIFT key. Various properties are available 

including: 

 

• Formatting e.g., as number or currency.  

 

• Name of the column: this will help you to maintain an overview with complex expressions. If you 

change the name directly in the tree structure, your change will also be applied as content 

where appropriate.  

 

• You can specify when this column is to be printed with an appearance condition. This is useful if 

you define multiple columns that are to be printed depending on certain values. The familiar 

dialog for defining logical expressions opens up here.  

 

• Rotation of the content in increments of 90°.  

 

• Background, frame, font, vertical and horizontal alignment.  

 

• A fixed height for the field irrespective of the content.  
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• The column width.  

Define Group Lines 

Group lines are a special type of line. They are used to group together the data lines that are to be 

printed.  

 

You can use the Group by line property to specify how the data is to be grouped. This means that the line 

is printed whenever the result of the expression changes from one data line to the next. If you don't enter 

an expression, the line will not be printed and the property is highlighted in red in the property window.  

 

A group header is printed accordingly before the data line is output, e.g., Item group XYZ group heading.  

 

A group footer appears after the condition of the Group By property has changed, in other words, after 

outputting the data line. Group footers are suitable e.g., for totals of data within a group.  

In the report container you can also output a group sum in the group header with the Precalc() function, 

e.g., Precalc(Sum(Item.UnitPrice, <GroupBy-String>)). 
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1. Create a new line definition on the Group header tab. Enter the following expression for the content 

of the column: 

  

Main group: ' + Left$ (Item.No,1)  

 

The result of the expression Left$ (Item.No,1) is the first character of the Item.No variable. 

Whenever the first letter of Item.No changes, the text Main group:  and the first letter in each case 

will be printed.  

 

2. Enter Left$ (Item.No,1) as the condition for the Group By property.  

With each new first letter, a corresponding intermediate header will be printed in the list.  

 

3. Multiple line layouts are possible with group headers as well. In this way, you can produce 

hierarchically structured intermediate headers. For example, you can define a line layout that is 

produced, as in the above example, based on the first letter of the Item.No variable. In addition, you 

define a second line layout that produces intermediate headers based on the first three characters 

of Item.No.  
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4. Create a new line grouping for the sub-group header in the same way. Enter Left$ (Item.No,3) as 

the condition for the Group By property.  

Enter the sub-group for the content of the column: ' + Left$ (Artikel.Nr,3): When the first 3 letters 

change, a corresponding intermediate header will be printed in the list.  

 

Along with the properties of the normal lines, you also have the following at your disposal:  

 

• Group sums: You can set sum variables to 0 here once they have been output in order to produce 

group sums.  

 

• Page break before outputting a group header or break after outputting a group footer.  

 

• The option of always displaying the group header additionally at the start of the table if the group 

has been separated by a page break.  

 

Table Layouts 

There are various properties and functions which you can use to influence the layout of a table.  

Align Columns 

There are various ways of simplifying the use of table objects. 

 

• If you hold down the CTRL key when reducing the size of a table, all columns will be automatically 

reduced in size by the same factor.  

 

• The width of the columns adjusts automatically. You can adjust the width of a column manually by 

moving the separating line to the right or the left with the mouse. This changes all table columns, 

whose separators are within +/-2 mm from the mouse position. If you hold down the CTRL key, the 

action will only be carried out for the line on which the mouse is positioned. If the Column width 

modification affects next column option is enabled (File > Options > Workspace), you can alter the 

column width while making the next column smaller.  

 



Perspective User’s Guide  Custom Reports 

 © Resolver Inc.   Page 279 of 399 

• If you move the first column separator to the right with the mouse, an empty column will be created 

in all line definitions.  

 

• Use the function TableWidth() to define the column widths relatively. It returns the width of the 

table object. Example: With TableWidth()*30/100 the Column takes 30% of the width.  

 

• You can hide Line Types (header, data, footer, group lines) in the workspace. To do this, select the 

table object and use Visible Line Types in the context menu or the corresponding menu item View> 

Visible Line Types.  

 

• To align (sub) tables easier with one another, additional tick marks can be shown on the ruler by 

means of an element property.  

 

 

Fixed Size 

The Fixed Size property lets you specify that the size of the table is not to be adjusted automatically 

when fewer data lines are printed than the available space in the table object.  

This property is useful to ensure that footers are always printed at the bottom of the page, e.g., if the 

page number is output in the footer. If the property is disabled, the end of the table automatically moves 

upwards (and the footer therefore also). 

Print Header Lines and Footer Lines Again 

If the print of a table is continued on the following page, the header lines of this table and the outer table 

will be printed again. To suppress repeated printing of the header lines on the following page, use the 

FirstHeaderThisTable() function as an appearance condition.  

This functionality is also available for footer lines, here you use the LastFooterThisTable() function as the 

appearance condition. This ensures that footer lines are only output on the last page of the table in the 

event that the print is continued on the following page due to lack of space. 
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Define the Size of the Table Variably 

You can define the height and width of the report containers variably to avoid data being truncated when 

the page format is changed (e.g., from portrait to landscape).  

 

To do this, select the report container in the Report Structure tool window and use the LL.Device.Page 

variables and the UnitFromSCM() function to specify the height and width. 

 

 

Force a New Page 

With complex projects containing hierarchical tables, it is sometimes wise to create a page break before 

outputting a line of the top table.  

 

Alternatively, you may want to have a new page if, after outputting a data line of the top table, there is 

not enough room for the following data lines of the sub-table.  

 

You can handle both cases with the Pagebreak Condition property.  

 

For example, in the case of a hierarchical table, in order to output each data line of the main table on a 

new page, select the main table in the Report Structure tool window and set the Pagebreak Condition 

property to True. 
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Create a Conditional Page Break 

Let’s assume that you want to create a continuous table. However, you want to avoid printing data lines 

from the main table at the bottom of the table unless there is enough room for at least 3 data lines from 

the sub-table.  

 

You do not want it to look like this: 
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You can avoid this by means of the RemainingTableSpace() function. This function returns a value 

showing the available space. If you set the parameter to True, the value will be returned as 1/1000 mm.  
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If you want to specify that a new page should be started before outputting the data line of the main table 

if the space remaining is less than 3 cm, enter the following formula for the Pagebreak Condition 

property:  

 

RemainingTableSpace(True)<30000 

Keep Lines Together 

If the print of a table is continued on the following page due to lack of space, you can decide whether the 

lines are to be separated or kept together if possible. 

This option is useful for multi-line data lines or for invoice footer lines containing totals. You can use this 

option with data lines, footer lines, group footers and group headers. 

Output Free Content Before and After a Table 

You can output free text before and after a table. To do this, use the RTF object and link the object to the 

project as free text via the report container.  

 

1. To add a new element to the report container, select the Append an element or the Append a sub-

element button in the Report Structure tool window.  

 

2. A selection dialog will appear for the chosen object type. Choose the Table object type.  

 

3. In the following dialog, select Free content as the data source.  

 



Perspective User’s Guide  Custom Reports 

 © Resolver Inc.   Page 284 of 399 

 
 

4. Then add a column via the properties dialog for the table object. In our case, we want to create the 

covering letter as formatted text. Therefore, click the small arrow on the right of the button and 

choose the Formatted Text option.  
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5. A dialog appears where you can type in the covering letter in the form of continuous text. You will 

find detailed instructions for working with formatted text in Chapter Practice: Create a Mail Merge 

Project.  

 

6. Please don't forget to remove the (column) frame for free content. The best way is to remove the 

frame via the Default Frame property in the element properties.  

 

7. You may also have to change the layer condition as the covering letter will now be output on the 

first page.  

 

8. If the General Terms and Conditions are also to be output at the end of the invoice, you must add 

another free content object to the container after the item table. Then you have several options:  

 

a. Use the Formatted Text object here as well.  

 

b. Use the PDF object and include the General Terms and Conditions in PDF format.  

 

c. Use the LoadFile$() function to load a linked file and enter the path of the file as the parameter 

as follows LoadFile$ (ProjectPath$()+\gtc.txt).  

 

d. For the issue on a reverse side, see Reverse Side in Chapter Report Sections.  

Anchored Lines (Overlapping Cells) 

Let us assume that you want to output the contents of a column across two lines. You can achieve this by 

anchoring two lines to each other by the line property Anchor to row (Index (1-based) of the row; 0=no 

anchoring). So the beginning of the next line definition will be forced to the beginning or the end of 

another line definition. Hence the cells can overlap. 

 

Note: This function is not supported by all export formats. 
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Let’s assume that you want to create two lines next to an image column:  

 

1. Define in the first line with 3 columns: Item.No (column width 1), empty content, a space (column 

width 1), Item.Description (column width 3).  

 

2. Define in the second line with 2 columns: empty content, Item.Picture (both column width 1). in the 

line properties set Anchor to Row to 1 to anchor this line with the first line definition.  

 

3. Define the third line also with 2 columns: empty content (column width 2), Item.Description2 

(column width 3).  

 

4. Thus, the second line is printed in the same starting position as the first line and the cells may 

overlap:  
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Expandable Region 

When you activate the property Expandable Region, the sub-elements of an element are not printed into 

the preview at first during printing, and a drop-down symbol will be displayed on the line itself. Clicking 

on the symbol expands the region for the corresponding line, providing a drill-down option without 

having to leave the current preview, and without having to design a separate project. 
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Creating Charts 

This object is used to evaluate and display data graphically in diagrams. This gives you an overview of 

your data and lets you recognize anomalies immediately.  

 

For example, you can analyze sales trends, illustrate percentage shares and show data in multiple 

dimensions. You have a wide range of different types of diagrams at your disposal: 

 

• Circle/Donut chart  

 

• Bar/Ribbon chart (also displayed as cylinders, pyramids, cones, octahedrons)  

 

▪ Simple (e.g., sales per customer)  

 

▪ Multi-row (e.g., sales to various customers over the years, scaled by customer)  

 

▪ Clustered (e.g., sales to various customers over the years, grouped by year)  

 

▪ Stacked (e.g., percentage of sales to various customers stacked over the years)  

 

▪ 100% stacked (e.g., respective sales percentages for various customers over the years)  

 

• Line/Symbol: Simple, Multi-row, Stacked, 100% stacked  

 

• Area: Simple, Stacked, 100% Stacked  

 

• Bubbles/Dots: Distributed, Sorted (Displayed as circle, drop or picture file)  

 

• Funnel/Pipeline  

 

• Map/Shapefile  
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Insert a Chart Object 

There are various ways of outputting chart objects:  

 

1. A chart as an element in the report container. Add the object via the Report Structure tool window. 

If you have not yet added a report container to the workspace, select Insert > Report Container 

(Objects > Insert > Report Container) and pull the object to the right size in the workspace while 

holding down the left mouse button. A selection dialog will appear for the chosen element type. 

Choose the Chart element type.  

 

2. You can output charts and gauges in a table cell. To do this, select the relevant entry by means of 

the context menu in the object dialog for the table. If you want to output the aggregated data, a 

good way of doing this is to use a footer line.  

 

 
 
3. In the following dialog, now select the data source. All available tables are shown hierarchically, in 

other words, under the tables you will find the relational tables in each case.  

To evaluate sales per country, for example, choose the Customers > Orders > Order Details table in 

the Sample Application so that you have all three tables at your disposal. The Customers table 

contains the country, the Orders table the order date and the Order_Details table the sales.  
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4. The chart object dialog is displayed. In the drop down lists in the top left you can select the base 

type and the corresponding sub type.  

 

5. The axes are defined in the tabs (Category Axis, Series Axis, Value Axis, Data Source, Segment, 

Funnel Segment, Shapefile Selection). You can click directly into the live preview (e.g., onto the title 

or axis label) to quickly jump to the corresponding property.  

 

 
 

6. On the Diagram tab, select the general diagram options (e.g., perspective, color mode).  

 

7. On the Object tab, select the general layout options for the entire chart object (e.g., Title, 

Background).  

 

8. On the Colors tab, you can specify the colors for the display:  
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• Design Scheme: Specifies the colors and color sequences for the data rows that are not 

specified by the Fixed Colors. You can select a predefined color set from the drop down list. 

These colors can still be adjusted in the properties.  

 

• Fixed Colors: You can assign fixed colors to particular axis values. If you click the New button, 

you can create a new assignment e.g., Customers.Country = Germany.  

Pie, Donut, or Circle Chart 

Let's assume that you want to evaluate the sales per country. The pie chart is the right choice for this. It 

lets you read off the percentages immediately. Proceed as follows in the Sample Application: 

 

1. As the data source, select the Customers > Orders > Order_Details table.  

 

2. For the diagram type, click Circle/Donut > Pie.  

 

3. You should first specify the coordinate values for the data source, i.e., the values that define the 

individual segments, e.g,. Customers.Country.  

 

 
 

4. Switch to the Segment tab to specify the coordinate values for size of the segment, i.e., the sales. 

Double-click the Coordinate Value property.  

 

Now select the aggregate function that you want for the contents in the Coordinate Value dialog 

that follows. You want to create a sales evaluation so choose the Sum function. 
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5. In the upper part of the dialog, you can specify the contents by clicking the formula button to start 

the formula wizard. In the Sample Application, the sales per order value is not supplied directly as a 

field so you must calculate it using the Order_Details.Quantity * Order_Details.UnitPrice formula.  

 

6. The Label on Object property is already set to Yes so that a label with the percentage value is 

shown on the segments. Define the value as percent without decimal places by means of the 

Format property.  
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7. The Explosion Offset property lets you specify a distance to the center for the segment. With the 

ArcIndex chart field, which numbers the segments according to their size, you can even display the 

largest segment with a greater offset. Example:  

Cond (LL.ChartObject.ArcIndex=1,20,10)  

 

8. On the Diagram tab, select the general diagram options. Various properties are available including:  

 

• The degree of perspective, e.g., strong.  

 

• The color mode, e.g., single color  

 

9. On the Diagram Area tab, select the general layout options for the entire chart object. Various 

properties are available for this including:  

 

• Title  

 

• Background including filling, border and shadow, e.g., border = transparent  

 

10. On the Colors tab, you can specify the colors for the display:  

 

• Design Scheme: Specifies the colors and color sequences for the data rows that are not 

specified by the Fixed Colors. You can select a predefined color set from the drop down list. 

These colors can still be adjusted in the properties.  

 

• Fixed Colors: You can assign fixed colors to particular axis values. If you click the New button, 

you can create a new assignment e.g., Customers.Country = Germany.  

 

11. The pie chart now looks like this: 
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Multi-Row Bar Chart 

Let's assume that you want to evaluate the sales for various countries over the years, scaled by country. 

A multi row bar chart is perfect for this. You get a diagram in which you can see the turnover achieved in 

the respective country for each quarter. Proceed as follows in the Sample Application: 

 

1. As the data source, select the Customers > Orders > Order_Details table.  

 

2. Choose Bar/Ribbon > Multi-Row (3D) as the diagram type.  

 

3. First specify the coordinate value for the category axis, i.e., the value of the x-axis. Select the 

Customers.Country field via the formula wizard.  
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4. Now specify the coordinate value for the series axis, i.e., the value of the y-axis. In the Sample 

Application, the order year is not supplied directly as a field so you must calculate it using the 

Year$(Orders.OrderDate) formula.  

 

If you want to evaluate the data by year, simply enter Year$(Orders.OrderDate) as the coordinate 

value. Type Year as the text for the Axis Label. 

 

 
 

5. Now specify the coordinate values for the value axis (z-axis), i.e., the height of the bars representing 

the turnover. Double-click the Coordinate Value property.  

Now select the aggregate function that you want for the contents in the Coordinate Value dialog 

that follows. You want to create a sales evaluation so choose the Sum function.  

 

6. In the upper part of the dialog, you can specify the contents by clicking the formula button to invoke 

the formula wizard. In the Sample Application, the sales per order value is not supplied directly as a 

field so you must calculate it using the Order_Details.Quantity * Order_Details.UnitPrice formula.  
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7. Various other properties are available on this tab including the following layout options:  

 

• Maximum Value Automatic: You can limit the height of the displayed area, e.g., to cater for 

anomalies.  

 

• Presentation: The data can be presented in various ways: cylinders, bars, pyramids, ribbons, 

octahedrons, cones  

 

• Thickness of the bars  

 

• Zebra mode for the background  

 

8. On the Diagram tab, select the general diagram options. Various properties are available including:  

 

• The Projection, e.g., flat.  

• Color Mode: Specifies which axis determines the color, e.g., the y-axis values.  

 

 
 

9. On the Diagram Area tab, select the general layout options for the entire diagram. Various 

properties are available for this including:  

 

• Title  

 

• Background including filling, border and shadow, e.g., border = transparent  
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10. The multi-row bar chart now looks like this:  

 

 

100% Stacked Bar Chart 

The pie chart in the first example gave you an overview of the percentages for the entire evaluation 

period. But in order to be able to recognize trends, it would be good to see how the percentages have 

changed during the course of the evaluation period. The 100% stacked bar chart can be used for 

precisely these types of applications. The respective percentage of the length of the bars relates directly 

to the turnover percentage of the respective country.  

Proceed as follows in the Sample Application: 

 

1. As the data source, select the Customers > Orders > Order_Details table.  

 

2. Choose Bar/Ribbon > 100% stacked as the diagram type.  

 

3. First specify the coordinate values for the category axis, i.e., the values of the x-axis. Select the 

Customers.Country field via the formula wizard.  

 

4. Now specify the coordinate values for the series axis, i.e., the values of the y-axis. In the Sample 

Application, the order year is not supplied directly as a field so you must calculate it using the 

Year$(Orders.OrderDate) formula.  
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5. Specify the coordinate values for the value axis (z-axis), i.e., calculate the turnover with 

Sum(Order_Details.Quantity * Order_Details.UnitPrice).  

 

6. On the Diagram tab, choose Left to Right for the Alignment to create a horizontal diagram.  

 

7. The multi-row bar chart now looks like this:  

 

 

Multi-Row Line Chart 

A line diagram offers an alternative to a multi-row bar chart. You can read off the values faster here. 
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Proceed as follows in the Sample Application:  

 

1. As the data source, select the Customers > Orders > Order_Details table.  

 

2. Choose Line/Symbol > Multi-Row as the diagram type.  

 

3. First specify the coordinate value for the category axis. Select the Orders.OrderDate field via  

the formula wizard.  

 

4. Select the property Coordinate Label > Format and select %q/%y in the Date-section (user-

defined).  

 

5. Now specify the coordinate value for the series axis. Select the CategoryName field via the formula 

wizard.  

 

6. Specify the coordinate values for the value axis and calculate the turnover with the 

Sum(Order_Details.Quantity * Order_Details.UnitPrice) formula.  

Stacked Area Chart 

The stacked area chart is available as an alternative to the multi row line chart. This chart allows you to 

compare statistical relationships more swiftly as the areas between the lines are colored in. 
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Proceed as follows in the Sample Application:  

 

1. Select the Customers > Orders > Order Details table as the data source.  

 

2. Select Area > Stacked as the chart type  

 

3. First specify the coordinate value for the category axis. Select the CategoryName field via the 

formula wizard.  

 

4. Specify the coordinate values for the series axis. In the Sample Application, the order year is not 

supplied directly as a field, so you must calculate it using the Year$(Orders.OrderDate) formula.  

 

5. Specify the coordinate values for the value axis (z-axis), i.e., calculate the turnover with the 

Sum(Order_Details.Quantity * Order_Details.UnitPrice) formula.  

Distributed Bubble Chart 

Bubble charts allow for a four-dimensional representation of statistics in that, along with the position on 

the y and x axes, the color and the size can be defined by statistical information. Diverse options are 

available regarding how you would like the bubbles to be displayed. 

 
 

Proceed as follows in the Sample Application:  

 



Perspective User’s Guide  Custom Reports 

 © Resolver Inc.   Page 301 of 399 

1. Select the Customers > Orders > Order Details table as the data source.  

 

2. Select Bubbles/Dots > Distributed as the chart type  

 

3. First specify the coordinate value for the category axis. Select the Customers.Country field via the 

formula wizard.  

 

4. Specify the coordinate values for the series axis. In the Sample Application, the order year is not 

supplied directly as a field so you must calculate it using the Year$(Orders.OrderDate formula.  

 

5. Specify the coordinate value for the value axis and the value for the Bubble Size and calculate for 

both the turnover with the Sum(Order_Details.Quantity * Order_Details.UnitPrice) formula.  

 

6. Under this tab you will also find the options for how you would like the bubbles to appear.  

Funnel 

With a funnel or a pipeline, you can e.g., display your sales processes in the various phases. There are a 

variety of options for the way the data is presented.  

 

To do so, proceed as follows:  

 

1. Select the appropriate data source.  

 

2. As the diagram type, select Funnel > Vertical Funnel.  

 

3. First of all, define the coordinate value of the data source, i.e., the value that will define the 

individual funnel segments (the sales phase). 

 

4. Switch to the tab Funnel Segment to define the coordinate value for the size of the funnel segment 

(number of sales opportunities). Double-click on the Coordinate Value property. Now, in the 

subsequent dialog Coordinate Value, select the desired aggregating function Count for the content.  
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5. For the labeling of the funnel segments with percentage values, the option Label on Object has 

already been set to Yes. Then, via the property Format, define the value as Percentage (Without 

Decimal Places) or as Absolute Value.  

 

6. You can enter an offset for the funnel values via the property Explosion Offset.  

 

7. In the Chart tab, select the general diagram options. The following properties are available (among 

others):  

 

• Relative Width of Funnel End/Start.  

 

• Color Mode, e.g., monochrome  

 

8. In the Chart tab, select the general layout options of the entire object. The following properties are 

available (among others):  

 

• Title  

 

• Background incl. filling, border and shadow, e.g., border = transparent  

 

9. In the Colors tab, you can configure the color options.  
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Map/Shapefile 

Shapefiles enable a diverse range of visualization options via a standardized vector description format. 

Via corresponding templates, a wide range of maps, seating charts or floor plans can be generated. The 

Shapefile determines the shape, and an associated attribute database enables the shapes to be 

referenced to the properties (e.g., country names). 

 

Tip: The availability of this chart depends on the application. 

 

  

 
 

To do so, proceed as follows: 
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1. Select the table ClimateData as the data source.  

 

2. As the diagram type, select Map/Shapefile. At this point, a selection dialog appears for the Shapefile 

templates provided with the software. Select World With Seas and Lakes.  

 

 
 

3. You will now see the preconfigured data Shapefile in the tab Shapefile Selection. In addition to the 

data itself, you can also select foreground and background Shapefiles in order to e.g., display the 

oceans in the background and the rivers and lakes in the foreground.  
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4. Click on the Assignment tab in order to link the data with the shapes.  

 

 

 

Link the coordinate value ISO_CODES from the data with the attribute iso_a3 from the Shapefile. 

By doing this, the data that is related to e.g., USA is linked to the outline of USA; the temperature 

from United States of America is linked to United States of America, and so on. 
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5. Go to the tab Value and select the mean temperature as the Value, i.e., the field 

ClimateData.Tmean.  

 

6. Go to the tab Colors to define the legend. As the first entry, define the color via the function 

HeatmapColor(LL.ChartObject.AxisCoordinate,-20,40) and set the condition to True. The value will 

then be used for the actual color fill, and you will obtain a continuous fill color.  

 

7. For the other discrete legend values, enter the corresponding functions, e.g., HeatmapColor(5,-

20,40) with the legend text 5° and set their condition to False. This means that the value will only 

be used for the legend.  

 

 

Use Series to Determine the Values 

With three-axis diagrams, you can also determine the values of the series axis (y-axis) by means of rows. 

This means that you define the different rows (e.g., measured value/target value/actual value) with a 

single data record and can show them parallel e.g., in a bar chart.  

 

As an example, we will create a diagram which shows the currency percentages of the 3 economic areas. 

Data for APAC, EMEA and NAFTA is supplied as rows. 
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Proceed as follows in the Sample Application:  

 

1. Select the Sales table as the data source.  

 

2. Choose Bar/Ribbon > 100% stacked as the diagram type.  

 

3. First specify the coordinate values for the category axis, i.e., the values of the x-axis. Select the 

Sales.Year field with the formula wizard. Remove the 2 decimal places using the 

Str$(Sales.Year,0,0) formula.  

 

4. Now specify the coordinate values for the series axis, i.e., the values of the y-axis. Select the Use 

rows as data source entry from the drop-down list above the properties.  
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This option changes the properties of the series axis and displays a dialog for defining the rows 

when you click the Row Definitions property. Create the individual rows choosing Sales.APAC, 

Sales.EMEA or Sales.NAFTA in each case as the coordinate value. 

 

 

Mixing Chart Types 

You can mix bar charts with line charts. In addition to the ability to display another data series as a line at 

the same time as the bar chart, you may also make use of the calculation options such as moving 



Perspective User’s Guide  Custom Reports 

 © Resolver Inc.   Page 309 of 399 

averages and aggregation options. This will allow you to see total turnover, trends in the data, or outliers 

(both upwards and downwards) at a glance. 

 

 
 

1. Select the table Customers > Orders > Order Details as the data source.  

 

2. As the diagram type, select Bar/Ribbon > Clustered  

 

3. First, define the coordinate value of the category axis. Use the formula assistant to select the field 

Customers.Country.  

 

Now define the coordinate value of the series axis. Use the combo box above the property list to 

select the entry Use series to determine the values. 

 

 
 

By doing this, the properties of the series axes change and a dialog appears for the property Series 

Definitions for the definition of the series. 

 

4. Define a new series Single Turnover and calculate the turnover using the formula 

Sum(Order_Details.Quantity * Order_Details.UnitPrice) with the calculation type normal and display 

type Cylinder.  
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5. Define another series named Mean and calculate the turnover using the formula 

Sum(Order_Details.Quantity * Order_Details.UnitPrice) with the calculation type Average and 

display type Line.  

 

 
 

6. The result is a turnover analysis with a mean line.  
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7. When using the calculation type Line of best fit, a trend line will be displayed:  

 

 

Create a Crosstab 

Crosstabs are used for evaluating and presenting data in multiple dimensions. Crosstabs (or contingency 

tables) are tables containing information about the frequency of the occurrence of combinations of 

certain characteristics.  

 

These frequencies are extended by their marginal totals which form contingencies. With a three-

dimensional crosstab, (three characteristics), the table includes an additional column grouping.  

For example, you can examine turnover trends per year and region, evaluating sales according to 

quantities and customers, and create marginal totals for quarters and years.  

 

A normal (flat) table has the attribute names in the first row and the occurrences of these attributes in all 

other rows. A crosstab is different. The titles of both columns and rows receive characteristic occurrences 

and, at the point of intersection of the respective column and row, a value is shown that depends on the 

characteristics specified for the column and row in each case. 
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For the schematic presentation of two-dimensional crosstabs, the 3D multi-row bar chart is the best 

choice. 

Create a Crosstab Object 

Let's assume that you want to examine the development of turnover per year, quarter and country. 

Proceed as follows in the Sample Application:  

 

1. Crosstabs are elements in the report container. Therefore, you add these objects in the Report 

Structure tool window. If you have not yet added a report container to the workspace, select Insert 

> Report Container (Objects > Insert > Report Container) and pull the object to the right size in the 

workspace while holding down the left mouse button.  

 

2. A selection dialog will appear for the chosen element type. Choose the Crosstab element type.  

 

3. In the following dialog, now select the data source. All available tables are shown hierarchically, in 

other words, under the tables you will find the related tables in each case.  

For our turnover analysis, e.g., choose the Customers > Orders > Order Details table so that you 

have all three tables at your disposal. The Customers table contains the country, the Orders table 

the order date and the Order Details table the turnover.  

 

4. A wizard appears which will lead you through the 3 configuration dialogs for crosstabs.  

Define Groupings 

In the wizard's first dialog, or alternatively on the Axis Definition tab, you first define the grouping for the 

rows and columns, i.e., the characteristics.  
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1. In the Rows pane, click on the Insert a row grouping button.  

 

2. In the formula wizard, you now enter the field or the expression for the row grouping e.g., 

Customers.Country. You have now created a row grouping and the data will be grouped by this 

characteristic.  

 

3. In the Columns pane, click on the Insert a column grouping button.  

 

4. In the formula wizard, you now enter the field or the expression for the column grouping.  

 

5. Since you first want to group the data by year, you must enter an expression here that returns the 

year of the order date. You have the Year() function in the formula wizard at your disposal; i.e., you 

select this function from the list and insert the order date as the parameter by double-clicking. The 

formula looks like this: Year(Orders.OrderDate).  

 

6. Since we also want to examine the data at another level, insert an additional column grouping via 

the Insert a column grouping button.  

 

7. Now enter an expression to return the quarter of the order date. You can use the Quarter() function 

in the formula wizard for this. The formula then looks like this: Quarter(Orders.OrderDate).  

 

Note: You can change the order of the groupings with the arrow button. The column at the bottom is the 

inner grouping.  

 

To swap lines and rows (Pivot function) use the button on the lower right on the Axis Definition tab. This 

button is only available in the object dialog, not in the wizard. 
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8. You have now created the groupings and you can go on to define the value for the intersection of 

the respective columns and rows. Click on the Edit group result formula button located under Value 

of the result cells.  

 

9. Now select the aggregate function that you want for the contents in the Cell Contents dialog that 

appears. You want to create a sales evaluation so choose the Sum function. In the upper part of the 

dialog, you can specify the contents by clicking the formula button to start the formula wizard.  

 

10. In the Sample Application, the sales per order value is not supplied directly as a field so you must 

calculate it using the Sum(Order_Details.Quantity * Order_Details.UnitPrice) formula.  

 

 

Define Cell Properties 

In the wizard's second dialog or, alternatively, on the Cell Definition tab, you edit the properties of the 

different cells.  

 

You can select the cells directly in the drawing in the upper pane of the dialog and then edit their 

properties. To select multiple cells, hold down the CTRL key or you can draw a border around the cells 

with the mouse. 
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1. Let's assume that the countries shouldn't be listed alphabetically but descending by turnover. Select 

the corresponding line header (here: Germany) and select the value Result Descending in the 

property Sort Order then. In combination with the property Limit To you will get a Top-N analysis 

by that.  

 

2. Assuming that you want to prefix the number of the quarter with a Q as the title of a column. Select 

the respective column title and then double-click on the Displayed Contents property.  

 

With this property, you can now specify the text that is to be displayed in this cell (independent of 

the value that you have defined for this column grouping).  

Now define either a suitable formula, e.g., Q + Str$(Quarter(Orders.OrderDate)) in the formula 

wizard  

 

3. Alternatively use the Format property. Then remove the Quarter$() here, i.e., only the date field 

remains in the field, and format the value by means of the property.  
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To do this, click the Formatting property, choose Date as the formatting type, and finally select the User-

defined entry from the drop-down list. At the end of the list you will find an example for formatting a 

quarter plus the number of the year. Since we don't need the number of the year, shorten the formula's 

string to Q%q. 

 

 
 

4. This cell is now formatted and you can go on to format all other cells in the same way. Various 

properties are available including:  

 

• Rotation of the content in increments of 90°  

 

• Background  

 

• Frame  

 

• Font  

 

• Vertical and horizontal alignment  

 



Perspective User’s Guide  Custom Reports 

 © Resolver Inc.   Page 317 of 399 

• Maximum width, minimum width and minimum height  

The Layout Option and Wrapping Behavior 

In the wizard's third dialog or, alternatively, on the Properties tab, you edit the layout properties and 

specify the wrapping behavior.  

 

Various layout properties are available including: 

 

• Background  

 

• Default frame  

 

• Minimum size (%) and minimum height  

 

In addition, as crosstabs are often wider and higher than the specified page format, you can also specify 

the wrapping behavior for columns and rows. It creates as many pages (shadow pages) as necessary. 

The row labels are repeated on all pages as standard while the column labels are not repeated.  

 

Various wrapping properties are available including: 

 

• Repeat Labels: Specifies whether the labels of columns or rows are to be printed again in the case of 

a page break.  

 

• Break Level: Specifies the optimum break level, e.g., 0. This corresponds to the lowest group, i.e., the 

quarter.  

 

• Column > Page Break on Shadow Pages: If the cross table is too wide, the wrapped parts are 

printed on shadow pages. A shadow page does not count as a real page and therefore does not 

have a page number. The default setting specifies that the wrapped parts are to be output below 

the table.  
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Special Functions 

Various additional functions are available in crosstabs including:  

 

• Crosstab.Value() returns the content of the cell (as a value).  

 

• Crosstab.Cells.Avg() returns the average value of the volume of data.  

 

• Crosstab.Col$() or Crosstab.Row$() returns the description of the column or the row for the current 

cell.  

 

With this, you can, for example, assign a particular color to the background of a column or row. The 

following example sets the background color to orange for all cells in a row where the cell 

descriptor is Germany:  

 

Cond(Crosstab.Row$()=Germany,LL.Color.Orange,LL.Color.White) 
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• Crosstab.Cells.Max() or Crosstab.Cells.Min() returns the largest or smallest value in the entire 

crosstab. With this, you can, for example, emphasize the largest or  

smallest value of the volume of data or perform calculations. The following example sets the 

background color of the cell with the largest value to green:  

Cond(Crosstab.Value=Crosstab.Cells.Max(),LL.Color.Green,  

Cond(Crosstab.Row$()=Germany,LL.Color.Orange,LL.Color.White)) 

 

 
 

• Crosstab.Col() or Crosstab.Row() returns the index of the column or the row for the current cell. 

Here, for example, you can set the background color of alternate rows thereby producing a zebra 

pattern. Example: Cond(Odd(Crosstab.Row()),LL.Color.LightGray,LL.Color.White)  

 

 
 

• Join$() returns a collection of strings, separated by a particular character. For example, you can 

output the individual turnover amounts in addition to the total turnover. Example:  
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Fstr$(Sum(Order_Details.Quantity*Order_Details.UnitPrice),-##,###,###) + ¶[+ 

Join$(Fstr$(Sum(Order_Details.Quantity*Order_Details.UnitPrice),-##,###,###))+] 

 

 
 

• You can use Total() for calculations across all cells. Otherwise, calculations are always made across 

all values that affect the respective cell.  
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Gateway 

All new electronically submitted reports flow through the Gateway. It serves as an inbox, where 

designated Gateway Administrators and Gateway Approvers assess each electronic report before 

accepting it into Perspective or deleting it from the system.  

 

Electronic reports in the Gateway can be submitted from a number of sources. If your organization uses 

Perspective e-Reporting or Portal, Incident reports may be submitted from a workgroup’s e-Reporting 

Web page. Otherwise, Incident, Item, Person, Organization, and Vehicle reports may be imported using 

Perspective’s built-in Import Manager. Imports may originate from a computer, Web site, PDA, mobile 

phone, or any electronic medium that enables creation and transfer of files in XML format.  

 

Once the Gateway Administrator and Gateway Approver have been granted appropriate user rights by 

the System Administrator, they will have access to the Gateway and the electronic reports stored in it. 

Their respective roles involve the authority to review these reports and perform their associated 

functions. 

 

Gateway Administrator and Gateway Approver both can: 

Edit Incident reports (or e-Incidents). 

View imported Item, Person, Organization, or Vehicle reports. 

Make the imported reports available for authorized users to add to the Perspective database. 

Delete the imported reports from the system. 

Only Gateway Administrator can: Only Gateway Approver can: 

Assign e-Incidents to the Gateway Approver 

for follow-up.  

Accept e-Incidents into Perspective as valid 

incidents. 
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User Interface 

The Gateway interface is divided into three sections: 

 

1. Navigation pane: Allows you to move between various types of Gateway electronic reports 

corresponding to the major Data Forms (i.e., Incidents, Items, Persons, Organizations, and Vehicles). 

To display folders containing reports for a particular Gateway report type (i.e., New, Assigned, 

Accepted, Pending, Rejected, and Deleted for Incidents; and New, Available, Added, and Deleted 

for Items, Persons, Organizations, and Vehicles), choose the required banner from the Navigation 

pane. Click on a folder in the Navigation pane to see all the reports contained within it listed in the 

Listing pane. If more than one workgroup’s electronic reports are contained in the folder, subfolders 

for the appropriate workgroups will be listed beneath the folder name in the Navigation pane. 

Expand the All Workgroups subfolder and select a workgroup to see only its particular reports in 

the Listing pane.  

 

2. Listing pane: Provides a list of electronic reports selected in the Navigation pane for viewing. On 

the right side of every report entry the system records a corresponding source of a report’s import 

(e.g., e-Reporting). Once you select an e-Report in the Listing pane, the report’s contents will be 

displayed in the Viewing pane on the right. (For Incident e-Reports, the submitted XML data is 

saved under the Attachments tab.) 

 

3. Viewing pane: Displays the contents of an e-Report selected in the Listing pane and provides 

options for saving, editing, assigning, deleting, accepting, rejecting, and closing individual reports, 

as well as transferring them into Available or Pending modes and viewing their XML versions. Every 

Incident report consists of a set of tabs (i.e., General, Involvements, Narratives, Attachments, 

Delete e-Incidents from the system. 
Send e-Incidents back to the Gateway Administrator 

for reassignment. 

 

Store e-Incidents in a Pending folder for review at a 

later date, if they contain insufficient information to 

accept or reject them. 
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Controls, and Audit History), while data for every Item, Person, Organization, and Vehicle report is 

provided on one simple form. 

 

 
 

Note: If a folder in the Navigation pane contains more than 1000 e-Reports, you must first filter the 

report list before viewing it in the Listing pane. Once you click on the folder in the Navigation pane, a 

pop-up window will appear allowing you to filter the e-Incident list.  

 

To display the top 1000 e-Reports (based on the reports’ identification numbers), click Start Search. 

Click OK to transfer the list to the Listing pane. 

 

To search for a particular e-Report or a set of e-Reports, set specific filtering criteria: 

 

1. In the Field Name lookup list, select the field that you want to set as the main criterion for 

narrowing your e-Report list.  

 

2. Choose an Operator for the field (e.g., Equal, Not Equal, After, Begins With, Like, etc.). 
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3. Enter the compared criterion Value. If the Selector button  is available, click it to display a tree of 

Value options in a separate window. Note that you may choose any node of the tree as the defining 

criterion, making your comparison value as narrow hierarchically as you want.  

 

4. If you want to include a second field as an additional filtering criterion, select the And or Or radio 

buttons and complete the Field Name, Operator and Value fields below. You may add as many 

filtering criteria as you want. To remove a field from your filtering criteria, click the Delete button  

 

5. By default, only the top 1000 reports matching the criteria that you set will be displayed. To display 

more or less, adjust the number in the Top field (from 1 to 2000). 

 

6. Click Start Search to generate a list of reports matching your filtering criteria. A count of the 

number of e-Reports in the list, as well as the total number of e-Reports matching your filtering 

criteria, will be displayed at the bottom of the window. 

 

7. To make changes to the ongoing search, click Stop Search first, and then make the necessary 

changes to the filtering criteria. 

 

8. When you are satisfied with the list of e-Reports displayed, click OK to transfer the list to the 

Listing pane in the Gateway. 

 

 

Incidents 
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Under the Incidents banner, the following folders will be displayed: 

 

• New: New e-Incidents that have not yet been assessed. 

 

• Assigned: e-Incidents assessed and assigned to a Gateway Approver for follow-up. 

 

• Accepted: e-Incidents that have been accepted into Perspective as valid Incident records by the 

Gateway Approver assigned to them (the only e-Incidents not available for editing). 

 

• Pending: e-Incidents that require further information before being assigned or deleted. 

 

• Rejected: e-Incidents that have been returned to the Gateway Administrator by the Gateway 

Approver. 

 

• Deleted: e-Incidents that have been marked for deletion upon purge. These can be re-assigned by 

the Gateway Administrator before the purge occurs. 

 

Note: Not all folders will be visible to the Gateway Approver. 

After selecting an e-Report in the Incidents Listing pane of the New folder, you can use the buttons 

available on the Viewing pane toolbar to perform a number of report functions. 

 

Common functions available for both Gateway Administrator and Gateway Approver: 

 Save  Preserves the changes you made to an e-Report. 

 Edit Transfers an editable e-Report into the editing mode.  

After clicking Edit, select the field you want to edit and make the necessary change. 

Editing of e-Reports functions similarly to the data entry in Incidents data forms, 

including the use of a similar set of sub-tabbed toolbar functions, like Edit, Add New, 

Remove and Read/View. Remember to complete every report editing action with 

saving the changes applied to the report by clicking Save on the Viewing pane 

toolbar. 
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Note: For further details on the sections of the e-Incident report and functions 

performed by the toolbar functions that are available for certain sub-tabs (i.e., 

Involved Persons, Organizations, Vehicles, and Items), see the Incidents and 

Common Record Functions chapters. 

Note: The only editing function that is exclusively under the authority of the Gateway 

Administrator is setting of the e-Incident’s security controls in the Controls tab 

(access level, organizational rollup and workgroup visibility). Although the e-Incident 

will have some default security controls, the Gateway Administrator may choose to 

re-set these in order to restrict both the Gateway Approver the e-Incident is 

assigned to (the Approver’s access rights must match those of the e-Incident in order 

to assess it), as well as users who have access to the record within Perspective if it is 

accepted as a valid Incident record. 

 Close Exits the e-Report without saving changes. 

 

Functions available for Gateway Administrator only: 

 Assign 
Assigns the e-Incident to the Gateway Approver for further review by transferring 

the e-Incident to the Assigned folder.  

 

Once you click the Assign button, a pop-up confirmation window will appear. Make 

any necessary notes on the assignment of this e-Incident in the Comments text box. 

Your notes will appear in the Reviews section of the e-Incident under the General 

tab. Click Assign to confirm your choice. 

 

Note: The Gateway Approver’s access rights must match those designated under 

the e-Incident’s Controls tab. 

 Delete 
Deletes an e-Incident as an invalid submission by transferring the e-Incident to the 

Deleted folder. 

 

Once you click the Delete button, a pop-up confirmation window will appear. Make 

any necessary notes on the deletion of this e-Incident in the Comments text box. 
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Your notes will appear in the Reviews section of the e-Incident under the General 

tab. Click Delete to confirm your choice. 

 

Note: e-Incident can be recovered anytime prior to the end of Deleted Retention 

Period specified for the e-Incident’s workgroup by the System Administrator. 

 

Functions available for Gateway Approver only: 

 Accept Accepts an e-Incident into Perspective as a valid Incident record, by transferring it to 

the Accepted folder. The accepted e-Incident will be available to users whose access 

rights match those designated under the e-Incident’s Controls tab. 

 

Once you click the Accept button, a pop-up confirmation window will appear. Make 

any necessary notes on the acceptance of this e-Incident in the Comments text box. 

Your notes will appear in the Reviews section of the e-Incident under the General 

tab. Click Accept to confirm your choice.  

 

A dialog box will appear displaying the e-Incident’s new Perspective Incident 

Number. For cross-referencing purposes, both the original e-Incident Number (e.g., 

INC-2010-000269) and the new Incident Number (e.g., EINC-2010-12-00001) will 

appear under the Record Information in the General tab of both the e-Incident record 

and the actual Incident data form. Click OK. 

 

Note: The accepted e-Incident will be purged from the Gateway at the end of the 

Accepted Retention Period specified for the e-Incident’s workgroup by the System 

Administrator. The original e-Incident form will remain in Perspective as an 

attachment to the newly created Perspective Incident record. 
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 Reject Sends an e-Incident back to the Gateway Administrator for further review by 

transferring it to the Rejected folder, so that it could be re-assigned or deleted.  

 

Once you click the Reject button, a pop-up confirmation window will appear. Make 

any necessary notes on the rejection of this e-Incident in the Comments text box. 

Your notes will appear in the Reviews section of the e-Incident under the General 

tab. Click Reject to confirm your choice.  

To evaluate the reasons for the e-Incident’s rejection by the Gateway Approver, edit 

the e-Incident, and/or delete or assign it again, the Gateway Administrator hat to 

access the rejected e-Incident from the Rejected folder. 

 Pending Sets an e-Incident to Pending status, by storing it in the Pending folder. This 

function is used when there is insufficient information to accept or reject the e-

Incident, and the Gateway Approver intends to make its review at a later date. 

Once you click the Pending button, a pop-up confirmation window will appear. Make 

any necessary notes on the pending of this e-Incident in the Comments text box. 

Your notes will appear in the Reviews section of the e-Incident under the General 

tab. Click Pend to confirm your choice. 

 

When an incident is submitted using e-Reporting or Portal, you must manually link the name of the driver 

(Vehicles), supervisor (Incident General), notified by person (Organizations), or the owner, person, or 

organization (Items), in Gateway. This is done by clicking the plus icon .  

 

Then, select the corresponding record from the pick list. If a record does not already exist, use the Quick 

Add function to create one. 

 

Note: If this is not done before acceptance to Perspective, the information will not get transferred into 

Perspective. 
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Items, Persons, Organizations and Vehicles 

Note: Item, Person, Organization, and Vehicle reports can only be imported to the Gateway using the 

Import Manager. 

 

To view imported Item, Person, Organization, or Vehicle reports, click on the appropriate banner in the 

Navigation pane. The following folders will be displayed: 

 

• New: New imported reports that have not yet been assessed. 

 

• Available: Imported reports that have been deemed valid, and made available for authorized users 

to add to the Perspective database. 

 

• Added: Imported reports that were first made available within Perspective, and then added by 

authorized users to the database as valid Item, Person, Organization, or Vehicle records. 

 

• Deleted: Imported reports that have been marked for deletion upon purge. These can be made 

available for adding to the database before the purge occurs. 
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After selecting an e-Report in the appropriate Listing pane of the New folder, you can use the buttons 

available on the Viewing pane toolbar to perform the three basic report functions that are available for 

both the Gateway Administrator and the Gateway Approver. 

 

 Available Makes a report available for authorized users to add to the Perspective database, 

while transferring it to the Available folder. If an authorized user chooses to add a 

new record to one of the Data Forms components, the data in the added report will 

be displayed as available for adding. Simultaneously, the report will be moved from 

the Available folder to the Added folder.  

At the end of the Added Retention Period specified for the report’s workgroup by 

the System Administrator, the imported report will be purged from the Gateway. 

However, the original XML report will remain in Perspective as an attachment to 

the newly created Perspective Item, Person, Organization, or Vehicle record. 

 Delete Deletes a report from the Gateway as invalid. 

Once you click the Delete button, a pop-up confirmation window will appear. 

Choose the Mark As Delete radio button to store the imported report in the 

Deleted folder, where it can be recovered at any time prior to the end of the 

Deleted Retention Period specified for the report’s workgroup by the System 

Administrator. Otherwise, choose the Immediate Delete radio button to 

permanently delete the report. Click Delete to confirm your choice. 

 XML View Displays the imported report in its original XML format including hidden data, if 

available. Click the XML View button again to return to the standard view. 
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DispatchLog and Dispatch 

For more information on DispatchLog, the built-in Perspective dispatch component, see the Perspective 

DispatchLog User’s Guide on the Resolver Support site. 

 

For more information on Dispatch, the separately managed application, see the Dispatch User’s Guide 

and Dispatch Administrator’s Guide.

  

https://support.resolver.com/hc/en-ca/sections/201705483-Documentation
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Visual Analysis 

Welcome to Perspective Visual Analysis™, an optional component of Perspective by Resolver. 

Perspective not only records and tracks incident data, but assesses and analyzes it to chart trends and 

report statistics. Visual Analysis complements Perspective by enabling it to render data relationships into 

powerful visual elements. 

The resulting visual data can be easily analyzed and interpreted, bringing clarity to complex 

investigations and scenarios. Seemingly unrelated events are mapped, and new connections are found. 

Perspective Visual Analysis significantly increases the productivity of your investigators saving time and 

resources along the way.  

Use Visual Analysis to Build a Link Chart 

Using dynamic link analysis, Perspective Visual Analysis reveals the complex, and seemingly disparate, 

associations hidden amidst hundreds, even thousands, of incidents, cases, items, persons, organizations 

and vehicles.  

 

The complex relationships that exist between your data are mapped in easy-to-read link charts. You can 

zero in on specific information, or keep expanding the web until all avenues have been explored. To save, 

print, or copy your link charts, transfer them into IBM i2 ChartReader and continue to view the 

associations in your Perspective data. 

 

Perspective Visual Analysis was developed in an exclusive partnership between Resolver and IBM i2—

the world’s leading provider of Visual Investigative Analysis software for law enforcement, intelligence, 

military, and Fortune 500 organizations. All of the visualizations created in Perspective Visual Analysis 

can be carried into IBM i2 applications, including Analyst’s Notebook. From there, you can connect to 

other databases in your organization for advanced analysis and in-depth visual analytics. 

 

For more information on IBM i2 products, or to download i2 ChartReader, visit the following links: 
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• Short link:  

http://ibm.co/W8rK1l. 

 

• Long link: 

http://www14.software.ibm.com/webapp/download/nochargesearch.jsp?S_TACT=&S_CMP=&s=&k=

ALL&pid=&q=Chart+Reader+&ibm-search=Search&pf=&b=&q0=. 

Access Visual Analysis 

1. Log on to Perspective. 

 

2. In the Navigation pane, open the Data Forms component and choose the record entity that you 

want to view (i.e., Activities, Incidents, Cases, Items, Persons, Organizations, or Vehicles).  

 

3. Set your record view for the Listing pane using the Quick View, Saved Views, or All Records View 

function. If your Perspective system contains a large number of records, it is recommended that you 

use the Quick View or Saved Views function. 

 

4. In the Listing pane, find and select the record you want to build your link chart from.   

 

5. Click the Visual Analysis icon  on the Ribbon. A separate window for Perspective Visual 

Analysis will open with the selected record displayed as an icon in the center. 

Create a Link Chart 

1. Right-click the icon in the center of the Visual Analysis window, and select Show Relationships. 

 

http://ibm.co/W8rK1l
http://www14.software.ibm.com/webapp/download/nochargesearch.jsp?S_TACT=&S_CMP=&s=&k=ALL&pid=&q=Chart+Reader+&ibm-search=Search&pf=&b=&q0=
http://www14.software.ibm.com/webapp/download/nochargesearch.jsp?S_TACT=&S_CMP=&s=&k=ALL&pid=&q=Chart+Reader+&ibm-search=Search&pf=&b=&q0=
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2. A link chart of related records will appear in the window, with the original record at the center. 

Right-click any icon in the link chart, and then select one of the following options: 

 

• Invert Selection: Selects all records except the current one. 

 

• Show Relationships: Displays all Incident, Case, Item, Person, Organization, or Vehicle records 

linked to the selected record. 

 

• Show Record: Opens the selected record in Perspective. (The Visual Analysis window may still 

be open in the foreground. In this case, minimize the Visual Analysis window to view the record 

in Perspective.)  
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3. Click on the top toolbar options to customize the appearance of your chart for clear visual analysis, 

or to find, select, or remove a particular record from your chart: 

 

 

Print on Single 

Page 

Prints all details of your chart on a single page. 

 

Print at 100% 

Scale 

Prints your chart at 100% scale, which would usually occupy more 

than one page. 

 

Page Setup Enables you to adjust margins and page setup settings before printing. 

 

Delete 

Selection 

Removes the highlighted record(s) from the chart. 

 

Undo Delete Brings back the record(s) that were just deleted. 

 

Key Entity 

Emphasis 

Enlarges the central records in your link chart placing focus back on 

them. Click again to restore the central records to regular size. 

 

Panning Tool 
Enables dragging of the entire link chart allowing you to quickly view 

different areas of the chart. 
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Zoom to Area 

Click the Zoom to Area button, and then click and drag on the chart to 

select an area with the help of the mobile zoom box. The window will 

fill with an enlarged display of the selected area. 

 

Fit to Window 
Fits the entire link chart in the window, making it easier to see the 

overall shape and the number of connections in the chart. 

 

Fit Selection 

to Window 

Click and drag on the chart to select an area of interest with the help of 

a box. Alternatively, select multiple records holding down the Ctrl key 

while clicking the record icons. Then, click the Fit Selection to Window 

button. The window will fill with all records that are currently selected 

in the link chart.  

 

Select All Selects all the records in the link chart. 

 

Reorganize 
Changes the arrangement of the record icons restoring the link chart to 

its original layout. 
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Find 

Searches for a chart entity and/or link that contains a particular string 

of text. The Find function only searches the text displayed in the 

window; it does not search actual records. Once you click the Find 

button, the Find dialog will open.  

a. Type the search text in the Find Text field.  

b. Choose to search Entities (e.g., incident numbers, person names, 

license plate numbers), Links (e.g., suspects, associates, subjects of 

interest), or Both.  

c. Select Exact Match to only search for text that matches the search 

string precisely.  

d. To execute your search, click OK. The window will select and zoom 

in on any entities and/or links matching your search criteria. 

 

 

Zoom 
Click and drag the slider back and forth to zoom the window in and 

out. 

 

4. Click the buttons on the right toolbar to hide particular entities from your link chart. By default, 

these entities are displayed in your link chart. Click again to restore the original link chart layout 

and/or to re-display the entities. 

 

 

Case Hides cases from your link chart.  

 

Incident Hides incidents from your link chart. 

 

Activity Hides activities from your link chart. 

 

Item Hides items from your link chart.  
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Organization Hides organizations from your link chart. 

 

Person Hides persons from your link chart.  

 

Vehicle Hides vehicles from your link chart. 

 

Involvements 

Hides involvements from your link chart. Involvements, represented 

by red connecting lines, show that an item, organization, person, or 

vehicle was involved in a particular incident (e.g., Suspect, 

Responding Service, Indirectly Involved). 

 

Associations 

Hides associations from your link chart. Associations, represented 

by black connecting lines, show that particular incidents, cases, 

items, organizations, persons, or vehicles are associated with each 

other by relationship or ownership (e.g., Alias, Contracted To/By, 

Similar M.O.).  

 

Timeline 

Transfers your link chart into the timeline mode (see the image 

below). All entities and links will be reorganized sequentially, 

allowing for time series analysis. 

Use IBM i2 ChartReader to Manipulate Your Link Chart 

After using Perspective Visual Analysis to build and develop your link chart—customizing its appearance 

to suit your needs—you can use IBM i2 ChartReader to share your chart with other people in your 

organization, or at the very least, to save or print your chart for access at a later date.  

 

If ChartReader is not already installed on your computer, you can download the product from the IBM i2 

website: 

 

• Short link:  

http://ibm.co/W8rK1l. 

 

http://ibm.co/W8rK1l
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• Long link: 

http://www14.software.ibm.com/webapp/download/nochargesearch.jsp?S_TACT=&S_CMP=&s=&k=

ALL&pid=&q=Chart+Reader+&ibm-search=Search&pf=&b=&q0=. 

 

ChartReader offers many of the same navigation functions as Visual Analysis, allowing you to zoom in 

and out on particular areas of your chart, resize your chart to fit your screen, and search for information 

contained within your chart. However, ChartReader does not have any editing functionality. You cannot 

add, eliminate, or reorganize chart items, and you cannot access any of your Perspective data to 

supplement your chart. 

 

Ensure that your chart is complete when you transfer it into ChartReader, and then simply use 

ChartReader to do the following: 

 

• Save your chart for later access. 

 

• Print your chart using a variety of page configuration and printing options. 

 

• Copy and paste your chart into Windows® applications, including Microsoft® Word, PowerPoint®, 

and Excel®, for inclusion in reports and other documents. 

 

In other words, use Perspective Visual Analysis to create and develop your visual research, and then 

employ ChartReader to document it and distribute it to others. 

Transfer Your Link Chart into IBM i2 ChartReader 

1. Launch ChartReader.  

 

2. Using the record selection options described in the Create a Link Chart chapter, select the chart 

items you would like to transfer into ChartReader. 

 

3. Drag and drop the link chart selection into the ChartReader blank window. 

 

http://www14.software.ibm.com/webapp/download/nochargesearch.jsp?S_TACT=&S_CMP=&s=&k=ALL&pid=&q=Chart+Reader+&ibm-search=Search&pf=&b=&q0=
http://www14.software.ibm.com/webapp/download/nochargesearch.jsp?S_TACT=&S_CMP=&s=&k=ALL&pid=&q=Chart+Reader+&ibm-search=Search&pf=&b=&q0=
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4. A status bar will appear, indicating that ChartReader is in the process of transferring your link chart. 

ChartReader uses another IBM i2 product, Online iLink, to retrieve data from online sources. When 

the bar disappears, your link chart will appear in the ChartReader window. There may be some 

differences in the icons used to represent the chart’s entities. 

 

5. Open the ChartReader’s Help menu to learn how to save, copy, and print your chart, as well as how 

to perform other relevant charting functions. 

Additional IBM i2 ChartReader Resources 

In addition to the online Help provided in ChartReader, the following documents are included with 

ChartReader’s download in PDF format:  

 

• Embedding in a Web Page: Contains instructions for embedding charts into Web pages. 

 

• User Guide: Provides detailed information about working with ChartReader.  

 

• Release Notes: Includes information on ChartReader’s latest features and updates. 
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• i2 Online iLink Release Notes: Supplies details on Online iLink’s most recent release. Online iLink is 

the program used to transfer data from Perspective Visual Analysis to ChartReader. 

 

For more information on IBM i2 and its products, visit the links below: 

 

• Short link:  

http://ibm.co/W8rK1l. 

 

• Long link: 

http://www14.software.ibm.com/webapp/download/nochargesearch.jsp?S_TACT=&S_CMP=&s=&k=

ALL&pid=&q=Chart+Reader+&ibm-search=Search&pf=&b=&q0=. 

 

  

http://ibm.co/W8rK1l
http://www14.software.ibm.com/webapp/download/nochargesearch.jsp?S_TACT=&S_CMP=&s=&k=ALL&pid=&q=Chart+Reader+&ibm-search=Search&pf=&b=&q0=
http://www14.software.ibm.com/webapp/download/nochargesearch.jsp?S_TACT=&S_CMP=&s=&k=ALL&pid=&q=Chart+Reader+&ibm-search=Search&pf=&b=&q0=
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Appendix A: Dashboard Chart Types 

The Dashboard component of Perspective can be populated with up to four charts that show trends and 

statistics for a selected portion of records found in Perspective’s database for a specified period of time. 

The data you may select for display include the following chart types. 

 

Incident by Class 

Displays the number of incidents by the specified number of 

incident classes (e.g., Criminal, Procedural, Policy Violation) that 

have taken place during the specified period of time. 

Incident by Business 

Unit 

Displays the number of incidents by the specified number of 

business units (e.g., North America, Europe, Asia) that have taken 

place during the specified period of time.  

Incident by Site 

Displays the number of incidents by the specified number of sites 

(e.g., Alberta, Ontario, British Columbia) that have taken place 

during the specified period of time.  

Incident by 

Organization 

Displays the number of incidents by the specified number of 

organizations (e.g., Edmonton, Leduc, Sherwood Park) that have 

taken place during the specified period of time.  
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Activities by Number of 

Days Open 

Displays the number of activities with an Open status arranged by 

the set periods of time for which the Activity records have been 

open (e.g., >14-29 days, >30-59 days).  

Cases by Number of 

Days Open 

Displays the number of cases without a Closed Date/Time 

arranged by the set periods of time for which the Case records 

have been open. 

Incidents by Number of 

Days Open 

Displays the number of incidents with an Open status arranged by 

the set periods of time for which the Incident records have been 

open. 

Investigations by 

Number of Days Open 

Displays the number of investigations without a Closed Date/Time 

arranged by the set periods of time for which the investigations 

have been open. 

 

When one of these charts is displayed on the Dashboard, you may choose to view the 

Activity/Case/Incident/Investigation data filtered for a specific user. To filter the Activity data 

for a Record Owner, the Case, the Incident data for a Case Investigator/Case Manager/Case 

Supervisor, or the Investigation data for an Investigator, click on the plus icon  in the chart 

section and select the required user from the entity list. To reset the filter and show the data 

that applies to all users in the system, click the x icon . 
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Activities by Month 

Displays the number of the specified portion of activities that have 

been recorded in each of the twelve months of the selected year. If 

no data has been recorded for a specific month, it will be absent 

from the chart. 

Incidents by Month 

Displays the number of the specified portion of incidents that have 

been recorded in each of the twelve months of the selected year. If 

no data has been recorded for a specific month, it will be absent 

from the chart. 

Investigations by Month 

Displays the number of the specified portion of investigations that 

have been recorded in each of the twelve months of the selected 

year. If no data has been recorded for a specific month, it will be 

absent from the chart. 
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Cases by Month 

Displays the number of the specified portion of cases that have 

been recorded in each of the twelve months of the selected year. If 

no data has been recorded for a specific month, it will be absent 

from the chart. 

 

Loss by Month 

Shows the monetary losses (Total Loss, Total Recovered, and Net 

Loss), in dollars, resulting from the selected portion of incident 

activity in each of the past twelve months of the specified year. 

This chart is only available in the bar chart form. 

 

Open Activities by 

Disposition 

This preset chart does not have any further chart settings and is 

only available in the bar chart form. It displays the number of 

activities with an Open status colour-coded for specific Disposition 

(e.g., Under Investigation) and arranged by the set periods of time 
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for which the Activity records have been open (e.g., >14-29 days, 

>30-59 days). 

Open Incidents by 

Disposition 

This preset chart does not have any further chart settings and is 

only available in the bar chart form. It displays the number of 

incidents with an Open status colour-coded for specific 

Disposition (e.g., Unsolved) and arranged by the set periods of 

time for which the Incident records have been open. 

Open Cases by 

Disposition 

This preset chart does not have any further chart settings and is 

only available in the bar chart form. It displays the number of cases 

without a Closed Date/Time colour-coded for specific Disposition 

(e.g., Active) and arranged by the set periods of time for which the 

Case records have been open. 

When one of these charts is displayed on the Dashboard, you may choose to view the 

Activity/Case/Incident data filtered for a specific user. To filter the Activity data for a Record 

Owner, or the Case or Incident data for a Case Investigator/Case Manager/Case Supervisor, 

click on the plus icon  in the chart section and select the required user from the entity list. 

To reset the filter and show the data that applies to all users in the system, click the x icon . 

 

Open Assignments by 

Due Date 

Displays the number of assignments that have not been checked 

off as Completed arranged by their closeness to the Due Date 

(e.g., Overdue, Tomorrow, Others). 



Perspective User’s Guide  Appendix A: Dashboard Chart Types 

 © Resolver Inc.   Page 347 of 399 

Open Assignments by 

Type 

Displays the number of assignments that have not been checked 

off as Completed arranged by specific assignment Type (e.g., 

Correction Notice, Information Request). 

 

When one of these charts is displayed on the Dashboard, you may choose to view the 

Incident, Case, and Activity assignment data that have been filtered for a specific recipient of 

assignments. To filter the data for a specific Assigned To user, click on the plus icon  in the 

chart section and select the required user from the entity list. To reset the filter and show the 

data that applies to all users in the system, click the x icon . 
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Perspective Gauge 

Resembles an automobile speedometer gauge, displaying the 

proportion of the number of incidents that has been recorded for 

the current year to the number of incidents that had been recorded 

in the year of your selection effectively comparing the two values. 

You can change the compared to year using the chart’s attached 

lookup.  

The Total Year diagram compares the number of incidents for the 

total calendar years (e.g., the periods of January 1 to December 

31).  

The Year to Date diagram compares the number of incidents for 

the years to the current date (e.g., if today’s date is October 1, then 

it will compare the periods of January 1 to October 1 only).  

The This Month diagram compares the number of incidents for the 

current month (e.g., if today is October, then it will compare the 

months of October only).  
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Appendix B: Text Editor Navigation 

In Perspective, there are four types of text editor windows: Narrative Editor, Summary Editor, Interview 

Editor, and Send Message. The corresponding editors enable entering and editing of (typically) large 

texts that convey incident or case narratives, investigation summaries and interviews, and descriptive 

email messages. Typing the content of a narrative, summary, interview, or email, you can format your text 

with any of the options available under the editor’s tabs (e.g., Narrative, Import/Export, Tools, and 

Spelling). 

 

 

Narrative/Summary/Interview tab 

 

Click Accept & Return to save the changes made to the document 

and return to the main screen of the entry. If you want to discard the 

changes made, click Cancel & Return. 
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Edit position of parts of the entered text by selecting the portion of the 

text and applying the Cut, Copy, or Paste options. The Undo and 

Redo buttons toggle the changes you have made to the document. 

 

Format appearance of the text by making it bold, italic, or underlined. 

Clear the formatting as needed. Apply the centered, left, right, or 

justified text alignment. 

 

Choose the text highlight and font color. Toggle document views, 

choosing between the Normal, Page Style, or Float (default) view.  

 

The Sealed option is available in the Narrative, Summary, and 

Interview Editors only. It functions similarly to the Seal/Unseal button 

 in the Viewing pane, by which clicking on it removes/assigns 

editing rights from/to the text.  

Note: Once you seal the text, and then save and leave the 

corresponding record, it can never be unsealed. 

Import/Export tab 

 

Alternatively to entering the text yourself, you may choose to Import 

an existing text document and its formatting into your text field. When 

finished with editing the text, you may also Export the text as an 

autonomous text document in multiple text formats. 

Tools tab 

 

To enhance the content of your text, you can insert tables, images, 

and hyperlinks. To display editing options of the default table frame, 

select the portion of the table you want to edit and click the Insert 

Table button again. 
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To edit the structure of your text, use the various Paragraph and Tab 

Format options. To format the font of your text and edit available text 

styles, use the Font Dialog and Style Format dialogs. Some of the 

most important text editing functions (e.g., text font, size, style, 

numbering, tabbing, visibility of formatting symbols) are also 

accessible directly from the autonomous toolbar that is located above 

the text field and that is not a part of any one particular tab. 

 

If you want to print your document, click the Print button. To preview 

the document before printing, click Print Preview. 

Spelling tab 

 

Although the spell check option is automatically applied to the text 

you enter (the incorrect text is underlined with a red wavy line), you 

can correct each spelling error one by one using the Spelling dialog 

box. 

Additional Send Message options 

The Send Message editor provides very basic options for editing a short email message that are all 

collected under one Mail tab. Typically, this message serves the purpose of providing some description to 

an automatically generated attachment that is sent out with the email (e.g., a record view or an 

assignment). In this case, the descriptive text will be provided by the system. If you want, you may, 

however, edit the default text for it to correspond to the document requirements set at your organization. 

 

 

To add an attachment to your email or view it, click Attachments. A 

window will appear where you can add or remove existing 

attachments. Click Proceed to return to the main message screen. To 

set a priority for the message you are sending, click Priority and 

select from the High, Normal (default), and Low priority option. 

When finished with editing of your email message, click Send. 
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If you want to format the message details in plain text rather than the 

default HTML table, unclick the Format button. By default, the 

formatting option is active. 
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Appendix C: Data Field Types 

Yes/No Fields 

Yes/No fields include both checkboxes  and radio buttons . Click a checkbox or radio button to select 

it. Once selected, checkboxes will contain a checkmark and radio buttons will contain a dot. 

Date/Time Fields 

 
 

To enter a date in a Date/Time field, you have the following three options:  

 

• Manually type the date in the field in MM/DD/YYYY format. Place your cursor in the month section 

and type two digits for the month, two for the day, and four for the year, using leading zeros if 

necessary. Specify the time in TT:TT format adding AM or PM, if relevant. 

 

• Place your cursor anywhere in the date or time field and click on the up and down arrows attached 

to the field to increase or decrease the time value accordingly. 

 

• Choose the appropriate date from the field’s built-in calendar. 

 

To display the field’s calendar, click the calendar icon to the right of the Date/Time field. The calendar will 

open on the current month and year with the current day highlighted. Use the adjacent scrolling arrows 

to adjust time, month, or year.  

 

If you are running Windows XP or Windows Vista, you may quickly advance the calendar to a different 

month or year. Click the appropriate time label to display a list of all the months in the year (or years) in a 

decade. Select the desired month or year to advance to the next level of time hierarchy (i.e., day or 

month).  
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After selecting a date, the calendar will close and the Date/Time field will automatically populate with the 

selected date, while the time portion will display 12:00 AM (or 00:00, depending on your machine’s 

regional settings). 

 

Note that at any time, you may select the current date by clicking the date marked Today at the bottom 

of the calendar, or by right-clicking the calendar and selecting Go to today.  

To clear the field of all values, click the Remove button  to the right of the Calendar icon. 

Lookup List Fields 

 
 

To display all options contained within a lookup list, simply click the down arrow beside the lookup field 

or use the keyboard shortcut Alt+↓.  

 

For more efficient data entry, you may automatically narrow focus in any lookup list to values beginning 

with the letters that you type. Simply start typing the value appropriate for the lookup field to display a 

lookup list containing only those values that begin with the letter(s) that you have typed. 

 

 
 

If you are changing a lookup field value, you may hit the Esc key at any time to populate the field with the 

value that was saved previously.  

 

Note: If the lookup field is part of a hierarchy, any unsaved field values lower in the hierarchy may be 

erased. 
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Number Fields  

 
 

Perspective includes number fields for both whole numbers and numbers with up to two decimal places, 

as well as special fields configured for height, weight, value, and year data. 

 

In any of these fields, you may type the desired value directly in the field. If up and down arrows are 

available, you may use them to adjust the value by increments of one. 

Pick List Fields 

 
 

Pick list fields can be populated with values linked from the common database. There are two ways to 

link a pick list field to a value from the database. 

 

First, you may start typing an approximate value directly in the pick list field to display a list of records 

showing only those values that contain the letter(s) that you have typed.  

 

Note: This option is not available if you are selecting an Investigator. 
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Second, you may select the data entry from the appropriate Entity List that opens when you click the Add 

icon  to the right of the field.  

 

Note: Some Person pick lists only allow persons designated as Perspective users, or Perspective users 

with specific privileges (e.g., Investigators) to be selected. In these pick lists, all persons available for 

selection will automatically be displayed in the window, and there will be no option to change the view. 

 

 
 

• If you have a default view specified for the data entity, this view will be displayed in the pick list. If 

not, the window will be blank. You may select or change the view by choosing a preset view from 

the Entity List lookup. To reset the view to display all records, click the green arrow icon . 
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• To find a specific user in the list, start typing the name in the search field to automatically filter the 

user list by the letter(s) that you have typed. To apply the filter, click the checkmark icon . To 

remove the filter, click the clear icon  and then the checkmark icon to view the original list. 

 

• To arrange the list alphabetically, click the A to Z icon . 

 

• To print the list, click the Print icon . 

 

• To quickly view a particular entity’s record, select the entity in the pick list and click the View 

Details button  located at the bottom of the dialog box. The record will open in read-only mode in 

a separate window. Close the window to return to the pick list.  

Note: If you do not have permission to view a particular entity’s record, the View Details button will 

be grayed out when you select the entity. 

 

• Once you have found the correct entity, double-click it, or select it in the pick list and click the Select 

button . The pick list window will close and the field will populate with your selection. 

 

• Alternatively, if the entity you are looking for does not have an existing record, you may use the pick 

list’s Quick Add function to create one. Click the Quick Add button , and a blank data form will 

open in a separate window. Enter all known information, ensuring that all required fields (marked 

red) have been populated, and click Save  when you are finished. The Quick Add form and the 

pick list window will close, and the field will populate with your entry. You can further edit your 

entity from there. 

 

Note: The Quick Add function is only available in Item, Person, Organization, and Vehicle pick lists. 

Further, some Person pick lists only allow persons designated as Perspective users, or Perspective 

users with specific privileges, to be selected; these pick lists do not offer the Quick Add function. 
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After populating a pick list field with a selected entity, you may click the View Details icon  to the left 

of the field to quickly view the entity’s record. The entity’s record will open in read-only mode in a 

separate window. If you are not authorized to view the entity’s record details, you will receive a message 

indicating this, and the record will not open. 

 

At any time, you may click the Remove button  located next to the Add button to clear the field of the 

current selection. 

Multi-Line Text Areas 

 

To enter a value in a text field, type inside the field. For additional options, including cut, copy, and paste, 

highlight the applicable text, right-click and select the desired option from the menu.  

All multi-line text fields include a spell-check option. Perspective will underline misspelled text in red. 

Right-click the applicable text to access suggested spelling corrections. Or, click the ABC button  on 

the formatting toolbar, and Perspective will run a spell-check on all words in your multi-line text area. 

 

 
H T M L  fo r m a t t i n g  i s  no t  s up p or t e d  i n  t e x t  f i e l d s .   
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You can use the following tools to format all multi-line text areas in Perspective: 

• Font face 

• Font size 

• Italics 

• Bold 

• Underline 

• Text alignment (left, right, or center) 

• Bullets 

• Numbers 

• Hyperlinks 

 

 
 

Note: By clicking the drop-down arrow on the right of the formatting toolbar, you can individually hide or 

show buttons (by hovering on Buttonbar), or you can customize the appearance and functionality of your 

toolbar (by selecting Customize…).   
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Calendar 

To select a date and time using the calendar function, click the calendar button  and navigate to the 

day, month, and year you want to select. Click on the date to populate the corresponding field with the 

date you have selected.   
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Appendix D: Chart Wizard 

The Chart Wizard tool embedded in the Analysis Expert contains a number of options that allow you to 

fully customize your chart. To access the Chart Wizard, click  Wizard on the chart toolbar, or right-

click in the chart area and select Wizard.  

 

 
 

Specify your chart options, selecting the appropriate modes from the toolbar on the left. Click Previous 

and Next to navigate between the modes.  
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Chart Type 

• Choose the general Chart Type Group (e.g., Column), and then select the specific Chart Type (e.g., 

Column with Perspective).  

 

• Click the Show 3D Types box to see the chart type images in 3D. 

 

 

3D 

• To start editing three-dimensional properties of your chart, ensure the 3D Enabled box is checked.  
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• Check the Right Angle Axes (Oblique) box to make your X and Y axes perpendicular to each other. 

Uncheck the box to set them at an angle other than 90 degrees.  

 

• Drag the chart or alter the numbers in the X and Y Rotation fields to change the viewpoint of the 

chart.  

 

• Adjust the degree of Perspective that corresponds to the distance and spatial relationship of image 

in relation to you.  

 

• Adjust the degree of the Light or shading applied to the chart. 

 

• Adjust the width between marked values on the X and Y axes under Area Wall Width. 

 

• If your chart includes a series variable, check the Clustered Series box if you want to cluster the 

variables separately. 

 

 

Appearance 

• Under the Style List tab, indicate what color scheme you want to apply to your chart.  
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• Under the Border tab, choose a Border Style and, if applicable, the Border Color and Fill. 

 

 
 

• Under the Advanced tab, select an element of the chart you would like to edit clicking on the chart 

image. In the Line/Border Attributes section, select the Color, Width, and Style of the line border of 

the element. In the Back Fill section, adjust the chart elements’ background colors and color 
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schemes (Solid, Gradient, or Hatch Background). In the Shadow Size section, set the depth of the 

shadow for the element. 

 

 

Series Data 

• Under the Series Data tab, add, remove, move, rename, and select Chart Types for the series 

variables included in your chart. 
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Axes 

• Under the Axis X and Axis Y tabs, assign formatted axes Titles. 

 

• Choose the placement of Tick Marks for axes values.  

 

• Make Grid Lines visible or invisible.  

 

• Apply Interlacing Strips of gray shading to every other grid column or row.  

 

• Make the chart axes reversed. 

 

• Maintain or eliminate any white space between the charted elements and the edges of the chart 

area with the Side Margin or Start at Zero option. 

 

• Set the axes Values Type as Numeric or Date/Time. 

 

• Select the correct Axis Labels Formats and the number of Decimals for these values. 
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Legend  

• If your chart has a legend, ensure the Legend Visibility box is checked to display the legend.  

 

• Choose the legend’s presentation Style. 

 

• Select the legend’s position relative to the chart in Docking and Alignment. Check Legend Inside 

Plot Area to display the legend inside the chart area. 

 

 

 

Point Labels  

• Check Display Point Labels if you want to label charted values for columns, bars, and so forth. 

Under Selected Chart, choose to format series of labels for each variable separately or apply the 

same formatting to all charted point labels.  

 

• Select the Color and Font of labels.  

 

• Set the Angle and Position of the label text relative to the point charted. 
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Chart Title 

• Enter or edit the chart title’s Text.  

 

• Choose its Color, Font, and Style.  

 

• Select the title’s position relative to the chart with the Docking and Alignment options. 
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Finish 

Once the design of your chart is complete, click Finish to exit the Wizard and see your chart results. Click 

Cancel to restore the chart to its original view.  
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Glossary 

TERM DEFINITION 

Activity 

An activity is an event or series of events with which security 

personnel may become involved. In Perspective, activities are created, 

scheduled, and assigned to officers or organizations with the help of 

the Perspective DispatchLog or Dispatch module. When an activity has 

been closed, the corresponding Activity record is transferred to the 

Activities component within Data Forms, where it can be further 

described, investigated, and analyzed. 

Administrator 

An Administrator sets up Perspective, changes settings, and assigns 

security protocols to users. Administrators have the highest level of 

access to all records, forms, and fields; they have no visibility or access 

restrictions within the program. 

Assignment 
An assignment is a task that is given to a user by his or her supervisor. 

Only authorized users can create assignments. 

Authentication 

Authentication refers to a security measure requiring a user to enter 

proof of identity (e.g., a User Name and Password) before accessing a 

network, program, file, or other information. 

Averted Loss 

In Incident and Case records, a loss that is associated with an involved 

entity and that is avoided in the course of an incident as a result of a 

preventative action. 

Banner 

A banner is a long rectangular button that opens a new section of the 

program when clicked (e.g., the Data Forms banner, the Analysis 

Expert banner). 
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Call Category 

A Call Category rollup describes an activity according to its type 

specifications: Level 1, Level 2, and Level 3. Call Category rollups are 

hierarchical, meaning that the option selected in the first level of the 

hierarchy, Level 1, determines what options are available in the second 

level of the hierarchy, Level 2, and so forth. 

Call Code 

A Call Code is a combination of alphanumeric symbols that are used in 

your organization to code the Call Category, optionally combined with 

the call’s Priority and Site. In Perspective, entering a call code on the 

new Activity record form will populate the Call Category, Priority, and 

Site fields. Also, entering the three latter fields may automatically 

calculate the appropriate Call Code, given its availability in the system. 

The Call Code specifications can be set in the Administration 

component of Perspective. 

Case 
A case is a grouping of incidents related by person, item, location, 

class, or other commonality, generally requiring further investigation. 

Chain of Custody 

Chain of custody refers to the complete and thorough documentation 

of an evidence piece’s seizure or collection, possession, control, 

transfer, and disposition. When the process is carried out correctly, 

documented chain of custody verifies that a piece of evidence is 

authentic, that the evidence is indeed connected to a particular 

incident, involved person, or organization, and that the evidence has 

not been tampered with, compromised, or misplaced at any point from 

its initial collection to its appearance in court. 

Child Data 

Child data refers to the data that are recorded on Perspective’s 

subforms, or that could potentially correspond to more than one 

referent. Examples of child data include information about involved 

Persons, involved Vehicles, and so on. 
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Child Node 
A child node is a node that can only be accessed when its associated 

parent node has been expanded. 

Class Rollup 

A Class Rollup describes an incident according to its Class, Category, 

Subcategory, and/or Type. Class Rollups are hierarchical, meaning that 

the option selected in the first level of the hierarchy, Class, determines 

what options are available in the second level of the hierarchy, 

Category, and so forth. 

Client 

A client computer is the computer used to access a software program 

or application. It is connected to a network of other computers and 

may request information from a remote computer, called a server, in 

order to run the application. 

Component 

A component is a program subdivision represented by a specific type 

of form. For example, the Data Forms component of Perspective 

contains such forms, or components, as Incidents, Cases, Activities, 

Items, etc. The components within Data Forms are graphically 

represented by banners accessible from the Navigation pane. 

Dashboard 

The Dashboard is like the Home page or main screen of Perspective. It 

displays charts summarizing incident information, as well as messages 

and assignments from supervisors. 

Data Data is information. 

Data Entry 
Data entry is the process of placing information, or data, in a database. 

This is usually accomplished by typing data into fields in data forms. 

Database 

A database is a collection of data stored in a structured format. A 

database might be compared to an electronic filing cabinet. Databases 

are often organized into tables that store related information in the 

form of records (e.g., Incident records, Person records, Item records). 
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Database Management 

System (DBS) 

A program that allows you to manage information in databases. 

Desktop 

Generally, when a computer is turned on, the screen opens on the 

desktop. This is the area where icon shortcuts are found, including My 

Computer and the Recycle Bin. All types of files can be saved onto the 

desktop. 

Dialog Box 

A dialog box is a window that appears on screen when a particular 

selection is made. It generally provides further options for the selected 

program feature. 

Dispatch 

Dispatch has the core functionality of DispatchLog, but is a separately 

managed application that, like DispatchLog, enables Security 

Departments to quickly and easily dispatch personnel and agencies, 

and to create work orders associated with dispatching activities. 

DispatchLog 

DispatchLog is an integrated module of Perspective that enables 

Security Departments to quickly and easily dispatch personnel and 

agencies, and to create work orders associated with dispatching 

activities. As calls come in, you may use DispatchLog to easily track the 

location, category, and priority of the activities, and to keep up-to-the-

minute records on your officers’ activities, including which officers are 

available for response, when they arrive on scene, and when they 

return. Once an activity has been closed in DispatchLog, it is 

transferred to the Activities component of Data Forms, where it can be 

further described and investigated. The banner that opens 

DispatchLog is located on the Navigation pane. 

Drop-Down 

A drop-down list, or menu, offers a range of selections that have been 

condensed to save screen space. Click on the down arrow on the right 

side of a drop-down field, and the field will expand to display a list of 

options. Select an option by clicking it. 
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e-Incident 

An e-Incident is an electronic Incident report. It may be created in one 

of Perspective’s optional modules (e.g., Perspective  

e-Reporting or Perspective Portal), or it may be imported via 

Perspective’s Import Manager tool. 

e-Report 

An e-Report is an electronic Incident report submitted from Portal by 

an employee to inform an employer of an incident or suspicious 

activity. Once an e-Report reaches the Gateway, it is assessed to 

determine whether or not it should be accepted as a valid Incident 

record. 

Electronic Report 

An electronic report is an Incident, Item, Person, Organization, or 

Vehicle report submitted electronically to the Gateway. Electronic 

reports may arrive from a number of sources. Incident reports may be 

submitted from Portal. Incident reports, as well as Item, Person, 

Organization, or Vehicle reports, may be imported using Perspective’s 

Gateway access point. Once an electronic report reaches the Gateway, 

it is assessed to determine whether or not it should be accepted as a 

valid Incident, Item, Person, Organization, or Vehicle record. 

Entity 

An entity is an object, person, event, or other concept that provides 

information about a larger category recorded in Perspective. For 

example, in order to create a detailed Incident record, you may need to 

enter involved persons and items, attachments, assignments, losses, or 

pieces of evidence that help to create a full picture of the larger 

category—the incident.  

Entity Record 

An entity record is a collection of data related to a particular entity 

(e.g., the record of an Involved Person, Assignment, Loss). In 

Perspective, entity records are stored as rows in a table that can be 

expanded into editable, or viewable, subforms. 
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Export 

To export a file is to convert a file created in one software program or 

application into a format that is usable in another application. For 

example, exporting a set of query results to Microsoft® Excel® involves 

converting the results into a format suitable for use in Excel. 

Exposure 
In Incident and Case records, the amount of potential monetary loss 

associated with an involved entity. 

Field 

A field is an element within a form that allows you to enter or access a 

specific nugget of information related to the record type. One field in 

an address record might be Street. 

Filter 

When filters are applied in directory searches, they tell the program to 

return only records in which the content of a specific field matches the 

criteria set by the user. 

Focal Point 

Perspective Focal Point is an optional module of Perspective, offering 

instant access to incident, investigation, and case data, summarized in 

a series of dynamic charts and graphs. Users can analyze their data to 

see the big picture, or drill down to review specific details, getting the 

facts they need, while uncovering areas of concern and sudden trends. 

Form 

A form is a part of the user interface that allows you to interact with 

the information contained in the database via a screen populated with 

related fields and designed to perform specific program functions, like 

reporting an incident, conducting searches, preparing reports, and so 

forth. 
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Gateway 

The Gateway serves as an inbox for all electronic reports generated 

using Perspective’s Portal. Once an electronic report lands in the 

Gateway, the Gateway Administrator and/or Gateway Approver are 

responsible for assessing it and determining whether or not the report 

should be accepted into Perspective as a valid Incident, Item, Person, 

Organization, or Vehicle record. 

Gateway Administrator 

The Gateway Administrator initially reviews all new electronic Incident 

reports (e-Incidents) submitted to the Gateway. The Gateway 

Administrator can edit e-Incidents, including customizing their security 

controls, and can either assign them to a Gateway Approver for follow-

up or delete them from the system. For all other imported reports (Item, 

Person, Organization, or Vehicle), the Gateway Administrator may 

make them available within Perspective for authorized users to add to 

the main database, or delete them from the system. 

Gateway Approver 

The Gateway Approver is responsible for following up on all  

e-Incidents he or she has been assigned by the Gateway 

Administrator. The Gateway Approver can edit e-Incidents, and can 

either accept them into Perspective as valid Incident records, or send 

them back to the Gateway Administrator for  

reassignment. If an e-Incident contains insufficient information to 

accept or reject it, the Approver can store the e-Incident in a Pending 

folder for review at a later date. For all other imported reports (Item, 

Person, Organization, or Vehicle), like the Gateway Administrator, the 

Gateway Approver may make them available within Perspective for 

authorized users to add to the main database or delete them from the 

system. 

Grid 
Search results and query results display in the form of a grid, or list, 

with each entity occupying a row. 
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Hierarchy 

A hierarchy is organized into successive levels, or layers, with each 

level subject to the preceding levels in the hierarchy. For example, the 

Class Rollup is divided into four fields ordered hierarchically (Class, 

Category, Subcategory, and Type); a selection made in the Class field 

determines what options are available in the Category field, and so 

forth. 

Hyperlink 
A hyperlink refers to an image or a string of text that retrieves a file, 

Web page, or other related information when clicked. 

Icon 

An icon is a small graphic used to represent a particular file, program, 

or function. Clicking the icon will open the file or program, or perform 

the appropriate function. 

Import 

To import a file is to bring a file into the currently active application. For 

example, importing an electronic report into the Gateway involves 

converting the file into a format that is usable within Perspective, and 

then uploading the properly formatted file into the Gateway. 

Incident 

An incident is an unusual action or situation affecting persons or 

property, either accidental or purposeful, which requires notice or 

follow-up by a security or human resources department. 

Integration Services 

Perspective Integration Services is a Web Service Application 

Programming Interface (API) that is designed as a tool for 

communicating with Perspective data across multiple external 

interfaces or systems. Integration Services enables secure creation, 

reading, updating, deleting, and querying of Perspective data across 

the supported systems. 
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Interface 

Interface in Perspective refers to the visual on-screen means (e.g., 

windows, dialog boxes, buttons, banners, panes, or icons) by which 

Perspective modules and components communicate with the user to 

allow for a seamless entry, display, analysis, and transfer of data. 

Investigation 

An investigation is a follow-up or close examination of an incident (or 

of a case linked to one or more incidents) in order to gather facts and 

learn more about the incident’s causes, sequence of events, 

involvements, and so forth. 

Investigator 

An investigator is a person assigned to work on the investigation of an 

incident (or of a case linked to one or more incidents). Within 

Perspective, users designated as investigators are permitted access to 

investigation forms, tabs and functions. 

Label Set See Language. 

Language 

In Perspective, a language refers to a set of field labels. Custom 

languages with unique field labels can be created and assigned to 

particular users. The default language, or label set, in Perspective is 

System English. 

Link A link is a connection to a specific file, form, or program level. 

Link Chart 

A link chart, in Perspective Visual Analysis, visually represents the 

involvements and associations between related Incident, Case, Item, 

Person, Organization, and Vehicle records. Icons signify the record 

entities, and colored lines identify the nature of their relationships. 

Listing Pane 

The Listing pane is the area of Perspective where users view lists of 

records available for selection; the record entity displayed depends on 

the selection made in the Navigation pane. The Listing pane is located 

in the middle of the screen, between the Navigation pane and the 

Viewing pane.  
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Logic Formula 

A logic formula expresses the reasoning Perspective will use when 

applying search criteria. It uses letter symbols to represent each set of 

search criteria and applies AND/OR operators and parentheses to 

define the relationship of search criteria to each other. For example, the 

simple logic formula (A AND B) shows that Perspective will only 

search for results that meet both criteria A and B; in order to include 

results that meet criterion A or criterion B, the logic formula would 

need to be modified. 

Lookup List See Drop-Down. 

Narrative A narrative is the story or explanation of an event. 

Navigate 

To navigate a program refers to using navigational tools, such as 

menus, buttons, tabs, and links to move between windows and other 

structural elements of the program. 

Navigation Pane 

The Navigation pane is the area of Perspective where users navigate 

to major program components (e.g., the Dashboard, Data Forms, 

Analysis Expert), and, to some extent, within the program components. 

The Navigation pane is located on the left side of the screen. 

Net Loss 
In Incident and Case records, the value determined by subtracting the 

Total Recovered amount (if any) from the Total Loss amount. 

No Impact Loss 

In Incident and Case records, any loss that has been associated with 

an incident that has either been prevented, or remains a potential loss 

and, hence, does not impact the Net Loss amount. 
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Node 

A node is a point of intersection in a tree that allows users to navigate 

through the tree to access increasingly specific levels of data or 

program function. A node can be identified by the small square box to 

the left of its position in the tree. Clicking the box when it has a plus (+) 

sign inside will expand the entity and display all its sub-entities 

underneath. Clicking the box when it has a minus (-) sign inside will 

collapse all the sub-entities and hide them under the main entity. 

When a sub-entity also has a small square box to its left, it is known as 

a child node. 

Officer 

An officer is a security personnel representative who can be 

dispatched and responds to activities created in Perspective 

DispatchLog. 

Officer Alert 

In Perspective DispatchLog or Dispatch, an Officer alert determines the 

amount of time set for a dispatched officer to respond to an activity 

when the officer reaches a specific Status (e.g., On Route, On Scene), 

Location, and/or when the activity’s Priority matches a specific priority 

set in the Officer alert. The combination of settings that triggers a 

specific Officer alert can be set in the Administration component of 

Perspective. Once activated in DispatchLog or Dispatch, the settings 

defined for the alert will cause the Officer alert timer to start counting 

the time for the officer to respond to the current combination of 

conditions before their status must be modified. 
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Operator 

An operator is used to create a more refined search. Like the 

calculation symbols used in mathematical formulae, where operators 

define the relationship between the formula’s parts (e.g., A is equal to 

B), operators in Perspective express the relationship of the field to the 

value when setting search criteria. For example, if the Class field is 

selected and Criminal is the chosen value, an operator of equal to 

would stipulate that any records appearing in your search results 

would have a Class equal to Criminal. Examples of other operators 

include not equal to, less than, starts with, and like. 

Organization 
In the context of Perspective, an organization is any agency, company, 

or group. 

Organizational Rollup 

An organizational rollup indicates the company division or region that a 

user belongs to, or when assigned to a record, the particular division or 

region that is permitted to access the record. A user can only view 

records with the same, or lower, organizational rollup as his or her 

own. Organizational rollups are multi-tier or hierarchical; the option 

selected in the first tier determines what options are available in the 

second tier, and so forth. Moving down the hierarchy, organizational 

rollups become increasingly specific. A user with an organizational 

rollup higher on the hierarchy will have greater access to records than 

a user with a more specific organizational rollup lower on the 

hierarchy. 

Pane 

A pane is an area within an on-screen window that contains specific 

type of information in the form of interconnected files, fields, 

messages, banners, buttons, formulae, or other information. For 

example, Data Forms interface is expressed through the functionalities 

contained in the Navigation, Listing, and Viewing panes.  
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Parent Data 

Parent data refers to the basic data that are recorded on Perspective’s 

main forms, or that correspond to only one referent. Examples of 

parent data include, but are not limited to, an incident’s Class, Site, 

Business Unit, Reported Date/Time, Status, and Created by User. 

Pick List 

A pick list requires users to select an incident, item, person, 

organization, or vehicle from a range of records displayed in a separate 

window. If the desired entity does not appear in the pick list, some pick 

lists allow users to create a new entity record for selection. A pick list 

effectively links data entered in a field to an entity record. Click on the 

green Add icon on the right side of a pick list field to display a window 

containing a list of records for selection. Once a record is selected, the 

window will close and the pick list field will automatically populate 

with the record’s name. 

Pop-Up 
A pop-up is a window that opens automatically when a particular 

option is selected in the previous window. 

Portal 

Perspective Portal is a module for Perspective, enabling any employee, 

onsite or in a distant location, to report an incident or suspicious 

activity as soon as it occurs, through the Portal webpage set up 

specifically for their workgroup. Once an electronic report has been 

submitted from Portal, it lands in the Perspective Gateway, where it is 

assessed to determine whether or not it should be accepted as a valid 

Incident record. 

Priority 

The level of importance assigned to an incident, activity, or email 

message (e.g., High, Low, or Normal). The list of available priority levels 

can be set in the Administration component of Perspective. 
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Query 

A query is a request for information. In Analysis Expert, when the 

Execute button is clicked, the program sends a message to the 

database where all information is stored, requesting results matching 

the query’s specified criteria. 

Quick Find 

The Quick Find tool allows users to easily locate records containing a 

particular text string. Quick Find searches text fields across the 

Perspective database (such as summaries, narratives, and text 

attachments) for the word or phrase specified, and returns a 

comprehensive list of records for review.  

Radio Button 

A radio button allows users to select one option out of a set of options. 

Before a radio button has been selected, it will look like an open circle, 

and after it is selected, a dot will appear inside the circle. Once a user 

has selected one radio button, selecting any other radio button in the 

same set will deselect the first option. 

Record 

A record is a subsection of database, holding information about one 

entity or a member of a category within the database that is stored as 

one unit (e.g., an Incident, Activity, Item, or Person record). 

Record View 

A record view is a particular list of records that a user is permitted to 

access. In Perspective, users are able to create and save their own 

customized record views in the Data Forms component, allowing them 

to better organize and manage the records they need to view on an 

ongoing basis. 

Recovery 

In Incident and Case records, an entity that corresponds to a loss 

amount associated with an incident that has been restored or regained, 

as a result of an action that had been implemented after the incident 

took place.   
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Regulated Time to Act 

(RTA) Alert 

In Perspective DispatchLog or Dispatch, a Regulated Time to Act alert 

determines the amount of time set for a dispatcher to react to and 

modify an activity when the dispatched officer reaches a specific 

Status (e.g., On Route, On Scene), Location, and/or when the activity’s 

Priority matches a specific priority set in the Regulated Time to Act 

alert. The combination of settings that triggers a specific RTA alert can 

be set in the Administration component of Perspective. Once activated 

in DispatchLog or Dispatch, the settings defined for the alert will cause 

the RTA timer to start counting the time the dispatcher is left to check, 

and modify, the status of the dispatched officer in Perspective 

DispatchLog or Dispatch. 

Ribbon 

The Ribbon locates the most frequently used general administration, 

navigation, help, and search tools for you to refer to sections of the 

integrated Help files. In the Data Forms component, the Visual 

Analysis icon is added, which assists in visual representation of 

relationships between the records stored in the Perspective’s 

database. In the Analysis Expert component, the Ribbon is populated 

with an additional set of icons that perform saving, adding, cloning, 

deletion, sharing, and execution of queries. 

Role 

Every user is assigned to a role, which determines how much access 

the user has to Perspective's functions and features, and what he or 

she uses the program for. Examples of roles include Administrator, 

Investigator, or General User.  



Perspective User’s Guide  Glossary 

 © Resolver Inc.   Page 385 of 399 

TERM DEFINITION 

Rollup 

A rollup is also known as a multi-tier or hierarchical lookup list. Rollups 

are used to streamline the options and functions available to users 

when making selections from related lookup lists. Each rollup has up to 

four tiers. The first tier is known as the Root; the option selected in this 

first tier determines what options are available in the second tier, and 

so forth. A higher tier in the hierarchy is known as a Parent field and a 

lower tier is known as a Child field. Any Child fields that are on the 

same tier of the hierarchy are called Sibling fields. 

Screen 

A screen is a display of some portion of the program on your computer 

monitor. The term screen may be used to refer to the main program 

screen, a program form, or a subform (e.g., the Data Forms main 

screen, an Involved Item screen, the Analysis Expert screen). 

Search 
To search a database refers to the process by which the software 

program looks for data meeting the criteria specified by the user. 

Search Engine 
A search engine is a computer program that retrieves files or data from 

a database based on specified search criteria. 

Server 

A server is a computer that shares information with client computers in 

a network to help process a software program or application. The term 

server may refer to either the machine that shares the information, or 

to a particular software program designed for this purpose. 

Sigma (Σ) 

Sigma is the Greek symbol for sum. In Analysis Expert, the sigma 

symbol appears on the heading of a column when Group By is clicked, 

indicating that the data in the column can be added together. 
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Single Sign-on (SSO) 

Login authentication that, if configured by a Perspective administrator, 

allows you to enter one set of credentials to access multiple Resolver 

desktop applications (Perspective, Dispatch, and/or Dashboard) 

without re-entering those credentials, as long as your session token (a 

temporary file that stores your credentials) remains active. The amount 

of time the session token is active is based on the settings of the SSO 

provider selected by your administrator, however, logging out of one 

Resolver application will end the session with all applications (e.g. if 

you click Logout in Dispatch, you will need to re-enter your login 

credentials to log into Perspective). Clicking the X at the top right of an 

application will keep your session token among the applications active. 

Standard Operating 

Procedures (SOP) 

A part of Perspective’s interface that provides guidance on the course 

of actions in case of an activity with a specific Call Category, Location, 

and/or Status. The Standard Operating Procedures can be described in 

the Administration component of Perspective with the help of a brief 

description, a standardized checklist of actions to be performed under 

the specified activity conditions, additional attachments, hyperlinks, 

and automated notifications. The created SOP rule will subsequently 

feature in Activity records that correspond to the settings specified in 

both Perspective’s Activity data forms and the SOP component in 

Perspective DispatchLog or Dispatch. 

Status Bar 

The Status bar is a part of Perspective’s interface that displays your 

system and login information, including your username, role name, as 

well as Perspective’s system and connection statuses (e.g., Connected/ 

Disconnected). The Status bar is located at the bottom of the screen. 

Sub-Administrator 

A Sub-Administrator is permitted to create user accounts and modify 

User Details and User Defaults, but only for users who are within their 

default workgroup and who have the same (or lower) access level and 

organizational rollup as their own. 
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Subform 

A subform is a sub-tabbed screen that contains child data, allowing 

you to enter a large amount of detailed information about an entity in 

an organized and coherent manner. A subform can only be accessed 

through its associated parent form. Like its parent form, the subform is 

designed to perform specific program functions (e.g., recording an 

involved person, registering a piece of evidence). 

Sub-tab 

A sub-tab is a tab that can only be accessed through a parent tab 

when navigating a form. For example, in the Incident form, the 

Involvements tab has four sub-tabs: Persons, Organizations, Vehicles, 

and Items.  

Supervisor 

A supervisor is permitted to access the Controls tab on all records. 

Among other things, this allows the supervisor to change the 

workgroups, organizational rollups, and access levels of records at will. 

Tab 

A tab in Perspective is used to mark a particular section within a data 

form. It looks like and operates like a tab in a file folder. To access the 

contents of a tab, users must simply click on the tab. 

Table 

A structure within a database designed for storing related information, 

often in the form of records or entity records. Simple databases may 

contain only one table; complex databases contain many. 

Toolbar 
A row of icons that activate functions or options when clicked. (e.g., 

The Ribbon). 

Total Loss 

In Incident and Case records, the sum value of all Loss amounts 

associated with an incident that corresponds to losses that actually 

took place. 
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Tree 

A tree is a hierarchical structure representing the links and 

relationships between program components. For example, expanding a 

single node reveals child nodes, which in turn yield further entities, 

until the user arrives at individual fields containing precise pieces of 

data. The hierarchical relationship between all these pieces, essentially 

a navigation map of one particular area of the program, can be 

described as a tree. 

User 
A user is a person who uses Perspective, and has his or her own User 

Name and Password to access the program. 

User Defined Field (UDF) 
A UDF is a special field developed by an organization to meet their 

specific needs. 

Value A value is the specific information, or data, entered into a field. 

Vehicle Identification 

Number (VIN) 

VIN is a unique tracking number that serves to identify a vehicle. 

Viewing Pane 

The Viewing pane is the area of Perspective where users view record 

contents. (Depending on their user privileges, users may also be 

authorized to edit, delete, or add records in the Viewing pane.) The 

record displayed in the Viewing pane depends on selections made in 

the Navigation pane and the Listing pane. The Viewing pane is located 

on the right side of the screen. 

Visual Analysis 

Perspective Visual Analysis allows data relationships between Incident, 

Case, Item, Person, Organization, or Vehicle records to be rendered into 

powerful visual link charts. These visual elements can easily be analyzed 

and interpreted, bringing clarity to complex investigations and 

scenarios. 
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Window 

A window is an enclosed rectangular on-screen viewing area that 

displays programs, files, fields, messages, or Web sites independently 

of other on-screen areas. 

Workgroup 

A workgroup, in Perspective, segregates users by department, division, 

corporate level, region, or any other criteria an organization wishes to 

use, and allows an organization to limit users’ access to data. Users 

can only access records assigned to their respective workgroups.  
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Contact Information 

Technical Support 

Toll Free: 1-877-776-2995 

Phone:  (780) 448-0616 

Email:  support@resolver.com 

Website: https://support.resolver.com  

Resolver Inc. 

Toll Free:  1-888-776-9776 

Phone:  (780) 448-0616 

Fax:   (780) 448-0618 

Email:  information@resolver.com 

Website:  http://www.resolver.com 
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